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Preface 
 

This report is the result of technical assistance provided by the Economic Modernization through 
Efficient Reforms and Governance Enhancement (EMERGE) Activity, under contract with the 
CARANA Corporation, Nathan Associates Inc. and The Peoples Group (TRG) to the United 
States Agency for International Development, Manila, Philippines (USAID/Philippines) 
(Contract No. AFP-I-00-00-03-00020 Delivery Order 800).  The EMERGE Activity is intended 
to contribute towards the Government of the Republic of the Philippines (GRP) Medium Term 
Philippine Development Plan (MTPDP) and USAID/Philippines’ Strategic Objective 2, 
“Investment Climate Less Constrained by Corruption and Poor Governance.”  The purpose of the 
activity is to provide technical assistance to support economic policy reforms that will cause 
sustainable economic growth and enhance the competitiveness of the Philippine economy by 
augmenting the efforts of Philippine pro-reform partners and stakeholders.   
 
By letter dated August 23, 2006, Commissioner Napoleon L. Morales of the Bureau of Customs 
(BOC) requested EMERGE assistance in explaining how to formulate a performance 
management system (PMS), a performance appraisal system and performance contracts, so that 
the BOC Lateral Attrition Implementation Committee could develop its own system of 
measuring, monitoring, rating and rewarding good performance in compliance with the Lateral 
Attrition Act of 2005.  With USAID approval, EMERGE responded to this request by organizing 
a PMS orientation workshop for about 25 middle to top BOC officials conducted by the 
EMERGE PMS team presently working with the Bureau of Internal Revenue (BIR) to install a 
PMS system there.  The workshop participants recognized their limitation in implementing a full 
blown PMS.  The BOC has yet to develop the performance measures the participants have 
identified in the workshop.  Among the measures, the Bureau has data on only one measure: 
financial collection.  Secondly, the Commissioner has yet to create a Planning unit of the Bureau, 
which would be responsible for managing the PMS process. Thirdly, the legal framework of the 
Bureau’s PMS needs to be enabled.  The Bureau is presently thinking of coming up with a PMS 
Customs Memorandum Order (CMO) containing the legal framework for the office PMS, goal 
allocation methodology, rewards and attrition framework.  This technical assistance activity 
builds on the project level outputs that EMERGE consultants were able to produce with BOC 
stakeholders at their PMS Workshop Orientation in September 2006.  The consultants will work 
closely with the BOC Lateral Attrition Implementation Committee, advising them how they may 
attain the above performance milestones.   
 
This report documents the process and methodology for the goal allocation, PMS installation 
framework, rewards and attrition and the enabling mechanism which is the CMO.  The task was 
undertaken by several members of the EMERGE BIR PMS Team, namely Marie Herminia 
Soriano, Team Leader and Performance Measurement/OD Specialist, Lee De Dios, Economist, 
Joel Grenas, Goal Allocation Researcher, Ana Lea Uy, Legal Adviser, John Paul Vergara, 
Rewards Framework Specialist, Edwin Siao, Systems Analyst/Developer and Blanca Pasaporte, 
PMS Documentation Specialist.    
 
The views expressed and opinions contained in this publication are those of the authors and are 
not necessarily those of USAID, the GRP, EMERGE or the latter’s parent organizations. 
 

 



Overview 
 
This Report on Institutionalizing the Performance Management System 

(PMS) in the Bureau of Customs (BOC) contains the initial tools and system 

for PMS implementation in the Bureau.  The Guidebook includes four 

Chapters: 

 

 

• Chapter 1: Performance Management Installation Framework contains 

the guiding principles in the implementation of the PMS.  It discusses 

the results of an office evaluation done at the Port of Manila (POM) as 

the pilot site of the project, to determine the level of readiness of the 

Bureau for PMS installation.  Based on these findings, it provides some 

recommendations on the nationwide installation of PMS in the BOC. 

• Chapter 2: Goal Allocation Methodology presents an approach for 

allocating revenue targets among the Districts, the use of collective 

targets for individuals and requisites for implementation.   

• Chapter 3: Rewards Framework describes a framework that is based on 

performance and recognizes the variations in accountabilities of the 

offices and employees in the BOC. 

•  Chapter 4: Customs Memorandum Order (CMO) presents the enabling 

measure, which shall catalyze the full scale implementation of the 

Attrition Act of 2005 in the BOC.  
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PMS Installation 

Recommendations 
 
This chapter presents the guiding 
principles in the implementation of 
PMS.  It discusses the results of an 
office evaluation done at the POM to 
determine the level of readiness of 
BOC for the installation of PMS.  
Based on these observations, some 
implications and recommendations 
for PMS installation and 
implementation are mapped out. 
Considering the complexity of the 
changes subsumed with PMS 
implementation and the level of 
resistance for PMS at the BOC, the 
PMS project installation is assessed to 
be “high risk”.  To manage the risks, 
this section recommends a phased 
implementation approach over the 
next three (3) years.  PMS teams will 
be taught and empowered to install 
the system across Districts and 
manage the resistance towards the 
PMS.  Hopefully this approach ensures 
greater ownership and buy-in of the 
PMS by BOC critical stakeholders. 
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The BOC-Performance Management System Installation Framework 

Objectives 
This chapter aims to provide its target readers, the BOC-PMS Teams1, 
guidelines in the installation and implementation of a Performance 
Management System based on the PMS workshop conducted with 
BOC management in September 2006 and focus group discussions 
and interviews conducted with the Port of Manila (POM) management 
in February-March 2007. 

Acronyms 
Table 1: List of acronyms used in Chapter 1 
ACDD Auction and Cargo Disposal Division 
ADKAR Level of awareness, desire, knowledge, ability and reinforcement 
BOC Bureau of Customs 
BSC  Balanced Scorecard 
CBWD Common Bonded Warehouse Division 
CIIS Customs Intelligence and Investigation Service 
DBCC Development Budget and Coordinating Committee 
ESS Enforcement and Security Service 
FED Formal Entry Division 
FS Financial Service 
GTMBWD Garments and Textile Manufacturing Bonded Warehouse Division 
HRS Human Resource Service 
IED Informal Entry Division 
IICO Interim Internal Control Office 
LBD Liquidation and Billing Division 
M&E  Monitoring and Evaluation 
MISTG Management Information Systems and Technology Group 
MMBWD Miscellaneous Manufacturing Bonded Warehouse Division 
PES  Performance Evaluation System 
PMIS Performance Management Information System 
PMS Performance Management System 
POM Port of Manila 
PSCO Planning and Systems Control Office  
PPBWD Private/Public Bonded Warehouse Division 
WAD Warehousing Assessment Division 
 

Definitions 
Table 2: Definition of terms used in Chapter 1 
Republic Act No. 9335, also known as 
the Attrition Act of 2005 

This was passed by the Third Congress of the Philippines 
on January 19, 2005 and approved by the President on 
January 25, 2005. The law seeks to improve the revenue 
collection performance of the Bureau of Internal 
Revenue and Bureau of Customs. 

Balanced Scorecard  It is a strategy management and implementation tool 
that looks at performance of offices in BOC from the 
following perspectives: financial, customer satisfaction, 
process improvements and organizational learning and 
growth. 

Change management  Specific actions that can be taken to manage the 
people side of installing change, in this paper, the 
installation of the Performance Management System. 

                                                 
 

1 These are the PMS Sponsors, Process Owners and Monitoring and Evaluation Teams, details of 
which are discussed on pages 1-21 to 1-26. 
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The BOC-Performance Management System Installation Framework 

Mission It describes the mandate and core purpose of the 
organization at the Bureau, District or Division level. 

Performance Management System It is a four-stage management system composed of 
target setting, monitoring, evaluating and rewarding. 

Scorecard The Performance Scorecard serves as the contract that 
binds offices and individuals to pre-identified financial 
and non-financial targets. 

Strategy The means towards the attainment of an organization’s 
vision, mission, development thrusts. 

Strategy map It serves as an implementation roadmap.  It describes 
the strategic objectives that the organization must 
deliver if it is successfully attain its mission and vision. 

Target It defines the expected level of performance required 
for each measure. 

Vision It is a vivid description of the organization’s desired 
future for itself so that it can better achieve its mission. 

Weight This indicates the priorities at the objectives and 
measure level.  Weight assignment across objectives 
and measures should always total 100%. 

Guiding principles 
 
The Implementing Rules and Regulations of the 2005 Attrition Act 
require the use of a Performance Management System (PMS) in 
implementing the rewards and incentives for officials and employees 
of the Bureau of Customs (BOC).  The Commissioner of Customs shall 
evaluate annually the performance of the various offices and 
personnel of the Bureau using a PMS that is fair, objective and 
accurate, and whose results are not only verifiable but also replicable.  
 
The PMS follows a four-stage process composed of performance 
planning, monitoring, evaluating, and rewarding.   In performance 
planning, objectives, performance measures and targets are 
established and cascaded from the office to the individual levels.  
Monitoring involves periodically checking and systematically 
documenting performance at the office and individual levels so that 
necessary adjustments in priorities and strategies can be made.  
Evaluation involves the process of assessing whether the performance 
targets are attained and determining ratings for actual performance.  
The results of performance evaluation are used as basis for rewards 
and continuous improvements.   

The Bureau’s PMS follows the Balanced Scorecard (BSC) approach in 
the design and installation of the PMS.  It is a strategy management 
and implementation tool that looks at performance of an organization 
from a balanced set of perspectives such as:  

 
 Financial:  It includes efforts of the BOC that directly contribute to 

increased collection.   
 

  Customer: It pertains to all strategic objectives leading to 
increasing compliance and satisfaction levels of BOC customers.  
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 Process improvement:  It captures all strategic objectives of the 

Agency to improve its core operations processes. These core 
processes may be in the areas of assessment/valuation, trade 
facilitation, and enforcement, warehousing and case resolution. 

 
 Organizational learning and growth.  It subsumes all strategic 

objectives contributing to improvement in BOC human resource 
competence, integrity and professionalism. IT also includes efforts 
of the BOC to improve the quality of its work life.  
 

The PMS uses several tools to ensure effective alignment of 
performance measures/data across offices and individuals.  These are 
the strategy map, scorecard, measures dictionary, PMS process map 
and the Performance Management Information System (PMIS).  
  
 The Strategy Map is used to translate the vision and mission of the 

Bureau of Customs into inter-related strategic objectives.  It serves 
as the guiding framework in the formulation of office and individual 
performance scorecards.   All the performance measures or key 
performance indicators in performance scorecards are linked to 
these objectives. 

 
 The Performance Scorecard serves as the contract that binds 

offices and individuals to pre-identified financial and non-financial 
targets.  Performance Scorecards are mutually agreed–upon and 
signed by raters and ratees after the target setting and evaluation 
processes. 

 
 The Measures Dictionary is a reference document containing 

detailed information about each measure in the scorecard.  
 
 The PMS process map details the activities of the PMS Teams in 

ensuring alignment of targets across offices during the target 
setting, integrity of data during the monitoring process and 
consolidation and analyses of data during the evaluation stage.  
The PMS Teams are composed of the PMS Sponsors, Owners and 
M&E Teams.  The PMS Sponsors are composed of the Customs 
Commissioner (CusCom), Executive Committee (EXECOM) and 
District Collectors.  The PMS Owners are the Financial Service, 
Interim Internal Control Office (IICO) and Human Resource Service 
(HRS).  The Financial Service focuses on financial collection data at 
the Office level while the IICO on non-financial performance data 
at the Office level and the Human Resource Service on 
performance data at the individual level. 
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 The last tool is the Performance Management Information System 
(PMIS) which is a web-based application that supports the Office 
PMS (OPMS) process.  Its installation and implementation is a major 
component of the OPMS since it is the system that facilitates the 
encoding and processing of measurement data to arrive at 
performance ratings for offices.  It has the following modules: 

Planning/ Target-setting - includes the setting up and generation of Office 
Contracts. 

Evaluation – includes the generation of worksheets for consolidating and 
uploading actual performance data, and rating of office performance. 

Management Reports – includes standard reports that provide management 
with data for analysis and decision-making. 

With all tools installed, the PMS is a potent tool that can provide 
quantitative and qualitative explanations on the organizational 
determinants of good and poor performance.  With good 
performance measures properly documented and evaluated, one is 
able to systematically define the areas of strength and improvement 
of an office which becomes a basis for office target setting, 
continuous improvement and organizational rewards. 

The next section focuses on the experience in the pilot site, the Port of 
Manila (POM), in an effort to determine the PMS installation framework 
and approach in the BOC based on observations, focus group 
discussions, interviews, with the POM District Collector, Deputy 
Collectors, Division Chiefs and customers. 

The Case of Port of Manila (POM) 
Last September 2006, several District Collectors and representatives of 
the Office of the Commissioner attended a four-day orientation 
workshop on the PMS.  The workshop provided a venue for the 
participants to gain a shared understanding of the PMS as a 
management tool.  It also allowed the participants to apply the PMS 
tools. 
 
After the workshop, Deputy Commissioner Reynaldo Umali asked for 
the technical assistance of EMERGE in the installation of PMS in the 
BOC. He suggested the POM as the site for validating the outputs of 
the workshop and “diagnosing” the level of readiness of the BOC for 
the implementation of a PMS. 
 
Focus group discussions and interviews were conducted by EMERGE 
with the District Collector, the Deputy Collectors and the Division Chiefs 
of POM in February-March of 2007 to:   
 
 Determine the level of readiness of the POM for the installation of 

the PMS by conducting a sample office evaluation using the BOC 
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Strategy Map, Scorecards and Measure Dictionary as reference 
tools. 

 Recommend an approach towards the installation of the PMS.
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Observations 
This section presents the observations of the EMERGE team on PMS 
practices at the POM on two areas: the PMS process itself and the 
performance measures currently being tracked, monitored and 
evaluated at the office level. 
 
Performance Management System Process 
 
Target setting process: Performance management requires that 
performance measures and targets are well defined, aligned, 
cascaded and the target setting process continuously improved.  In 
POM, the following are noted: 
 
 Collection target is clear in POM, its Group and Division Heads.  

However, ownership of the collection targets is rather low.  There is 
no understanding why some divisions are given collection targets.  
There is no ownership and buy-in of the basis of the goal allocation.   

 
 Collection target is imposed by the Development Budget 

Coordinating Committee (DBCC).  It is further “imposed” by the 
Finance Service across Ports.  Within the POM, the Division Chiefs do 
not understand how the collection goal is allocated.  The following 
Offices have collection targets: Formal Entry Division (FED), Informal 
Entry Division (IED), Warehousing Assessment Division (WAD), 
Private/Public Bonded Warehouse Division (PPBWD), Common 
Bonded Warehouse Division (CBWD0, Miscellaneous Manufacturing 
Bonded Warehouse Division (MMBWD), Garments and Textile 
Manufacturing Bonded Warehouse Division (GTMBWD), Auction 
and Cargo Disposal Division (ACCD), Liquidation and Billing Division 
(LBD), Bonds Division, and the Sub-Ports S. Harbor, Masinloc, 
Mariveles, Limay, FTI, Rosario, Postal, and Laguna.  

 
 The POM does not seem to have a formal planning process.  The 

Divisions chiefs submit their “plans” to the Administration Group on 
a yearly basis.  The Deputy Collector for Administration does not 
remember having formulated any plans recently until a colleague 
reminded her that plans are submitted to her.  The District Collector 
on the other hand has a “secret marketing strategy.” 

 
 Only collection target seems to be clear among the Division Chiefs 

during the interviews.  They were asked for the existence of 
performance measures elicited during the September workshop 
but most of them point to another office as the unit responsible for 
collecting such data.  When the office referred to was asked for 
the data, these offices refused to give the data, claiming that such 
data are confidential. 
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Monitoring process: Performance management presumes the 
presence of a well-functioning reporting system.   Focus group 
discussions and interviews with POM top and middle management 
reveal that: 

 Daily, weekly, monthly and yearly reports are generated for 
collection-related measures.  Other performance measures are not 
as religiously and periodically monitored. 

 Other outcome measures such as compliance level of importers as 
a result of assessment or output metrics such as additional payment 
due to appraisal are documented but not summarized, evaluated, 
analyzed and used as bases for action.   Thus, most metrics do not 
have baseline performance data for 2006. 

 The PMS process necessitates establishing actual performance 
through an office evaluation by obtaining baseline data.  In an 
effort to establish 2006 actual performance for the POM based on 
the scorecard developed with the Operations and Administration 
Groups, the team requested the Collector for Administration and 
the Chief of the Administrative Division to assist in gathering 
baseline data for the metrics.  Unfortunately, there was no 
feedback from their end so the team decided to visit the offices to 
obtain the needed data on abandonment shipments and number 
of hold and alert orders issued.  The Enforcement and Security 
Service (ESS) Chief alleged the Office does not track the metric but 
the Customs Intelligence and Investigation Service (CIIS) does.  An 
interview with the CIIS Chief yielded negative results and so with 
the Collection Service, which according to him tracks actual 
figures.  The next stop was the Assistant Chief of the Law Division.  
Sad to say, according to her, the staff keeping the data is on leave 
and the Division could not provide the information on the same 
day.  A check with the Assistant Chief of the Auction and Cargo 
Disposal Division (ACDD) did not do any good.   

 A precondition for timely submission of reports is an efficient 
management information system.  The source of most data in POM 
is the MISTG and CIIS, but this is not yet designed to provide data 
on overall office performance with balanced set of measures. 
Interviews reveal that a current system is being developed where 
other performance data such as entries processing flow will be 
system generated.  

 Performance data are generally treated confidential.  There seems 
to be no system or mechanism for making office performance 
results transparent.   
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Evaluation and continuous improvement process.  A critical attribute 
of a working PMS is the use of office evaluation results as bases for 
continuous improvement.   

 Offices are evaluated on collection metric alone.  Determinants of 
good office performance are not analyzed and established.  

 Individuals are evaluated using the Performance Evaluation System 
(PES) which is not perceived to be effective in distinguishing high 
from low performers.  Evaluation at the individual level is based on 
self assessment.  Raters such as the Section, Division and Group 
Heads sign the evaluation sheets so ratees can claim their annual 
two thousand pesos merit bonus. 

 
Performance measures 
 
BOC Strategy Map validated.  Division Chiefs present in the January 31 
workshop2  validated the strategy map3 drafted by the District 
Collectors in the September 2006 workshop.  

 
They agreed with the strategic objectives captured in the Strategy 
Map.  They agreed that for them to exceed their collection target, 
they need to improve the compliance and satisfaction levels of their 
stakeholders. For them to impact on the compliance behavior and 
satisfaction levels of their customers, they need to strengthen their 
internal control and monitoring systems, enhance trade facilitation 
and enforcement of laws and expedite resolution of administrative 
cases. 

 
They also underscored that for these process improvements to take 
place they need to be able to attract, develop and maintain 
competent personnel with integrity. 
 
POM Scorecard formulated. The Deputy Collector for Assessment, 7 
Assessment Division Chiefs, 11 Operations Division Chiefs, 3 Collectors 
from the Sub-ports and 2 Division Chiefs from the Administration Group 
were coached to formulate their Office Scorecards.  They were asked 
to validate the performance measures identified at the BOC level 
which are applicable to their Division.  The table below shows the 
measures applicable to the POM.  The Division chiefs were also asked 
to give baseline data for 2006 but only measures with the check 
symbol have actual data for the previous year. 

 

                                                 
 2 The list of participants who validated the BOC Strategy Map is in Appendix 1. 

3 The BOC Strategy Map is the result of the strategy mapping exercise with 15 District Collectors 
and representatives of the Office of the CusCom last September 2006, validated by POM 
participants. This is shown in Appendix 2.  
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Table 3: Performance measures identified at the BOC Level which are 
monitored/tracked at the POM level 
 

OBJECTIVE MEASURE FORMULA OG AG Adm

Exceed 
collection 
performance 

1. Revenues collected  
Actual collection  

------------------------------------------- 
Assigned goal/target 

 
 

 
 

 
    

 2. Collection growth 
Collection this year 

__________________________ 
Collection last year 

 
 

 
 

 
    

 
3. Amount collected 

from shipments 
subjected to WSD 

Number of shipments subjected to 
WSD 

__________________ 
Total number of shipments 
referred to the Law Division 

   

 

4. Additional revenue 
generated from 
alerts and hold 
orders 

Revenue generated from alerts 
and hold orders 

Total revenue generated 

   

Improve 
compliance 
level of 
stakeholders 

5. Increase in 
collection as a result 
of assessment of 
imports 

Value of imports declared 
___________________________ 

Value of imports assessed 

   

Improve 
enforcement 
process  

6. Number of 
contraband 
detected 

Number of violations detected 
Number of containers subjected 

to X-ray 

   

 7. Number of alert and 
hold orders issued  

Number of alert and hold orders 
issued 

Total number of shipment 
processed 

   

 
8. Number of 

shipments subjected 
to WSD 

Number of shipments subjected to 
WSD 

Total number of shipments put on 
alert or hold order 

 
 

 
 

 
    

 9. Number of cases 
won 

Number of cases won 
____________________ 

Number of decided cases 

 
 

 
 

 
    

 
10. Number of CBWs  

issued order of 
closure 

Number of warehouses issued 
order of closure 

_______________________ 
Number of cases forwarded by 
different warehousing divisions 

   

 
11. Number of 

abandonment 
shipments resolved 

Number of abandonment 
shipments resolved 

______________________________ 
Total number of abandonment 

shipments 

   

Promote trade 
facilitation 

12. Number of  import 
cargoes processed 

Number of import entries 
processed  

Number of import entries 
received 

 
 

 
 

 
    

 13. Number of export 
entries processed 

Number of export entries 
processed 

Number of export entries 

    

BOC/EMERGE 1-10 
 



The BOC-Performance Management System Installation Framework 

 

OBJECTIVE MEASURE FORMULA OG AG Adm

received 

 14. Volume of imports 
cleared 

Volume of imports cleared 
Volume of imports received 

   

 

15. Increase in 
collection as a result 
of assessment of 
imports 

Value of imports declared 
___________________________ 

Value of imports assessed 

   

 

16. Turn –around time in 
the release of 
shipments to 
importers 

Current average processing time 
per entry for current year 

_______________________________ 
Average processing time for last 

year 

   

 

17. Number of entries 
processed under 
the selectivity 
system 

Number of red/yellow/green 
_______________________ 

Total entries filed 

   

 18. Number of super 
green  lane users 

Number of super green lane users 
_______________________ 

Total number of importers 

 
 

 
 

 
    

 
19. Number of importers 

subjected to post 
entry audit 

Number of importers subjected to 
post entry audit 

_________________ 
Number of importers 

   

Organizational 
learning and 
growth 

20. Technical  staff 
complement 

Number of technical staff 
complement 

____________________________ 
Current personnel strength 

 

 
 

 
 

 
    

 
POM Measure Dictionary crafted.  The Division Chiefs helped craft the 
Measures Dictionary which captures clarifications on each measure of 
the Performance Scorecard.   
 
However, completion of the PMS Evaluation was a feat. While the 
Office Performance Scorecards were formulated up to the Division 
level, computing for the Office ratings could not be completed 
because of difficulty in accessing /retrieving actual performance 
data.  This implies either the performance measures are not yet 
documented, monitored, consolidated, evaluated and used as basis 
for any decision making. 
 
Offices currently tasked to define, consolidate and analyze 
performance data 

The Finance Service (FS) currently defines, consolidates and analyzes 
collection data across ports of the BOC.  On the other hand, the 
Human Resource Service (HRS) consolidates the Performance 
Evaluation reports at the individual level.  The IICO will be tasked to 
analyze and consolidate office performance data.  For the POM, only 
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collection data is consolidated by the Data Monitoring Office for 
submission to the Office of Customs Commissioner.  

Implications for PMS Installation 

Scoping the change 
The implementation of the Attrition Act necessitates the installation of 
the PMS for the whole agency, across ports, divisions, sections and 
individuals. 
 
The change will directly impact on top and middle managers of the 
BOC.  Installing PMS in BOC entails changes in defining, selecting, 
allocating and evaluating financial and non-financial measures.  It 
involves cascading and aligning performance targets across offices 
and individuals.  It means re-tooling managers and supervisors in PMS.  
More than these, top and middle managers will have to be taught to 
manage change in their respective units.  The District Collectors, their 
Deputy Collectors and Division Chiefs across ports will play a critical 
role in the sustained implementation of the PMS.   
 
It will also target the teams who will oversee the installation and 
implementation of the PMS.  These are the PMS Sponsors, PMS Owners 
and M&E Teams.  They will have to learn to analyze performance data 
at the office and individual levels using a more balanced set of 
performance measures.  They will have to learn to use the automated 
system that will make performance monitoring and evaluation user-
friendly and manageable.   
 
Eventually, regular employees will also be affected by the PMS.  They 
will have to accept more defined and specific targets at the office 
and individual levels.  They will have to document their performance.  
They will go through a process of evaluation that is aligned with the 
results of office evaluation.  Decisions regarding human resource 
systems, such as rewards, attrition, training and development, and 
movements will now have to take into consideration the results of the 
PMS. 
 
The PMS entry points for change are multiple and may be clustered 
into the following: 
 
Tasks/Behavioral:  
 Top and middle managers will have to do performance target 

setting, monitoring, evaluation and rewarding and ensure 
compliance of the staff with the set standards.  

 Individuals will now have to comply with the defined performance 
standards and learn to document their performance.   
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Processes/Systems:  
 Performance target setting, monitoring, evaluation and rewarding 

processes will be institutionalized.   
 Performance measures will be aligned, deployed, tracked and 

evaluated at the office and individual levels. 
 Evaluation and computation of rewards at the office and individual 

levels will be system generated. 
 Human Resource systems will be aligned with the results of the PMS. 

 
Standards:  
 Financial and non-financial standards will be identified, 

standardized, deployed and used as bases for decision making 
such as human resource movements, training and development, 
rewards and attrition. 

 Emerging good practices/determinants of good performance at 
the office and individual levels will be documented and 
consistently used as BOC-wide benchmarks. 

 Good practices are established, repeated and continuously 
enhanced. 

 
These changes will have to be introduced in an incremental, 
progressive manner. The PMS project installation will have to adopt a 
phased-implementation approach.  This means few but “critical” set of 
performance measures will be identified and carefully tracked across 
ports initially until they are cascaded to the offices and individuals.   
 
For the first year, recommended critical performance measures that 
need to be tracked, aside from collection are assessment versus 
declared values and average turn-around time in the release of goods 
under the three selectivity schemes: red, yellow and green.  The first is 
a good indicator of quality of assessment.  The latter, if consistently 
tracked and analyzed is a good indicator of process improvement. 
More performance measures will be added as the Agency sees fit.  It 
also means that at the onset, Agency measures will be cascaded until 
the Port/District and Group levels only.  
 
For the second year, the Port/District measures will be cascaded to the 
Division and Section levels.   
 
For the third year, the Division and Section level measures will be 
cascaded to the individual levels. 
 
Thus, the timeframe for the full and comprehensive installation of the 
PMS at the office and individual levels will be at least three (3) years. 
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All these imply that for PMS to be installed and implemented in a 
sustained manner, a well-mapped out change management strategy 
will have to be crafted by the PMS Teams.   
 
The next section focuses on the level of readiness of the BOC for the 
changes that go with the implementation of the PMS. 
 

Assessing the level of readiness of the BOC for the PMS 
installation 
 
Resistance level: Resistance to the PMS is high because the system is 
associated with the implementation of the Attrition Act.  All 15 District 
Collectors refused to sign the performance contracts presented by 
Customs Commissioner Napoleon Morales in the Command 
Conference held last March 19, 2007.  Several employees staged a 
rally during their lunch break to protest the penalty clause in the 
Lateral Attrition Law last March 30, 2007.  Change management 
strategies focusing on top and middle management will form a critical 
component in the BOC-PMS installation. 
 
Capacity for change: Organizations have limited capacities for 
change.  If the organization is experiencing a large degree of change, 
then implementing yet another change can be difficult.  A number of 
changes in BOC are in the pipeline.  These are the implementation of 
Integrity Development Action Plan, computerization of the BOC core 
export processes and the Organization Rationalization Plan.  The 
installation of the PMS will have to consider other change initiatives of 
the BOC because other change initiatives will potentially target the 
same people. 

 
Leadership styles and predisposition to change: Leadership styles play 
an important role in change management planning.  Studies show 
that sponsorship and management support are key success factors for 
the installation of the PMS.  
 
The leadership structure in BOC is perceived to be centralized with 
decisions emanating largely from the top management.  The District 
Collectors form part of that management structure.  They are a 
powerful block to reckon with in the implementation of the PMS.  They 
will have to define the strategic directions of the Districts, identify 
measures and manage the resistance at the District level.   The middle 
managers such as the Deputy Collectors and Division Chiefs, on the 
other hand, are the ones who have direct access and influence on 
the employees of BOC.  It is equally important that they are allies in the 
installation and sustained implementation of the PMS, because they 
can yield the desired influence on the employees. 
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Both the District Collectors and Deputy Collectors have high resistance 
to the PMS because it is associated with the implementation of the 
Attrition Act.   
 
Initial actions will have to be geared towards winning the minds and 
hearts of the District and Deputy Collectors towards the installation 
and sustained implementation of the PMS.  Just like any change 
initiative, it will be a good exercise to identify the potential allies and 
“villains” in the PMS installation.  A different “change management” 
approach will have to be adopted for each key stakeholder. 

Recommendations on the installation of the PMS 
 

Considering that the PMS installation has to involve the whole Agency, 
the changes are multi-pronged and the resistance level of the top and 
middle management is high, installing the PMS in BOC falls in the 
quadrant labeled “high risk”.   
 
Figure 1: Risk Profile of PMS in BOC 
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4.  Small, incremental change  
to change ready 
Organization 
 
Low risk 

 
Change Resistant Organization  

 
Change Ready Organization  

 

 
Organizational Attributes 

 
 
 

 
Since the project is high risk, the following actions are recommended. 
 
 Adopt a phased implementation approach in the installation of the 

PMS. 
 Prepare for the change. Form and train the PMS Teams to install the 

PMS.  
 Manage the change. 
 Implement the change by institutionalizing the performance 

management cycle. 
  Reinforce the change. 
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Adopt a phased implementation approach  
 
The installation of a full-scale PMS will take some time.   
 
For the first year, critical few BOC-District level performance measures 
will be adopted across ports by the top management.   This means 
targets are clearly defined, documentation tools mutually agreed on 
and used.  It also entails evaluating, comparing and analyzing the 
performance of ports against these measures.  For the first year, 
possible metrics aside from collection recommended and approved 
by CUSCOM Napoleon Morales on April 17, 2007 are: 
 
Table 4: Recommended critical few measures for Year 1 of PMS 
 

Possible measures for the Operations Offices 
Assessed values/Declared values 
Amount collected as a result of alert orders issued 
Number of alert orders issued 
Amount collected from post entry audit conducted 
Number of post entry audit conducted 
Amount collected from seizure cases 
Number of seizure cases 
Number of RAT cases filed in DOJ 
Number of RAT cases favorably resolved 
Ratio of dutiable entries versus non-dutiable entries 
Ratio of warehouse entries versus export entries 
 
These metrics will be presented to the District Collectors for validation. 
The next step entails installing standardized documentation formats 
that will be used to monitor performance across ports.  Examiners will 
now have to encode both declared and assessed values.  This is 
potentially threatening to many because it is an added work but with 
clear and decisive instructions from top and middle management, the 
examiners will have no choice but to comply.  Documentation of this 
one metric alone will be met with a lot of resistance.  This has to be 
anticipated and proactively managed. 
 
For the second year, more measures may be added and cascaded 
from the District/Group to the Division and Section levels.  Ports will now 
be clustered according to pre-determined factors.  Based on these 
factors, ports with the same core processes such as all free ports, 
seaports and airports will now be grouped together with the 
assumption that they may have the same contracts.4   
 
For the third year, Section level scorecards may be cascaded to the 
individual levels.  

 

                                                 
4 Possible clustering of ports is reflected in Appendix 3. 
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A summary of the possible progression in the installation of the PMS is 
shown in the table below. 
 
Table 5: Proposed installation timeline 

Installation Timeline 
Year 1 

Office performance 
contracts contain balanced 

set of measures at the 
 BOC and District Levels 

Year 2 
Office performance 

contracts contain balanced 
set of performance 

measures at the BOC, 
District, Division and Section 

levels 

Year 3 
Office performance 

contracts are 
cascaded to the 
individual level  

Target setting 
PMS Sponsors such as the 
CusCom, EXECOM and 15 
District Collectors choose 
BOC–wide performance 
measures. All Districts adopt 
the performance measures.  
Performance targets, 
monitoring and evaluation 
processes are standardized 
across districts to make 
performance analyses and 
comparisons feasible. 

PMS Sponsors will now have 
to multiply sponsorship of the 
PMS.  District targets will be 
cascaded to the Division 
and Section levels. 

Individual performance 
contracts are aligned 
with office 
performance 
contracts.  
Section level metrics 
cascaded to the 
individual levels. 
Competencies 
required to produce 
outputs identified.  
Competencies used as 
“hub” for aligning BOC 
Human Resource 
Systems. 
 

Monitoring 
Agency and District 
Scorecard ratings are 
monitored periodically.   

Districts, Divisions and 
Sections are monitored 
periodically. 

Individual performance 
contracts monitored on 
a semestral basis. 

Evaluation 
Agency and Districts are 
evaluated based on the pre-
agreed set of performance 
measures. 
Individuals are still evaluated 
using the old system, PES. 

Districts, Divisions and 
Sections are evaluated; 
Similar offices compared. 
Individuals are still evaluated 
using the PES. 

Individuals are 
evaluated using the 
PES that is aligned with 
the Office Scorecards. 
 

Rewarding 
Offices are rewarded based 
on Scorecard ratings.  
Individuals are rated using 
the rewards framework. 

Offices are rewarded based 
on Scorecard ratings.  
Individuals are rated using 
the rewards framework. 

Individuals are 
rewarded based on 
financial and non-
financial measures 

Change management 
Visible, sustained top 
management sponsorship of 
the project is required.   
A communication plan 
focusing on the rationale 
and gains of the PMS should 
be instilled in top and middle 
BOC managers across ports. 
 

Deputy collectors are 
trained to   be effective 
“coaches” to their personnel 
in the sustained 
implementation of the PMS.  
They are also trained on 
anticipating and managing 
possible resistance to the 
PMS. 

Individuals are trained 
to align their targets to 
the office and monitor 
their performance 
using pre-structured 
monitoring tools; 
Section chiefs taught to 
evaluate performance. 
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Installation Timeline 
Year 1 

Office performance 
contracts contain balanced 

set of measures at the 
 BOC and District Levels 

Year 2 
Office performance 

contracts contain balanced 
set of performance 

measures at the BOC, 
District, Division and Section 

levels 

Year 3 
Office performance 

contracts are 
cascaded to the 
individual level  

District collectors are trained 
and coached on the skills 
involved in PMS: strategic 
and aligned target setting, 
monitoring and 
documentation of 
performance data, 
evaluation and continuous 
improvement of offices and 
cascade of performance 
data to the individual level.   
They are also trained how to 
manage potential resistance 
in the installation of the PMS. 

Office Performance Management Information System (OPMIS) 
 
PMIS used as a stand alone 
system.   

 
PMIS used as a stand alone 
system. 

 
PMIS may be 
integrated with existing 
management 
information systems in 
BOC. 

 

Prepare for change by forming and training the PMS 
Teams 
The PMS installation process will have to be steered and managed by 
critical stakeholders internal to BOC for more ownership and buy-in of 
the system.  The PMS teams will be formed with distinct and 
complementing roles.  It shall be composed of three levels of 
stakeholders: 
 
 The PMS sponsors shall champion the PMS and provide strategic 

directions.  They shall be composed of the CusCom, EXECOM and 
the 15 District Collectors. 

 The PMS process owners shall provide technical support to the PMS 
sponsors.  They will consolidate and analyze performance data of 
the Agency.  They will also communicate the performance results 
of the BOC. They shall be composed of the Finance Service, 
Human Resource Service and Interim Internal Control Office. 

 The PMS Monitoring &Evaluation Teams shall ensure the integrity of 
the performance data in the Districts. They shall be composed of 
the Deputy Collectors across Districts.  Studies show that middle 
managers have the most access and influence on the employees.  
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It is critical that the Deputy Collectors are allies in the installation of 
the PMS. 

 
A diagram showing the relationship among the PMS critical 
stakeholders is shown below. 
 
 
 
 
Figure 2: The PMS Stakeholders, their composition and roles 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

M&E teams for every District 
composed of the Deputy 

Collectors assisted by Data 
Monitoring Unit 

 

Performance 
Quality Assurance 

PMS Process Owners composed of the 
Finance Service, Human Resource 
Service and Interim Internal Control 

Office, Incentives Review Committee 

Performance 
Integrators and 

Analysts 

PMS Sponsors composed of the CusCOM, 
ExeCOM and the District Collectors 

Strategic Direction 
Providers 
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The PMS Teams are assessed on their level of ADKAR or Awareness, 
Desire, Knowledge, Ability and Reinforcement on the roles that they 
will assume in the implementation of the PMS. 
 

Table 6: ADKAR level of BOC-PMS Stakeholders 

  ADKAR Level  by PMS 
team 

Remarks 

  Sponsors Process 
Owners 

M&E 
Teams 

 

A Awareness of the need for 
PMS 

High High Low Some sponsors 
and process 
owners attended 
the PMS 
orientation in 
September 2006. 
They have a high 
level of awareness 
for the need for 
PMS. 

D Desire to participate and 
support the PMS 

Low High Low PMS is associated 
with Attrition Act 
implementation 
which is 
encountering high 
level of resistance 
among the District 
Collectors. PMS 
Sponsors and ME 
Teams are 
attritable based 
on the 
Implementing 
Rules and 
Guidelines; the 
Process Owners 
are not attritable, 
thus they are not 
threatened by the 
installation of PMS. 

K Knowledge on PMS 
processes e.g. 
performance target 
setting, monitoring, 
evaluating, analyzing. 

Low Low Low Deeper 
understanding of 
PMS required. 

A Ability to implement 
required PMS skills 

Low Low Low More coaching 
sessions on PMS 
skills required. 

R Reinforcement to sustain 
the change 

   Attrition Law provides 
for a sizeable 
amount of reward. 
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With a low level of awareness, desire, knowledge and ability to 
implement the PMS, the PMS Teams will have to go through a 
combination of structured training and coaching sessions with different 
focus for each team based on the roles that they will play in the 
installation and implementation of the PMS in BOC. 

 
The following are the priority training and coaching interventions for 
the PMS Teams.   
 
Table 7: Training and Coaching Sessions for PMS Sponsors 

Priority #1: 
 

Training and Coaching Sessions for 
PMS Sponsors 

ADKAR level of  
PMS Sponsors 

Awareness of rationale of PMS is high after the 
attendance to PMS workshop in September 2006; 
Resistance to the Attrition Act is high.  All 15 
District Collectors refused to sign the 
performance contracts presented by Customs 
Commissioner Napoleon Morales in the 
Command Conference held last March 19, 2007. 
Knowledge on PMS still needs more deepening 
through skills application.   

Competency Gaps 
(in Knowledge, Skills, and 
Attitudes/Orientation 
form)  

   
Lack of capability in PMS including selecting, 
cascading, documenting and analyzing 
performance measures; 
 
Lack of knowledge and skills in managing 
change, including people, systems, and tasks 
 

Training/Coaching 
Objectives  

   
Training and coaching sessions on PMS and 
change management shall be given this group.  
PMS will focus on the technical side of change; 
change management will focus on the people 
side of change.  Both training programs aim to:  
 
 Increase the level of  understanding and 

appreciation of PMS 
 Develop a plan for installing PMS in their 

District 
 Develop a change management plan to 

address resistance to the PMS. 
 

Expected Outputs  

   
 BOC Strategy Map 
 BOC scorecard 
 District Scorecard/Measure Dictionary 
 PMS Installation Plan in own District 
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Priority #1: 
 

Training and Coaching Sessions for 
PMS Sponsors 

 PMS-Change Management Plan in own 
District 

Proposed Approach 

  Combination of training and coaching sessions 
 
1st training/coaching session shall focus on PMS 
concepts and completion of PMS Installation 
Plans. PMS Tools will be applied such as the 
Strategy Map, Scorecards, Measure Dictionary 
and PMS Process map.  This will be conducted in 
3 instructional days (preferably on a Saturday, 
Sunday and Monday). 
 
2nd training/coaching session shall dwell on the 
people side of change at the District Level. 
Change management tools e.g. Sponsorship 
Roadmap, Resistance Management, 
Communication Plan, Training and Coaching 
Plans will be mapped out.   This will also be 
conducted in 3 instructional days.   
 
Expected participants are the CusCom, EXECOM 
and the 15 District Collectors of the BOC. 
 

Proposed training and 
coaching content 

The following are some content areas of this 
training intervention: 
 PMS Basics 
 PMS Tools 
 PMS Installation framework 
 Change management concepts and tools 
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Table 8: Training and Coaching Sessions for PMS Owners 

Priority #2: Training and Coaching Sessions for 
PMS Owners 

ADKAR level of  
PMS Owners and other 
issues 

The Process owners have a high level of 
awareness of and desire to implement the PMS.  
However, knowledge and skills level in specific 
PMS skills are required. 
 
The Finance Service has yet to formulate and 
apply a clear financial goal allocation 
framework.  
 
The Interim Internal Control Office has yet to learn 
to apply the PMS Tools so they can effectively 
coach the offices in the identification and 
cascade of performance measures. This office is 
currently not tasked to evaluate and analyze 
office performance.  Another office will yet be 
formed to perform such functions.  Personnel will 
still be deployed to this Office.  
 
The Human Resource Service has yet to align he 
Individual PES with Office PMS.   

Competency Gaps 
(in Knowledge, Skills, and 
Attitudes/Orientation 
form)  

   
Lack of knowledge and capability in PMS 
including selecting, cascading, documenting 
and analyzing performance measures; 
 
 

Training/Coaching 
Objectives  

   
As a result of the training and coaching sessions 
on Financial Goal allocation, Office and 
Individual PMS, the participants should be able 
to:  
 Develop/apply a financial goal allocation 

framework in deploying financial goals across 
districts/divisions in BOC 

 Apply the PMS tools  
 Develop performance documentation, 

analytical tools and management reports 

Expected Outputs  

   
 Financial goal allocation framework 
 Performance documentation tools 
 Performance management and analyses 

reports 
 BOC PMS Process Map 

Proposed Training and 
Coaching Content 

 Training sessions on: 
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Priority #2: Training and Coaching Sessions for 
PMS Owners 

 
 Goal allocation framework 
 PMS tools 
 Office Documentation tools 
 Office Performance evaluation  
 PMS Process Map 

 
Coaching sessions on the application of 
concepts: 
 District targets, Means of verification tools and 

sample analyses 
 Division Targets, Means of verification tools 

and sample analyses 
 Individual targets, means of verification tools 

and same analyses 
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Table 9: Training and Coaching Sessions for PMS M&E Teams 

Priority #3: Training and Coaching Sessions for PMS 
Monitoring and Evaluation Teams 

ADKAR level of  
PMS Monitoring and 
Evaluation Teams 

Resistance to the Attrition Act by this group is also 
high although still latent. 
 
Level of awareness, desire, knowledge, and 
ability on PMS processes by this group is low.  Only 
the POM has attended workshop on PMS. 
 

Competency Gaps 
(in Knowledge, Skills, and 
Attitudes/Orientation 
form)  

   
Lack of knowledge and capability in PMS 
including selecting, cascading, documenting 
and analyzing performance measures; 
 
Lack of knowledge and skills in managing 
change and resistance. 
 
 

Training/Coaching 
Objectives  

   
As a result of the training and coaching sessions 
on PMS and change management, this group 
should be able to: 
 Enhance their level of understanding and 

appreciation of PMS and their roles in its 
implementation 

  Validated the Sponsors’ PMS Installation Plan 
in the District 

 Validated the Sponsors’ Change 
management plan to address resistance to 
the PMS in the District 

 Developed an approach for ensuring integrity 
of performance data in their District. 

 

Expected Outputs  

 PMS Installation Plan validated 
 PMS Change Management Plan validated 
 Plan or approach for ensuring integrity of 

performance data in the District 
 Means of verification tools 
 Strategy Map, Scorecard, Measure Dictionary 

validated 

Proposed 
Training/Coaching 
Content 

 PMS Basics and Tools  
 Change Management Basics and Tools 
 Office and Individual performance analyses 

and evaluation 
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Manage the change 
 
For PMS sponsors in the BOC to have a high stake in the PMS 
installation and implementation processes, they are taught to install 
the PMS in their respective districts.  The PMS installation plan shall 
contain the technical aspect of the change: what measures will be 
monitored, how these will be monitored and evaluated using various 
PMS tools such as the Strategy Map, Scorecard, Measure Dictionary, 
Process Map and Management Information System. 
 
Aside from mapping out a PMS Installation Plan, the PMS sponsors are 
also expected to manage potential resistance to the PMS in their 
respective Districts.  The PMS Team will be taught to formulate a 
Change Management Plan which is basically a set of processes and 
tools that can be used to manage the human side of PMS installation. 
Studies show that to meet the objectives of any project, both the 
technical and the people side of projects should be carefully mapped 
out.  The Change Management plan shall contain the following: 
 
PMS Team Roadmap 
 
This shows the main activities, roles and responsibilities of the PMS 
Sponsors, Owners and M&E Teams at each phase of the PMS project 
to sustain the PMS installation/implementation processes.  There should 
be a shared understanding of roles and expectations from each 
member of the PMS Team across the phases of the PMS Installation 
Process. 

 
Who will perform: 
 PMS Team consisting of the PMS Sponsors, Owners and M&E Teams 

 
How it is performed: 
 Prepare a plan where roles, strategies and activities by the PMS 

Team are mapped out at each phase of the PMS project. 
 The major phases of the PMS project are (1) Start-up and Design (2) 

Implementation and (3) Continuous Improvement. 
 The strategies and activities are further categorized by the primary 

target audiences: PMS Sponsors, PMS Owners and M&E Teams 
 The Table below shows possible activities with the rows representing 

key roles/project timing and the columns representing the primary 
target audiences. 
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Table 10: Sample PMS Team Roadmap 
 PMS Sponsors PMS Owners PMS M&E Teams 
Key People CusCom, EXECOM 

and District 
Collectors 

HR Service, Internal 
Control Office and 
Finance Service 

Deputy Collectors 
in the Ports 

Key Roles Champion the PMS 
installation 

Sustain the PMS 
installation and 
implementation 
process 

Ensure the integrity 
of performance 
data in the District. 

Start up and Design  Seek outside 
expertise in 
training the 
PMS Sponsors 
on PMS and 
Change 
Management 

 Identify Office 
level 
performance 
measures. 

 Formulate a 
PMS Installation 
& 
Implementation 
Plan 

 Formulate a 
Change 
Management  

 Firm up BOC 
Strategy Map, 
Scorecards, 
and Measure 
Dictionary. 

 Create key 
messages that 
they will use to 
increase level 
of awareness 
and desire for 
the installation 
of a PMS. 

 

 Select the right 
team members 

 Firm up office 
goal allocation 
framework for 
both financial 
and non-
financial 
metrics 

 Firm up PMS 
Process Map. 

 
 

 Seek outside 
expertise in 
training the 
PMS Sponsors 
on PMS and 
Change 
Management 

 Validate the 
PMS Installation 
Plan 

 Validate  
Change 
Management 
Plans  

 Formulate 
Performance 
Integrity/Qualit
y assurance 
plan. 

 

Implementation  Implement the 
PMS Installation 
& 
Implementation 
Plans. 

 Communicate 
the rationale of 
the PMS. 

 Manage 
resistance in the 
Port. 

 Manage the 
PMS 
Implementation 
Process 

 Implement the 
PMS/ Change 
Management 
Plans 

 Coach the PMS 
Sponsors and 
M&E Teams 

 Implement the 
PMS Installation 
& 
Implementation 
Plans. 

 Formulate 
means of 
verification 
tools 

 Ensure 
submission of 
performance 
data reports 

 Year 1  Cascade the  Ensure  Cascade the 
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 PMS Sponsors PMS Owners PMS M&E Teams 
Key People CusCom, EXECOM 

and District 
Collectors 

HR Service, Internal 
Control Office and 
Finance Service 

Deputy Collectors 
in the Ports 

Key Roles Champion the PMS 
installation 

Sustain the PMS 
installation and 
implementation 
process 

Ensure the integrity 
of performance 
data in the District. 

Strategy Map 
 Align District 

Scorecards 
with the BOC 

 Check the 
quality of the 
Measures 
Dictionary. 

 Ensure 
documentation 
and evaluation  
of required 
performance 
data 

 Check the 
quality of data 
sources. 

 Use evaluation 
data as basis 
for next year 
planning. 

alignment in 
performance 
measures from 
the BOC to the 
District levels 

Strategy Map 
 Align District 

Scorecards 
with the BOC 

 Check the 
quality of the 
Measures 
Dictionary. 

 Ensure 
documentation 
and evaluation  
of required 
performance 
data 

 Check the 
quality of data 
sources. 

 Use evaluation 
data as basis 
for next year 
planning. 

 Year 2  Align Division 
and Section 
Scorecards 
with the District. 

 Ensure 
improvements 
in performance 
measures 

 Ensure 
alignment in 
performance 
measures from 
the District to 
the 
Division/Section 
levels 

 Align Division 
and Section 
Scorecards 
with the District. 

 Ensure 
improvements 
in performance 
measures 

 Year 3  Align Individual 
Scorecards 
with the 
Division and 
Section levels. 

 Ensure 
improvements 
in performance 
measures 

 Ensure 
alignment in 
performance 
measures from 
the 
Division/Section 
levels to the 
individuals 

 Align Individual 
Scorecards 
with the 
Division and 
Section levels. 

 Ensure 
improvements 
in performance 
measures 

Continuous 
improvement 

 Ensure 
continuous 
improvements 
in the PMS 
process 

• Ensure 
continuous 
improvement
s in the PMS 
process 

 Ensure 
continuous 
improvements 
in the PMS 
process 
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Resistance Management Plan 
 
This is a proactive approach in managing resistance to the PMS.  
During the Start-up and Design Stage, forms of resistance must be 
anticipated by the PMS Sponsors, specifically the District Collectors, in 
their respective Districts. 
 
Who will perform: 
 PMS Sponsors and M&E Teams 

 
How it is performed: 
 Define the forms and possible causes of resistance for the most 

affected levels in BOC for each port. 
 Define a strategy for managing resistance to the PMS. 
 Prepare a resistance management plan. Communicate the 

resistance management plan with the PMS Process Owners. 
 

Approach: 
 Identify the forms and root causes of resistance.  
 PMS Sponsors and M&E Teams should address and manage the 

resistance in their respective ports. 
 In most cases, resistance is best managed by the Division and 

Section Chiefs.  The PMS Installation/Implementation and Change 
Management Plans must be communicated to the Division and 
Section Chiefs. 

 Communicate the consequences for not supporting the PMS 
implementation. 

 Implement the consequences for not supporting the PMS 
Implementation.  Speed in dealing with resistance must be quick 
and decisive.   

 Seek expert support in the coaching of PMS Sponsors, M&E Teams 
and Division and Section Chiefs in the management of resistance, if 
needed. 

 
Communication Plan 
 
This entails developing a communication matrix that includes targeted 
audiences, key messages, and frequency of communications, delivery 
mechanisms and senders.   This is needed to create a roadmap of the 
required communications across the phases of the PMS installation. 
 
Who will perform: 
 PMS Owners  

 
How it is performed: 
 Identify the audiences.  These are the people who are most 

impacted by the PMS installation project.  For the first year, this will 
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be the District Collectors, Deputy Collectors, Division and Section 
Chiefs. 

 Identify key messages for each audience for each phase of the 
project. 

 Determine content packaging, delivery mechanism (email, one-
on-one meetings) and sender. 

 Prepare and present the Communication Plan to the PMS Sponsors 
and M&E Teams. 

 The output of the PMS Communication Plan will be a table like the 
one below for each target audience. 

 
Table 11: Sample Communication Plan Template 
Target audience 
Phase of the project Message content Delivery mechanism Sender 
    
    
    

 
Training Plan 
 
This is critical in building the knowledge and ability in the installation, 
implementation and continuous improvement in the PMS process.  
Training shall focus on the following: 
 PMS skills such as performance target setting, monitoring and 

analyses and evaluation.  
 Performance measures alignment from the BOC to the Districts, 

Division, and Section and Individual levels. 
 Construction of M&E Tools 

 
Who will perform: 
 Managed by the HR Office; Seek external expertise if needed 

 
How it is performed: 
 Identify the audiences that require training.  Priority should be given 

to the PMS Process Owners, PMS Sponsors and M&E Teams; others 
are the Division and Section Chiefs and employees. 

 Identify skills needed during the installation and implementation of 
the PMS 

 Conduct the required training. 
 

 
 
Coaching Plan 
 
The Coaching Plan defines the support needed by the PMS Teams 
during the PMS installation and implementation process.  The PMS 
teams must be empowered to implement the PMS and manage the 
resistance that go with its installation.  A good coaching plan enables 
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the PMS Teams to become effective coaches during the 
implementation of the PMS. 

 
Who will perform: 
 Managed by the HR Office; Seek external expertise if needed 

 
How it is performed: 
 Develop coaching requirements and activities for the PMS Owners, 

PMS Sponsors and M&E Teams across stages of the PMS 
implementation process. 
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Implement the change 
Once there is a clearer 
understanding of the need for 
PMS, its implementation activities 
and the roles of the critical 
stakeholders in its 
implementation, the BOC is 
geared up for PMS.  This means 
that Districts will now go through 
a yearly institutionalized process 
of defining office targets, 
monitoring and evaluating 
performance.   

Planning 
Monitoring 

Rewarding 
Evaluating 

 
The target setting phase entails defining the performance measures 
and targets.  For year 1, the measures will be at the District/Group 
levels.  For year 2, District and Group measures will be cascaded to the 
Division and Section levels.  For year 3, the Section measures will be 
cascaded to the individual levels.   
 
Table 12: Major activities during the target setting phase 

Activities Who will 
perform 

Time frame 

  Yr 1 Yr 2 Yr 3 
Articulate the District and Division Mission and 
Vision. 

PMS Sponsors       

Translate the mission and vision statements 
into a strategy map. 

PMS Sponsors       

Formulate the Scorecards at the District level.  PMS Sponsors       
Capture the operational definition, data 
source, target and rating scheme of each 
measure at the office level in the measure 
dictionary. 

PMS District 
Collectors , PMS 
M&E Teams and 
PMS Process 
Owners 

      

Cascade the Scorecards at the District to the 
Division and Section levels. 

      

Cascade the Division and Section Scorecards 
to the Individual level. 

     

 
The monitoring phase involves the documentation and management 
of performance at the office and individual levels to ensure targets are 
attained.  The specific steps are 
 
 
Table 13: Major activities during the monitoring phase 

Activities Who will 
perform 

Time frame  

  Yr 1 Yr 2 Yr 3 
Ensure presence of monitoring mechanisms 
and means of verification tools. 

PMS M&E Teams       

Assess quality of information and 
appropriateness of data sources. 

PMS M&E Teams 
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Activities Who will 
perform 

Time frame  

  Yr 1 Yr 2 Yr 3 
Track and analyze performance data. PMS Process owners       
Take corrective actions. PMS Sponsors       

 
The evaluation phase involves the process of consolidating 
performance data and determining ratings for actual performance at 
the office and individual levels.  The specific steps are: 
 
Table 14: Major activities during the evaluation phase 

Activities Who will 
perform 

Time frame  

  Yr 1 Yr 2 Yr 3 
Compute overall performance rating at the 
District and Group levels  

PMS Process Owners     

Compute performance rating at the District, 
Group, Division and Section levels 

PMS Process Owners      

Compute performance rating at the District, 
Group, Division, Section and Individual levels. 

PMS Process Owners       

Analyze strengths and areas for 
improvement at the office level 

PMS Teams    

Do comparative office performance analysis PMS Process Owners       
Analyze strengths and areas for 
improvement at the individual level 

PMS Teams     

Do comparative individual performance 
analysis 

PMS Process Owners     

Enhance areas of strength and address gaps 
in next performance management cycle. 

       

Consolidate and communicate 
performance results. 

       

 
The rewarding phase involves the distribution of rewards across offices 
and individuals of the BOC, assuming the District/Division exceeds its 
collection targets.   
 
Table 15: Major activities during the rewarding phase 

Activities Who will 
perform 

Time frame  

  Yr 1 Yr 2 Yr 3 
Assign weights to each individual and office. PMS Process Owners       
Distribute the rewards. 
 

PMS Process Owners       

 
The performance management cycle starts again with the intention of 
enhancing areas of strength and addressing areas for improvement at 
the office and individual levels. 
 

Reinforce the change 
 
For PMS to be implemented in a sustained basis, reward Districts that 
are implementing the PMS.  Collect and analyze installation and 
implementation issues related to PMS.  Diagnose gaps and manage 
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resistance.  Implement corrective actions to districts not implementing 
the PMS.  A possible course of action is to consider the presence of a 
working PMS as a factor for deploying office rewards. 
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Appendices 

1. The list of participants who validated the BOC 
Strategy Map and Scorecard. 

 
Name Office/Designation 

1. Arsenia C. Ilagan Chief, Garments and Textile MFTG Bonded Warehouse 
Division 

2. Ellen G. Handumon Chief, Administrative Division 
3. Gliceria R. Umandap Chief, Liquidation and Billing Division 
4. Nicky Earle L. Hortillas Chief, Law Division 
5. Raymund P. Cabigon Chief, Warehouse Inspection Division 
6. Romalino G. Valdez Chief, Miscellaneous Manufacturing Bonded Warehouse 

Division 
7. Sonia C. Togonon Deputy Collector for Administration 
8. Vida D. Aggarao Chief, Collection Division 
9. Louie C. Adviento Chief, Export Division 
10. Lowell L. Medija Chief, Common Bonded Warehouse Division 
11. Wilnora Cawile Chief, Internal Control Office 
12. Ramon O. Hernandez Jr. Acting Chief, Customs Container Control Division 
13. Amelia V. Castro Acting Chief, Informal Entry Division 
14. Rafael Crisol Jr. Acting Chief, ACDD 
15. Melita O. Del Rosario Assistant Chief, Private/Public Bonded Warehouse 

Division 
16. Romulo Pagulayan Chief, Formal Entry Section 
17. Wilmar Bernados Assistant Chief, Bonds Division 
18. Argus Rey S. Thompson Assistant Chief, Piers and Inspection Division 
19. Raymond Ventura Office of the Deputy Collector for Operations 
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2. Strategy Map of BOC  
 

Mission Statement:  We are a government agency tasked to collect revenues, duties 
and taxes for the government to finance projects and services for the Filipino 
people;  suppress smuggling to protect trade and industry;  
Vision Statement: A world class customs service more responsive to clients’ needs 
supportive of government goals, adhering to world’s best practices and fostering 
cooperation with the private sector in building a dynamic organization that every 
Filipino can truly be proud of. 

Financial perspective 
1.  Maximize collection 

performance

 

 
 
 
 

 
 

Process perspective 

Customer perspective  
3. Improve satisfaction 

of stakeholders 
2.  Improve 

compliance level of 
stakeholders

6. Improve the level of 
professionalism and 
integrity of the POM 

personnel 

5. Promote trade 
Facilitation  

4. Improve 
enforcement 
processes 
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3. Possible office clusters by category  
 
Port/Subport Seaport Airport Seaport/ 

Airport 
Freeport Warehousing Special 

Operation 
OCOM       
POM X   x X  
  Mariveles X      
  FTI     x  
  Limay X      
  Laguna    X   
  Cavite    X   
MICP X      
NAIA  X     
   DHL      X 
   Paircargo      X 
   PSI-PAL      X 
   MIASCOR      X 
   Cargohaus      X 
Clark  X  x   
Subic X      
   Morong       
San Fernando X X  X   
   Sual       
   Aparri       
   Baguio       
   Laoag       
Batangas X      
   Siain       
   Puerto Princesa       
Legaspi X      
   Jose 
Panganiban 

      

Cebu   x x   
   Mactan  X     
   Dumaguete X      
Iloilo X      
   Pulupandan       
Tacloban X   X   
   Isabel       
   Catbalogan       
Davao   X  X  
   General Santos X      
   Mati X      
   Parang X      
Zamboanga   X    
  ZIA  X     
  Jolo X      
  Basilan X      
  Bongao X      
Surigao X    X  
  Bislig X      
  Nasipit X      
Cagayan de 
Oro 

X   X X  

  Ozamis X      
  Iligan X      
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Description 

 
 

The collection target of BOC 
is determined by the 
Development Budget and 
Coordinating Committee. This 
chapter presents a method 
for allocating revenue targets 
among the Districts, the use 
of collective targets for 
Individuals, and requisites for 
implementation. It also 
describes how adjustments 
may be made in the DBCC 
assumptions. 
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Objectives 
This chapter aims to: 

• Describe the current method of allocating the DBCC-imposed 
collection target of BOC among its Districts 

• Propose an alternative allocation method in the interim 

• Propose a long-term method for allocating the collection target 
of the BOC among its Districts, or the District targets among their 
component units, and the use of collective targets for 
Individuals.  

• Describe the adjustments that can be made in the DBCC 
estimate to reflect realized values of the parameters 

• Identify issues that must be addressed for rational target 
allocation to be achieved 

Only financial targets are considered in this Chapter, as the main 
bases for evaluating performance that will subsequently be 
complemented by non-financial performance measures. 

Outputs 
 Methodology for allocating the collection target for the interim and 

long-term 
 Data Processing Manual (Appendix) 
 DBCC Assumptions and Adjustments  
 Organization for Target Allocation and Adjustments 

 

Acronyms 
ACOS Automated Customs Operations System 
AFMA Agriculture and Fisheries Modernization Act 
AFTA ASEAN Free Trade Area 
BOC Bureau of Customs 
BOI Board of Investments 
CBW Customs Bonded Warehouse 
CIIS Customs Intelligence and Investigation Service 
CIF Cost plus insurance and freight 
DBCC Development Budget Coordinating Committee 
DOF Department of Finance 
FOB Free-on-board 
HS Harmonized System 
IRRs Implementing Rules and Regulations 
NFA National Food Authority 
NSO National Statistics Office 
PMS Performance Management System 
PEAG Post-Entry Audit Group 
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RA Republic Act 
RPEB Revenue Performance Evaluation Board 
TEF Tax Expenditure Fund 
VAT Value-added tax 
WAMU Warehouse Assessment and Monitoring Unit 
 

Framework and Guiding Principles 
 
As one of the major revenue-generating agencies of the government, 
BOC performance has been evaluated mainly on the basis of its ability 
to deliver on its collection targets. This is now underscored under the 
Attrition Law, which provides for rewards to and attrition of BOC 
personnel on the basis of surpluses or shortfalls relative to the collection 
target.  
 
Collection targets must therefore be determined and allocated 
rationally. Such rationality in this context entails the following: 
 
a. rational targets recognize that BOC revenue is determined by 

exogenous factors as well as effort1 
b. rational targets recognize that exogenous factors may not remain 

constant during the year 
c. rational targets require quality verifiable information  
 
The Development Budget Coordinating Committee (DBCC) 
determines the annual collection target of BOC. This amount is based 
on the projected values of the variables comprising actual collection 
as well as a forecast growth in collection efficiency for the year. The 
former are beyond the control of BOC, with projected variables 
depending on DBCC assumptions about the economy, while the latter 
represents an estimate of BOC-induced improvements in compliance 
or reductions in leakages. This legally-prescribed annual target is fixed 
despite any changes that may have taken place with respect to the 
assumed parameters. The revenue estimate also makes use of ex-post 
data on collection that already incorporates the level of effort, which 
is defined as the actual application of tariff and Customs laws that 
may be different from what is appropriate. 
 
The above considerations drive the method proposed in this Chapter 
of allocating the collection target of BOC down to its Districts and 
Offices, Divisions, Sub-Ports, Units, Sections and attritable individuals so 
that the allocation: 

                                                 
 1 For instance, the IRRs provide that the setting of individual targets shall “strive towards the ability 

to ascribe changes in taxpayer behaviour to specific actions of officials and employees”.   
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• is rational, replicable, transparent, and fair; 
• utilizes all available verifiable data and information; and 
• mitigates any potential perverse incentives against good 

performance and integrity among BOC personnel. 
 
For 2007, the target collection is the only yardstick in the BOC 
Performance Management System (PMS). In future years, the 
balanced scorecard of the PMS will be expanded to take non-
financial metrics into account as well. 
 

Current Method 

General Procedure 
 
Revenue targets are allocated among the collection districts in the 
following manner: 
 
Step 1. Calculate historical shares of each district in actual collections 
per broad type of import (crude, petroleum products, non-oil) and 
type of tax (duties, VAT, excise).  
 
Step 2. Apply these shares to the DBCC-imposed targets categorized 
under existing measures (crude, petroleum products, non-oil, by type 
of tax) and new measures (e.g. lifting of exemptions, VAT increase, 
excise tax by commodity type) to get district targets under each. 
These are summed up to get each district’s total target.  
 
Step 3. Percentage deviations of each district’s collections from their 
respective targets in the previous year are examined in order to 
“balance off” low and high targets. Shifts in jurisdictions such as the 
transfer of subports or particular accounts to other districts are also 
considered in adjusting targets.  
 
Step 4. Calculate monthly targets based on actual figures in the 
previous year.  

 

Current Allocation of the 2007 Target 
 
The DBCC imposed the following targets on BOC for 2007, specifying 
not only the total but targets classified according to duties, VAT, and 
excise taxes, further segregating the amount that falls under the 
existing system and those that are expected from new tax measures.  
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TABLE 1. DBCC PROGRAMMED REVENUE TARGET (P million) 

 Duties VAT Excise TOTAL 
EXISTING   61985 88705  14360 165051 
  Non Oil  88705  135023 
  Crude Oil    7746 
  Petroleum Products    22282 
NEW    63158 
LEGISLATIVE     
Excise tax on motor vehicles  (349) +  
Sin taxes on cigarettes (388) +  
Sin taxes on liquor (300) 

  1037 
 

 

VAT rate increase (15666) +  
Lifting of VAT exemptions  
           on coal (820)  +  
           on crude oil (32675) +  
           on petrol prods (12173) 

 65226 
(61334
+3892) 

  

Less: reduced excise tax on petrol prods    -3892  
EXECUTIVE: Administrative measures (787) 551 236   
TOTAL  62536 154167 11505 228208 
 
 
The procedure for allocating the 2007 collection target was as follows: 
 
Step 1. District shares in actual collections were computed by 
commodity and tax type.  For 2007, the average of each district’s 
performance for the period 2001-2006 was used as the basis for total 
collections by commodity category, 2006 performance was the basis 
for VAT shares, while the average for 2004-2006 was the basis for excise 
tax shares. These shares are summarized in Table 2.  Crude oil imports 
enter only through the Port of Manila and Batangas.  The programmed 
value of non-cash imports called the Tax Expenditure Fund (TEF)2 are 
reported under the Office of the Commissioner (OCom), which does 
not have any collection target.  
 
TABLE 2. CALCULATED DISTRICT SHARES IN COLLECTIONS BY COMMODITY & 
TAX TYPE (%) 

Average for 2001-
2006 

Average for 2006 Average 2004-2006 

Total Collections  VAT Excise Tax 

PORT 

Crude 
 

A 

Petrol 
prods 

B 

Non-
oil 
C 

Total 
 

D 

Crude 
 
E 

Petrol 
prods 

F 

Coal  
 

G 

Non-
oil 
H 

Tob 
 
I 

Alc 
 
J 

MV 
 

K 
San 
Fernando 

0 0 0.7 
 

0.5 0 0 51.24 0.8 0 0 0 

Port of 
Manila  

62.5 20.3 31.6 34.8 64.0 18.0 5.88 29.3 22.1 36.4 43.2 

MICP 0 3.9 40.1 24.4 0 2.0 0 44.0 71.7 52.3 8.4 

                                                  
2 Represents tax subsidy to government agencies since they are allowed to defer payments of 
duties to BOC. Considered as part of revenue under the Attrition Law but excluded under the 
IRRs. 
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NAIA 0 0 13.3 8.3 0 0 0 12.0 2.0 0.1 0 
Batangas 37.5 65.7 6.7 21.6 36.0 69.0 37.58 6.7 0 0 45.6 
Legaspi 0 0 0.02 0 0 0 0 0 0 0 0 
Iloilo 0 0.1 0.2 0.2 0 0 0 0.2 0 0 0 
Cebu 0 0.1 3.1 2.0 0 0 0 3.1 0 3.2 0.1 
Tacloban 0 0.1 0.3 0.2 0 0 0 0.5 0 0 0 
Surigao 0 0 0.05 0 0 0 0 0.1 0 0 0 
Cagayan de 
Oro 

0 0.5 1.5 1.0 0 1.0 5.3 1.6 0 0 0 

Zambo-anga 0 0 0.1 0 0 0 0 0 0 0 0 
Davao 0 0.3 1.0 0.7 0 0 0 1.0 0 0 0 
Subic 0 8 1.2 1.8 0 8.0 0 0.6 4.2 8.0 2.7 
Clark 0 1 0.3 0.3 0 1.0 0 0.3 0 0 0 
OCom/ TEF 0 0 0 4.2 0 0 0 0 0 0 0 

 
 
Step 2.  The estimated shares are applied to the DBCC targets shown 
in Table 1, differentiated according to existing and new measures. 
District shares under existing measures are summarized below.  The 
columns used from Table 2 are indicated. Adjustments to the targets 
are made by the Financial Services Division, and shown in parentheses 
as deductions from or additions to the computed share. 
 
TABLE 3. 2007 DISTRICT SHARES UNDER EXISTING MEASURES (P million) 

DISTRICT Crude Oil 
(Duties, VAT) 

 
apply col A 

Petroleum Product 
(Duties, VAT, Excise 

Tax) 
apply column B 

Non-Oil Imports 
(Duties, VAT, Excise Tax) 

 
apply column C 

TOTAL 

TARGET  7746 22282 135023 165051 
San Fernando - - 551 (815 - 264) 551 
Port of Manila  4839 4815 (4515+300) 38352 (38382 - 30) 48005 
MICP - 871 48727 (48733 - 6) 49598 
NAIA - - 15300 (16169 -1000 

+131) 
15300 

Batangas 2907 14334 (14633 - 299) 8469 (8141 + 328) 25711 
Legaspi - 0 21 21 
Iloilo - 29 273 (267 + 6) 302 
Cebu - 33 4089 (3725 + 364) 4122 
Tacloban - 21 372 (315 + 57) 393 
Surigao - 0 62 (59 + 3) 62 
Cagayan de Oro - 104 1858 (1847 + 11) 1962 
Zamboanga - 4 69 (68 +1) 73 
Davao - 63 1424 (1169 + 255) 1487 
Subic - 1786 1588 (1471 + 117) 3374 
Clark - 222 355 (328.5 + 26.5) 577 
OCom - - 6285 (5774+511) 6285 
TEF - - 7226 7226 
 
New measures affecting BOC collections in 2007 are classified into 
legislative and executive measures as itemized in Table 1.  Under 
legislative measures are the VAT-related reforms of RA 9337 which 
consisted of (a) an increase in the VAT rate from 10% to 12%, (b) the 
lifting of exemptions on coal, crude oil, and petroleum products, and 
(c) reduction of excise tax on kerosene, diesel and fuel oil as a 

 

Bureau of Customs - EMERGE 2-6 
 



Goal Allocation Methodology 

mitigating measure, (d) excise taxes on motor vehicles, tobacco, and 
alcohol.  The net effect of (b) and (c) is already accounted for under 
the targets for petroleum products below. Adjustments to district 
targets are shown in parentheses as deductions from or additions to 
the calculated targets. 
 
TABLE 4. 2007 DISTRICT SHARES UNDER NEW MEASURES: VAT REFORMS  
(P million) 

Lifting of Exemptions  
Crude 

 
apply col E 

Petroleum 
products 

apply col F 

Coal 
 

apply col G 

VAT rate 
increase 

 
apply col H 

TOTAL 

TARGET 32675 12173 820 15666 61334 
San Fernando - 0 320  

(420-100) 
110  

(120-10) 
431 

Port of Manila  18772  
(20772-2000) 

2237 148 (48+100) 4890 
(4590+300) 

26048 

MICP - 275 - 6588 (6888-300) 6862 
NAIA - - - 1673  

(1873-200) 
1673 

Batangas 13903 
(11903+2000) 

8375 308 1256 (1046+210) 23842 

Legaspi - -  2 2 
Iloilo - 29  34 63 
Cebu - 23  484 507 
Tacloban - 23  72 94 
Surigao - -  8 8 
Cagayan de 
Oro 

- 98 43 247 388 

Zamboanga - 1  6 7 
Davao - 54  151 205 
Subic - 937  95 1032 
Clark - 122  49 170 
OCom - -  - - 
 
The fourth legislative measure in the preceding paragraph comes from 
the rationalization of excise taxes on motor vehicles, and the 
indexation of taxes on sin products i.e. cigarettes and fermented 
liquor. 
 
Executive measures consist of administrative initiatives to: (a) improve 
assessment, (b) increase law enforcement, (c) strengthen internal 
audit, (d) check transshipment, (e) expand Super Green Lane, (f) 
collect from demandable assets, (g) expand computerization, and 
others.  Collections from these are shown in Table 5.  
 
TABLE 5. 2007 DISTRICT SHARES UNDER NEW MEASURES: EXCISE TAXES AND 
ADMINISTRATIVE (P million) 

Excise Taxes DISTRICT Administrative 
Measures 

 
apply col D 

Tobacco 
 

apply col I 

Alcohol 
 

apply col J 

Motor 
Vehicles 

apply col K 

Total 
Excise 
Taxes 

TARGET  787 388 300 349 1037 
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San Fernando 4 - - 0 0 
Port of Manila  286  

(285.6 +0.4) 
86 109 151 346 

MICP 201 278 157 29 465 
NAIA 68 8 0 - 8 
Batangas 178 - - 159 159 
Legaspi 0 - - - - 
Iloilo 1 - - - - 
Cebu 16 - 9 0 10 
Tacloban 2 - - - - 
Surigao 0 - - - - 
Cagayan de 
Oro 

8 - - 0 0 

Zamboanga 0 - - - - 
Davao 6 - - - - 
Subic 14 16 24  

(24.4-0.4) 
9 49 

Clark 3 - - 0 0 
 
Step 3. Revenue targets per district are the sum of revenue expected 
from existing and new measures, summarized in Table 6.  
 
TABLE 6. SUMMARY OF DISTRICT SHARES IN BOC 2007 TARGET (P million) 

New Measures DISTRICT Existing 
Measures VAT Reforms Excise Tax Administrative 

TOTAL 

San Fernando 551 431 0 4 985 
Port of Manila 48005 26048 346 286  74685 
MICP 49598 6862 465 201 57125 
NAIA 15300 1673 8 68 17050 
Batangas 25711 23842 159 178 49890 
Legaspi 21 2 - 0 24 
Iloilo 302 63 - 1 366 
Cebu 4122 507 10 16 4655 
Tacloban 393 94 - 2 490 
Surigao 62 8 - 0 70 
Cagayan de Oro 1962 388 0 8 2359 
Zamboanga 73 7 - 0 80 
Davao 1487 205 - 6 1698 
Subic 3374 1032 49 14 4470 
Clark 577 170 0 3 750 
OCom 6285    6285 
TEF 7226    7226 
TOTAL 165051 61334 1037 787 228208 

 

Alternative Method for 2007 
An alternative to the current practice of target allocation is proposed 
for 2007 as an interim method while data for the implementation of the 
long-term method is still being organized. Compared to the current 
method that uses historical shares as the basis for allocation, the  
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alternative method discourages underperformance by making poor 
performers deliver their collection shortfalls in the previous year.  
 
The procedure is as follows: 
 
 
Step 1. Calculate each district’s collection shortfall in 2006.  Sum this 
up. 
 
 
     TABLE 7. DISTRICT COLLECTION SHORTFALLS IN 2006 (P million) 

DISTRICT 2006 TARGET 2006 CASH 
COLLECTION 

SHORTFALL 

San Fernando 958 893 -64 
Port of Manila 67140 65998 -1142 
MICP 59124 46603 -12521 
NAIA 17476 15216 -2260 
Batangas 30847 40866  
Legaspi 17 17 -0.06 
Iloilo 147 306  
Cebu 5202 4012 -1190 
Tacloban 351 455  
Surigao 80 44 -36 
Cagayan de Oro 3111 1866 -1245 
Zamboanga 52 56  
Davao 1560 1356 -205 
Subic 3802 3331 -472 
Clark 584 585  
OCom/TEF 5524 10301+6270  
TEF    
TOTAL 195976 198175 -19135 
 

 
 
Step 2. Calculate the difference between the 2007 BOC target and 
the 2006 BOC cash collection.  From this difference, remove the sum of 
the districts’ shortfalls. 
 

 P Million 
2007 TARGET 228208 

2006 CASH COLLECTION 198175 
  

SUM OF SHORTFALLS 19135 
REMAINING TARGET 10898 
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Step 3. Allocate this remainder among the districts on the basis of their 
respective shares in the 2006 cash collection. 

 
TABLE 8. DISTRICT SHARES IN REMAINING TARGET  

DISTRICT SHARE IN 2006 CASH 
COLLECTIONS (%) 

DISTRIBUTION OF REMAINING 
TARGET (Pm) 

San Fernando 0.45 49 
Port of Manila 33.30 3629 
MICP 23.52 2563 
NAIA 7.68 837 
Batangas 20.62 2247 
Legaspi 0.01 1 
Iloilo 0.15 17 
Cebu 2.02 221 
Tacloban 0.23 25 
Surigao 0.02 2 
Cagayan de Oro 0.94 103 
Zamboanga 0.03 3 
Davao 0.68 75 
Subic 1.68 183 
Clark 0.30 32 
OCom/TEF 8.36 911 
TEF   
TOTAL 100.00 10898 

 
 
Step 4. Compute the 2007 target for each underperforming district 
(marked with asterisks) as the sum of its 2006 cash collection, 2006 
collection shortfall, and share in the remainder in step #3. Compute 
the 2007 target for each performing district as the sum of its 2006 cash 
collection and share in the remainder in step #3. 
 
TABLE 9. 2007 DISTRICT TARGETS (P million) 

DISTRICT 2007 TARGET BASED ON 
ALTERNATIVE METHOD 

2007 TARGET BASED ON 
CURRENT METHOD 

San Fernando* 1007 985 
Port of Manila* 70770 74685 
MICP* 61687 57125 
NAIA* 18313 17050 
Batangas 43113 49890 
Legaspi* 18 24 
Iloilo 323 366 
Cebu* 5423 4655 
Tacloban 480 490 
Surigao* 82 70 
Cagayan de Oro* 3214 2359 
Zamboanga 59 80 
Davao* 1635 1698 
Subic* 3986 4470 
Clark 617 750 
OCom/TEF 17482 6285+7226 
TOTAL 228208 228208 
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Proposed Method for District and Sub-District 
Targets 

Methodology and Data Requirements 
 
The allocation of the BOC target collection will be done at three levels: 
(a) across Districts including the Office of the Commissioner; (b) across 
Divisions, Sub-ports, Units, and/or Sections under each District, and (c) 
across individual attritable personnel.  
 
1. A replicable statistical procedure using available verifiable data will 

measure the relative contribution of each exogenous variable to 
the percentage change in collection per District. The following 
variables, if data on them are available and if found to be 
statistically significant in explaining collection performance, may 
be used. Collections will include duties, VAT, excise tax, and non-
tax revenue.  
• import values (declared and assessed) 
• commodity composition of imports  
• number of entries 
• exchange rate 
• imports selected Green, Yellow, Red 
• duty-exempt or nondutiable imports (under warehousing, 

AFMA, AFTA, etc) 
• tax credits and deferred payments 
• proportion containerized 
• number of personnel 
• budget 
• port infrastructure 

 
2. The above statistical procedure produces the estimated 

percentage contributions of the exogenous variables to each 
District’s historical collection performance and collection effort or 
efficiency growth.  The latter is estimated as a residual between the 
actual collection performance of the District and that portion of 
the collection that is explained by the exogenous variables.  The 
residual is attributable to the intensity and quality of the District’s 
collection effort.  

 
3. The weighted sum of the respective estimated percentage 

contributions of the exogenous variables and the collection 
efficiency growth is the estimated percentage that will be used in 
computing the shares of each District in the target collection of the 
Bureau.  The Commissioner may increase the target collection 
efficiency growth of a District if in his/her judgment its collection 
performance needs to be improved.  The Commissioner may be 
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guided by the following factors in adjusting collection efficiency 
growth:  support infrastructure available and quality of the 
personnel at the District. 

 
4. The Districts’ estimated percentage changes in collection as may 

be adjusted by the Commissioner are applied to BOC’s actual 
collection in the current year or up to the last month of the current 
year where information on actual collection is available, to obtain 
the absolute amounts per District. These are then converted to 
District shares. 

 
5. The District shares are applied to the BOC target for the following 

year to obtain the absolute amounts of the target per District.  
  

The same exercise for allocating the BOC target among the 
Districts may be used to estimate the targets of each Division or 
equivalent level, i.e. Sub-Ports, Units, or Sections, if verifiable data 
for each variable at the level of Districts, Sub-Ports, Units, or Sections 
is available.   
 
If data is not available to allow a decomposition of the factors 
explaining Division, Sub-Port, Unit, or Section collection 
performance, some other replicable allocation of the target 
collection of the District to which these units belong may be used, 
e.g., historical shares of Division, Sub-Port, Unit, or Section 
collections. 

 

Data Processing Manual (see Appendix 1) 
 
The statistical procedure for allocating revenue targets across the 
Districts or Sub-Districts is described separately in the Appendix. 

 

Test Results  
 
To illustrate the proposed long-term method for target allocation, 
available data from ACOS and the Financial Service covering the 
period 2002-2006 was processed following the steps outlined above.  
The data was too aggregated to allow estimation at the sub-District 
level, excluded 5 ports, and was missing in some months for one port. 
Import values were also the declared rather than the actual assessed 
values of the commodity. Nevertheless, while not ideal and complete, 
the exercise is useful in showing how the method works. 
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Step 1. A statistical technique called regression is used to explain the 
systematic dependence of one variable upon others, removing the 
accidental variations and yielding an average relationship.3 In this 
case, collections (C) per District, computed as the sum of duties, VAT, 
and excise tax revenue, is the dependent variable to be explained by 
the following independent or exogenous variables at each District. The 
corresponding variable name is indicated in parentheses.  
 
• import values (Val)  
• number of entries (Ent) 
• exchange rate (Exr) 
• nondutiable import value (Non) - covers warehousing, AFMA, AFTA, 

and other relevant regulations 
• tax credits (TCC) 
• deferred payments (Def) 
• port characteristics (as dummy variable PD)- to capture differences 

in port infrastructure and efficiency, or commodity composition in 
each port 

• month of year (as dummy variable MD) - to capture seasonality of 
imports 

 
The relationship of collections (C) for each port  j  per month of the 
year  t  is formally specified in the following equation as one of 
dependence on port characteristics (PD) and seasonality (MD), 
number of entries (Ent), import value (Val), tax credits (TCC) and 
deferred payments (Def), non-dutiable values (Non) and a residual. 

 

Ct,p = e
A p + α i MDi

i=1

11

∑ + δ j PD j
j=1

14

∑
Entt ,p

β1 Valt ,p
β 2 Exrt,p

β 3TCCt,p
β 4 Deft,p

β 5 Nont ,p
β 6εt,p

 
 
 

The equation is expressed in natural logarithm (ln) terms to yield 
percentage changes in collection per District for a given percentage 
change in each explanatory variable.  Thus the beta coefficients (∃) 
signify the contributions of one-unit changes in each explanatory 
variable to a one-unit change in collection per District: 
 

)ln()ln()ln()ln()ln(

)ln()ln(ln

,,6,5,4,3

,2,1

14

1

11

1
,

ptptptptpt

ptpt
j

jj
i

iippt

NonDefTCCExr

ValEntPDMDAC

εββββ

ββδα

++++

+++++= ∑∑
==  

 

                                                

 

 
3 The procedure is provided in statistical software packages and described in the Appendix.  
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The regression procedure is performed on the available data as 
specified in this manner. Several runs may be attempted for different 
combinations or specifications of the variables and the best fit is 
selected (i.e. the specification with the highest adjusted R-squared). 
Variables with the correct sign that are statistically significant (i.e. 
based on the t-statistic) then explain collection performance and are 
used to predict changes in collections per District. 
 
The estimated equation is: 
 

)ln(ˆ)ln(ˆ)ln(ˆ)ln(ˆ)ln(ˆ)ln(ˆˆˆˆln ,6,5,4,3,2,1

14

1

11

1
, ptptptptptpt

j
jj

i
iippt NonDefTCCExrValEntPDMDAC ββββββδα ++++++++= ∑∑

==

 

 
The regression produced the following constant and beta coefficients.  
Italicized t-statistics indicate which, are the significant explanatory 
variables. A choice may be made whether to use only the significant, 
or all, independent variables in the next steps of the estimation. In our 
example, all explanatory variables were used.  
 
TABLE 10. REGRESSION RESULTS  
VARIABLE ∃  t-statistic 
Constant 3.095  
Febdum 0.069 0.796 
Mardum 0.040 0.479 
Aprdum 0.045 0.552 
Maydum 0.024 0.286 
Jundum 0.029 0.342 
Juldum 0.186 2.197 
Augdum 0.106 1.232 
Sepdum 0.132 1.625 
Octdum -0.017 -0.201 
Nocdum 0.048 0.574 
Decdum 0.083 0.964 
Dum1 (San Fernando) 1.416 3.005 
Dum2B (MICP) -0.149 -2.257 
Dum3 (NAIA) -0.342 -3.555 
Dum4 (Batangas) 0.404 1.115 
Dum6 (Iloilo) -0.833 -1.787 
Dum7 (Cebu) 0.191 1.393 
Dum10 (Cagayan de Oro) 0.379 1.274 
Dum12 (Davao) 0.244 1.239 
Dum13 (Subic)  0.251 1.212 
ln(Ent) 0.096 1.088 
ln(Val) 0.922 14.299 
ln(Exr) -1.614 -3.523 
ln(TCC) 0.007 0.381 
ln(Def) 0.074 5.509 
ln(Non) 0.015 0.701 
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The dummy variables are in relation to a default, January in the case 
of month dummies and Port of Manila in the case of port dummies. 
Their beta coefficients thus indicate performance in relation to the 
default. For instance, the above-unity beta coefficient for San 
Fernando (dum1) shows that its performance is better than that of the 
Port of Manila. Dummy variables may hence be used as an indicator 
of relative performance. 
 
Step 2. The total derivative of the estimated equation is used to 
estimate each District’s growth in collections: 
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This requires forecasts of each explanatory variable. Since we are using 
monthly data, month-on-month growth of each explanatory variable 
for each port is first calculated. That is, the import value of a District in 
January 2003 is compared with its January 2002 figure, and so on. On 
this basis, the value for the next month in the next year is forecasted. 
The table below shows the month-on-month percentage changes and 
forecasts for the Port of Manila as an example. 
 
TABLE 11. MONTH-ON-MONTH CHANGES IN EXOGENOUS VARIABLES AND 
FORECASTS FOR PORT OF MANILA 
Port of 
Manila 

pt

pt

Ent
Ent

,

,∆
 

pt

pt

Val
Val

,

,∆
 

pt

pt

Exr
Exr

,

,∆
 

pt

pt

TCC
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,

,∆
 

pt

pt
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,

,∆
 

pt

pt

Non
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,

,∆
 

Jan 2003 -0.1096 0.1824 0.0419 2.2396 -0.7582 -0.4292 
Jan 2004 0.2664 0.2542 0.0366 -0.4131 4.7818 1.23478 
Jan 2005 -0.2814 -0.0298 0.0043 -0.3585 -0.8984 -0.1405 
Jan 2006 0.1215 -0.5386 -0.0565 -0.7064 14.285 -0.0361 
Forecast 
Jan 2007 

0.0356 -0.6448 -0.0753 -2.0054 14.2154 0.1083 

Feb 2003 -0.1234 0.4667 0.0545 2.0660 2.3092 0.2524 
Feb 2004 -0.0629 0.1918 0.0369 0.1382 1.4905 -0.1238 
Feb 2005 -0.2118 -0.2061 -0.0224 -0.6053 0.2027 0.7567 
Feb 2006 0.1962 -0.2636 -0.0547 -0.6984 0.7093 -0.5104 
Forecast 
Feb 2007 

0.1520 -0.6000 -0.0931 -2.0340 -0.3440 -0.2582 

Mar 2003 0.2442 1.4917 0.0690 2.3697 -0.3924 0.3649 
Mar 2004 0.0849 0.0457 0.0314 -0.6688 -0.2468 -0.1749 
Mar 2005 -0.3391 -0.2777 -0.0331 -0.3782 2.9235 1.0204 
Mar 2006 0.2421 -0.3472 -0.0592 2.3008 0.7227 -0.4452 
Forecast 
Mar 2007 

-0.0495 -1.2319 -0.1102 0.9269 2.3806 -0.1174 

Apr 2003 -0.0441 -0.0545 0.0357 1.9115 0.9534 -0.3507 
Apr 2004 -0.0037 0.6513 0.0586 -0.6956 0.3305 0.1177 
Apr 2005 -0.2613 -0.5623 -0.0253 1.8546 6.8483 0.5060 
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Apr 2006 0.3392 -0.0316 -0.0575 -0.8083 -0.1315 -0.3956 
Forecast 
Apr 2007 

0.2306 -0.2855 -0.0880 -0.8367 2.8159 0.0328 

May 2003 -0.1530 -0.0071 0.0536 2.1942 0.6579 0.2229 
May 2004 -0.0489 0.5123 0.0636 -0.7712 -0.6441 -0.1567 
May 2005 -0.0587 0.0744 -0.0269 -0.6641 14.5429 1.4467 
May 2006 0.1444 -0.0483 -0.0407 27.2611 -0.4694 -0.5895 
Forecast 
May 2007 

0.1915 -0.0075 -0.0810 25.8319 6.4732 0.0224 

Jun 2003 -0.0379 -0.0777 0.0594 0.6763 1.2876 1.2214 
Jun 2004 0.0481 0.4443 0.0484 -0.0516 -0.1104 -0.1315 
Jun 2005 -0.0151 0.2489 -0.0144 -1.0000 0.6465 0.9921 
Jun 2006 0.0246 -0.5663 -0.0367 1.0000 -0.0349 -0.7493 
Forecast 
Jun 2007 

0.0360 -0.4030 -0.0735 0.1618 -0.3555 -0.8640 

Jul 2003 -0.0957 0.4013 0.0616 -0.6960 0.2130 -0.0459 
Jul 2004 -0.2433 -0.2235 0.0417 2.0807 -0.8135 0.2982 
Jul 2005 -0.0948 -0.2074 0.0010 -0.5673 10.2164 0.1759 
Jul 2006 0.4181 -0.0081 -0.0644 8.1223 -0.4443 -0.4371 
Forecast 
Jul 2007 

0.4185 -0.3125 -0.0948 8.1866 4.5574 -0.3262 

Aug 2003 -0.0370 0.1049 0.0618 -0.0626 -0.2021 0.5262 
Aug 2004 -0.0780 -0.1830 0.0153 0.6217 0.1359 0.0866 
Aug 2005 -0.1183 0.6955 0.0021 -0.5993 3.5389 0.0693 
Aug 2006 0.4757 -0.4466 -0.0820 6.4336 -0.4142 -0.2267 
Forecast 
Aug 2007 

0.4350 -0.1513 -0.1119 6.1653 1.4563 -0.4552 

Sep 2003 0.0084 -0.0172 0.0555 1.0987 -0.6207 0.0702 
Sep 2004 -0.0089 0.4658 0.0216 -0.5829 -0.6149 0.5287 
Sep 2005 -0.1830 -0.2053 -0.0010 -0.6855 27.4737 0.8844 
Sep 2006 0.4368 -0.2813 -0.1025 3.8116 -0.7764 -0.5906 
Forecast 
Sep 2007 

0.3411 -0.3753 -0.1307 2.9195 13.2708 -0.1835 

Oct 2003 -0.0188 -0.2274 0.0387 -0.0517 -0.9650 0.4568 
Oct 2004 -0.1440 0.4735 0.0253 -0.3432 -0.2346 -0.0300 
Oct 2005 -0.0560 -0.4065 -0.0112 0.8795 2.5370 0.3611 
Oct 2006 0.5099 0.4629 -0.1024 -0.5446 4.3116 -0.2941 
Forecast 
Oct 2007 

0.4913 0.3734 -0.1273 -0.0790 6.0626 -0.3420 

Nov 2003 -0.0587 -0.1227 0.0387 -0.7787 -0.7421 0.4889 
Nov 2004 -0.0041 0.2417 0.0172 3.9894 0.5162 0.3410 
Nov 2005 -0.2551 -0.5682 -0.0313 -0.4882 0.8426 0.3502 
Nov 2006 0.4117 1.4436 -0.0865 1.7172 0.1857 -0.3879 
Forecast 
Nov 2007 

0.3134 1.2208 -0.1214 1.8625 0.9781 -0.4573 

Dec 2003 -0.5000 -0.7350 0.0360 0.2520 -0.9390 0.3419 
Dec 2004 2.6088 8.5849 0.0133 0.5332 -0.7825 -0.2342 
Dec 2005 -0.0934 -0.4611 -0.0458 -0.2103 52.5728 0.8086 
Dec 2006 0.3611 0.3249 -0.0773 5.5898 -0.0431 -0.2724 
Forecast 
Dec 2007 

0.5644 0.4618 -0.1182 5.3586 26.7128 -0.0391 
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The forecasted values for each District are next multiplied by the beta 
coefficients, and summed up. Again using the Port of Manila example, 
they are as follows: 
 
TABLE 12. ESTIMATED PERCENTAGE CONTRIBUTIONS OF EXOGENOUS VARIABLES 
AT THE PORT OF MANILA 

POM 
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∆
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ˆ ∆
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pt
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ˆ ∆
β  

TOTAL 

Jan 0.0034 -0.5945 0.1215 -0.0140 1.0519 0.0016 0.5699 
Feb 0.0146 -0.5532 0.1503 -0.0142 -0.0255 -0.0039 -0.4319 
Mar -0.0048 -1.1358 0.1779 0.0065 0.1762 -0.0018 -0.7818 
Apr 0.0221 -0.2633 0.1420 -0.0059 0.2084 0.0005 0.1039 
May 0.0184 -0.0069 0.1307 0.1808 0.4790 0.0003 0.8023 
Jun 0.0035 -0.3715 0.1187 0.0011 -0.0263 -0.0130 -0.2875 
Jul 0.0402 -0.2881 0.1529 0.0573 0.3372 -0.0049 0.2947 
Aug 0.0418 -0.1395 0.1805 0.0432 0.1078 -0.0068 0.2269 
Sep 0.0327 -0.3460 0.2110 0.0204 0.9820 -0.0028 0.8974 
Oct 0.0472 0.3442 0.2055 -0.0006 0.4486 -0.0051 1.0399 
Nov 0.0301 1.1256 0.1960 0.0130 0.0724 -0.0069 1.4302 
Dec 0.0542 0.4258 0.1907 0.0375 1.9767 -0.0006 2.6844 

 
Step 3.  The percentage contributions of the exogenous variables are 
summed up for each District per month.  
 
TABLE 13. SUM OF ESTIMATED PERCENTAGE CONTRIBUTIONS OF EXPLANATORY 
VARIABLES PER DISTRICT 
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 JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC 
POM 0.57 -0.43 -0.78 0.10 0.80 -0.29 0.29 0.23 0.90 1.04 1.43 2.68 
1 14.78 0.59 0.36 -0.09 2.94 -4.96 -0.04 -1.53 -0.26 0.93 1.57 -211.11 
2B -0.01 -0.05 0.01 0.00 0.06 0.36 0.84 0.60 0.39 0.64 0.50 1.50 
3 0.13 -0.13 0.64 0.67 0.61 0.49 1.19 0.75 0.60 0.83 0.77 0.57 
4 0.53 0.13 0.82 -0.64 -0.26 -1.17 -0.18 -0.60 -0.12 1.20 -2.07 -0.89 
6 -0.79 178.4 -6.50 -1.44 -14.9 135.1 1.59 224.96 0.05 1.25 9.31 -1.76 
7 -0.42 -1.85 -1.53 -1.26 -0.57 -0.27 0.31 12.95 0.03 58.55 1.53 -1.20 
10 1.56 -0.31 -28.28 -3.71 -0.12 0.43 0.24 0.03 1.69 0.51 0.89 -2.16 
12 4.57 0.50 -2.36 -0.38 4.44 -0.04 -0.18 0.46 0.12 0.34 0.22 -0.80 
13 0.16 -3.42 -0.64 -0.44 -0.94 -1.35 -1.08 -1.00 -1.46 0.63 -0.43 -2.10 

 
 
To these sums are added the constant and contributions of the 
dummy variables, to obtain the total estimated percentage 
contributions per District per month. 
 
For the default District (POM) and in the default month (January) the 
estimated percentage contributions are equal to:  
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while in the other months: 
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For the other Districts (1, 2b, 3, 4, 6, 7, 10, 12, 13) in January: 
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and from February to December the estimate is equal to: 
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Each District’s share in 2006 monthly collections are used as weights: 

BLE 14. DISTRICT SHARES IN MONTHLY COLLECTIONS IN 2006 
 JAN P OCT NOV DEC 

 
TA
 FEB MAR APR MAY JUN JUL AUG SE

POM   0.05 0.06      0.07 0.08 0.13 0.07 0.08 0.07 0.07 0.12 0.11 0.08
1 0.11 0.01 0.02 0.08 0.13 0.09 0.32 0.07 0.13 0.02 0.02 0.01 
2B 0.07 0.06 0.09 0.08 0.09 0.08 0.09 0.10 0.08 0.09 0.09 0.07 
3 0.07 0.06 0.10 0.10 0.09 0.08 0.08 0.08 0.07 0.10 0.10 0.08 
4 0.05 0.06 0.09 0.07 0.11 0.09 0.09 0.11 0.05 0.10 0.07 0.10 
6 0.04 0.27 0.03 0.03 0.01 0.14 0.06 0.03 0.14 0.05 0.14 0.04 
7 0.06 0.10 0.10 0.11 0.06 0.06 0.09 0.12 0.09 0.07 0.06 0.07 
10 0.31 0.07 0.05 0.07 0.04 0.10 0.11 0.06 0.07 0.06 0.05 0.03 
12 0.05 0.10 0.08 0.13 0.09 0.11 0.10 0.13 0.07 0.05 0.04 0.05 
13 0.07 0.08 0.09 0.06 0.15 0.08 0.09 0.12 0.06 0.10 0.05 0.04 

 
Multiplying the sums by their weights per month for each District results 

e 
in weighted sums of the estimated percentage contributions of the 
exogenous variables. These are added up so that for a given port, th
annual growth estimate is  
 
∆Cp

Cp

=
∆Ct,p

Ct,p

Ct,p

Cp

⎛ 

⎝ 
⎜ ⎜ 

⎞ 

⎠ 
⎟ ⎟ 

t=1

12

∑ = ˆ φ p  
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TABLE 1 ANNUAL GROWTH ESTIMATE PER DISTRICT 
 AUG SEP OCT NOV DEC PORT 

 
5. 

JAN FEB MAR APR MAY JUN JUL 

pφö  

POM 0.19 0.17 0.17 0.27 0.51 0.21 0.27 0.25 0.29 0.51 0.50 0.44 3.78 
1 2.06 0.05 0.08 0.35 1.00 -0.04 1.49 0.21 0.56 0.12 0.11 -1.98 4.02 
2B 0.21 0.19 0.26 0.23 0.26 0.28 0.36 0.38 0.28 0.34 0.32 0.32 3.42 
3 0.20 0.17 0.33 0.34 0.30 0.28 0.33 0.29 0.25 0.34 0.35 0.26 3.43 
4 0.21 0.23 0.41 0.20 0.37 0.21 0.31 0.32 0.19 0.49 0.10 0.27 3.31 
6 0.06 4 1 78.72 -0.11 0.03 -0.09 9.87 0.26 7.82 0.35 0.18 1.66 0.03 8.76 
7 0.19 0.15 0.17 0.22 0.17 0.19 0.35 2.02 0.33 4.45 0.30 0.15 8.67 
10 1.55 0.24 -1.15 -0.01 0.12 0.41 0.42 0.20 0.36 0.25 0.20 0.04 2.63 
12 0.41 0.38 0.08 0.39 0.71 0.36 0.33 0.50 0.25 0.19 0.15 0.14 3.90 
13 0.23 0.00 0.25 0.17 0.37 0.17 0.22 0.28 0.12 0.41 0.14 0.06 2.43 

 

tep 4. This annual collection growth estimates, as may be adjusted by 

e, to 
 

 
ese are then converted to District shares 

ˆ C p
p = 1

15

∑

 
S
the Commissioner, are applied to BOC’s actual collection in the 
current year or where information on actual collection is availabl
obtain the absolute amounts per District.  The projected collection per
District is equal to 
 
ˆ C p = (1+ ˆ φ p )Cp  

Th
ˆ C pσ p =  

 
ABLE 16. DISTRICT SHARES IN PROJECTED COLLECTIONS  

 
 Shares in Projected 

T
DISTRICT φö 2006 Collection Projected

 
 

p (P million) Collection 

pCö  
Collection (%) 

pσ  

POM 3.78 68574 36.84 71166 
1 4.02 1174 1221 0.63 
2B 47857 4 23.42 9494 5.62 
3 3.43 15216 15738 8.15 
4 3.31 39889 41209 21.33 
6 78.76 259 463 0.24 
7 8.67 4787 5202 2.69 
10 2.63 2591 2659 1.37 
12 3.90 1716 1783 0.92 
13 2.43 4156 4257 2.20 
TOTAL for 10 193193 
PORTS 

   

 
 
Step 5. The District shares are applied to the BOC target for the 

istrict.  following year to obtain the absolute amounts of the target per D
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Our example, which is limited to10 Districts, shows the following 
distribution of the 2007 target.  
 
TABLE 17.  ALLOCATION OF 2007 TARGET BASED ON SHARES OF 10 DISTRICTS 

 Shares in Projected 
Collection (%) 

pσ  

DISTRIBUTION OF 2007 TARGET BASED 
ON DISTRICT SHARES OF 10 PORTS ONLY 

POM 36.84 84065 
1 0.63 1443 
2B 25.62 58464 
3 8.15 18591 
4 21.33 48678 
6 0.24 547 
7 2.69 6145 
10 1.37 3141 
12 0.92 2106 
13 2.20 5029 
TOTAL for 10 
PORTS 

 228208 

 
 
The Commissioner may increase the target collection efficiency 
growth of a District if in his/her judgment its collection performance 
needs to be improved.  The port dummy variable, which serves as a 
proxy for port infrastructure and efficiency, indicates relative port 
performance as well, and may be used as a guide for adjusting 
collection effort of each District. 
 
If the Commissioner decides to compel port j to perform better, the 
same equation is adjusted with a policy decision parameter ν per port. 
 

∆Ct,p

Ct,p

=ϕp + ˆ A p + ˆ α iMDi
i=1

11

∑ + ˆ δ jPDj
j=1

14

∑ + ˆ β 1
∆Entt,p
Entt,p

+ ˆ β 2
∆Valt,p
Valt,p

+ ˆ β 3
∆Exrt,p
Exrt,p

+ ˆ β 4
∆TCCt,p

TCCt,p

+ ˆ β 5
∆Deft,p
Deft,p

+ ˆ β 6
∆Nont,p
Nont,p

 

 

Framework for Individual Targets 
 
It is proposed that the target of the lowest grouping that an attritable 
individual directly belongs to shall serve as that individual’s target, so 
that all individuals in that group share a collective or pooled target. 
Thus if the group an attritable individual immediately reports to is a 
Section, Division, Sub-Port, or Unit, then the target of that Section, 
Division, Sub-Port, or Unit, shall serve as his/her target.  
 
This proposal follows a consideration of the alternative bases for 
individualized targets, including equal shares, weighted shares using 
position and function factors, regular-client (“suki”) system, or 
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supervisory discretion. The advantages and disadvantages of each, 
tabulated below, show that the collective target would be better as 
long as it is combined with individual performance evaluation that 
minimizes free-riding by poor performers.   
 

 INDIVIDUALIZED COLLECTIVE 
A 
D 
V 
A 
N 
T 
A 
G 
E 
S 

• Encourages competition to 
process as many entries as 
possible 

• Rewards high performers 
 

• Ease of administration 
• Does not require equal access to 

entries 
• Functions even if entries have 

dissimilar contents, multiple-
processors, multiple-HS   

• Functions despite frequent 
personnel movement 

• No need to attribute effort to 
each individual 

 
D 
I 
S 
A 
D 
V 
A 
N 
T 
A 
G 
E 
S 

• Makes the assignment of 
entries crucial 

• Assumes that entries have 
similar contents  

• Assumes single processor per 
entry  

• Makes attribution of effort 
crucial for entries processed 
by multiple individuals  

• Difficult to implement with 
multiple-HS entries 

• Difficult to implement with 
frequent movement of 
personnel 

• Carries a disincentive once an 
individual meets his target  

• Doesn’t distinguish between poor 
and high performers, and 
encourages free-riding and 
demoralizes high performers 

 

 
 
In a group that consists of individuals of different rank (as reflected in 
actual tasks rather than designation), although the collective target 
will apply to all, those that have a higher rank will have greater 
responsibility and therefore a corresponding greater weight in terms of 
rewards as well as attritability.  This will be reflected in their 
performance evaluation, which will consider mitigating factors and 
individual effort or efficiency separately. Thus an individual with a 
higher rank will be assigned more weight or points compared to one in 
a lower position. 
 
The collection target of an attritable individual who belongs to a 
group that does not have a collection target will be determined on 
the basis of the source of revenue comprising the individual’s 
responsibility. For instance, the target of an administrative officer who 
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takes charge of the sales of official forms will be based on the historical 
trend of such sales. 
 
Transferees or those in acting capacities shall be considered regular 
members of the Division they are assigned to and assume the 
collective target. 

 

Issues to be Addressed 
 
There are minimum conditions for the rational allocation of targets: 
information requirements must be met, and certain operational 
practices and the coverage of target assignments must be 
reexamined.  

Quality of Information  
 
At present the information required by the methodology is not 
available from the ACOS database or the Districts. (a) ACOS captures 
only the declared values of imports that the system assesses based on 
HS codes, rather than actual assessments at the District.  Some ports 
and time periods are also missing from the database. (b) There is no 
certainty whether all lodged entries get processed and encoded into 
ACOS. Changes in the entries are not reflected in the database, so 
that there is no way of knowing if an undervalued, misclassified, or 
misdeclared entry was ultimately assessed properly. (c) District data is 
too aggregated and does not include certain variables that affect 
collection performance.  
 
At the minimum, complete, accurate, and verifiable information must 
be a top BOC priority through diligent record-keeping by the Districts 
combined with random checks.  This must be complemented by 
information from independent sources, such as on economic or 
industrial activity at the local level and prices, which are particularly 
valuable for explaining or benchmarking port performance. The 
Revenue Collection Monitoring Group must take an active role in the 
generation, organization, and evaluation of District revenue 
information in order to ensure their integrity and quality. Assigning staff 
specialists to one port each to analyze the determinants of their 
collections and verify collection data would enable RCMG to track 
port performance more effectively. 
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Practices 
 
Frequent movement of personnel 
 
BOC particularly suffers from the frequent movement of personnel.  
Transferring is so rampant that any inventory listing of personnel per 
port easily becomes inaccurate within a month.  Transfers may be 
initiated by the employee, and are effected when both the originating 
and destination units pose no objection, following the rule that the 
number does not drop in the former by up to, nor increase in the latter 
by more than, 10% of plantilla positions.  Transferees usually bring their 
item along with them, although their tasks change when they move. 
 
Frontline operations attract the greatest number of transferees in 
contrast to back offices, which are usually severely undermanned. At 
the extreme, employees in administrative or support positions move to 
revenue-related units. This implies the incentive to be involved in the 
processing of import entries. District Collectors are concerned over 
their inability to exercise authority over such transferees despite being 
under their responsibility.  
 
Frequent personnel movement has implications on District, section, or 
individual targets. Assuming that the actual manpower complement in 
each unit reflects real workload requirements, movements must be 
controlled if not frozen once targets are set to ensure that all 
personnel, whether regular or acting, will contribute to the unit’s 
collection. Movements complicate the setting and monitoring of 
individualized targets, making pooled or collective targets easier to 
administer. 
 
“Suki” system 
 
Since import entries may be filed at any port, officials and employees 
cultivate long-term relationships with importers/brokers to ensure that 
collections are sustained. This “suki” system, also considered 
“marketing” or “trade facilitation”, works to the advantage of both 
sides since they become familiar with each other’s requirements. 
Entries are therefore not randomly assigned to assessors as they are 
lodged at the port but go to the importer’s regular assessor. In turn, the 
importer chooses his regular assessor each time he files an entry.  
 
This practice would cause difficulty in the case of individualized targets 
that require equal access of personnel to each import entry as it is 
filed. This again makes pooled or collective targets the more 
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advantageous method, especially since the contents of import entries 
vary widely in value, number or type of commodity, and so forth. 
 

Coverage of Target Allocation 
 
1. Districts or individuals with no revenue generating functions may 

have to be assigned independently estimated targets  
 

Currently, targets are given to divisions and individuals that only 
mainly deal with non-tax revenue, or have no assessment, audit, or 
collection functions.  
 
For instance, the Operating Division oversees Customs Bonded 
Warehouses (CBWs) that receive and store conditionally-free 
imports of raw materials used in the manufacture of export 
products. Bonds for warehoused goods are eventually cancelled 
upon full liquidation of the raw materials utilized in production, 
allowable withdrawals for local consumption of BOI-registered 
enterprises is a decision of the CBWs and not the Operating 
Division, and importations in excess of quotas or not in the list of raw 
materials are strictly disallowed. The Division’s regular revenue 
comes only from warehousing fees, forms, penalties and 
surcharges, and wastages. Tax revenue can only be realized if 
there is non-compliance or conversion of imports to consumption 
entries. Even then, importers usually opt for bonds adjustment rather 
than cash payments. Tax revenue is thus minimal and 
unpredictable. Assigning a share of the BOC revenue target to the 
Operating Division encourages the diversion of imports to domestic 
consumption.  
 
Warehousing targets would be better estimated on the basis of the 
determinants of its collections such as the exports of CBW users and 
the reasons for withdrawals of BOI-registered enterprises. For 
example some CBWs are used by industries that have been 
drastically affected by international developments such as the 
removal of export quotas on garments, or the relocation of 
manufacturers to lower-cost countries or to export processing 
zones. A more realistic determination of the Operating Division 
targets combined with effective monitoring would minimize 
leakages. 
 
Likewise, some administrative positions in which the key duty is to 
sell forms and issue official receipts are assigned targets.  In this 
case, it would be more appropriate to base the target on a 
forecast of collectibles from the sales of forms. 
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Other non-dutiable imports due to special laws such as the 
Agriculture and Fisheries Modernization Act (AFMA) and 
agreements such as the ASEAN Free Trade Agreement (AFTA), must 
also be determined independently. Similarly, tax credits, which are 
granted by agencies outside of the BOC, and deferred payments 
on government imports, must be estimated more explicitly rather 
than assuming historical growth alone. 

 
2. Units or individuals that are not allocated targets yet contribute to 

revenue, participate in import clearance procedures, or get 
credited for collections, may have to be reconsidered  

 
Support units such as the PEAG contribute to revenue but are not 
currently assigned any targets.  Offices that have no targets are 
credited with collections, e.g. duties on NFA imports are credited to 
the Office of the Commissioner, which does not have any 
collection target, and WAMU collections are not credited to the 
Operating Division.  
 
Certain personnel who participate in the clearance process are 
not assigned any collection targets, e.g. CIIS agents who inspect 
entry documents. 

 
3. Designations or positions have varying tasks or responsibilities 
 

The responsibilities accompanying some designations are not 
uniform and depend on the division they are assigned to, such as in 
the case of Customs Operations Officers. Some have revenue-
related functions while others do not have any.  Salary grades of 
similar positions may also differ.  Actual tasks or responsibilities rather 
than designation alone must be the basis for rank and thus of 
rewards and attritability.  

 

DBCC Assumptions and Adjustments  
 
The Department of Finance (DOF) estimates for the DBCC the BOC 
revenue target for the year in the middle of the preceding year, on 
the basis of assumptions about economic activity combined with 
historical collection data. Since changes are likely to occur with 
respect to these assumed parameters that are out of the control of the 
BOC, flexibility must be allowed.   
 
In fact the IRRs accompanying the Attrition law provide that attrition 
must first give due consideration to all relevant factors affecting the 
level of collection, including economic causes as determined by the 
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Revenue Performance Evaluation Board (RPEB).  While this recognizes 
the ex post implications of economic causes on attrition, their impact 
on target-setting has to be considered as well. 
 
To illustrate the impact on targets of deviations between the 
assumptions and realized parameters, the 2006 record is examined. 
The assumptions or programmed values used in 2006 are tabulated as 
follows, with their corresponding actual or realized values:  
 
TABLE 18. PROGRAMMED AND REALIZED VALUES OF DOF PARAMETERS  

PARAMETER 2006 
PROGRAM 

REALIZED Data 
Source 

Exchange rate (P/$) 56 51.3143 BSP 
Imports (FOB, $m) 52677 51470 NSO 
Imports (CIF, $m) 57945 53632  NSO 
   Non-oil imports (FOB, $m) 47485 43281 NSO 
   Non-oil imports (CIF, $m) 52234 45185 NSO 
   Crude oil imports ((FOB, $m) 5192 5143 NSO 
   Crude oil imports (CIF, $m) 5711 5323 NSO 
   Petroleum product imports (FOB $m)  2781 NSO 
   Petroleum product imports (CIF $m)  2878 NSO 
    
Share of nondutiable to non-oil imports 60% 60.9% BOC 
Average tariff on non-oil imports 4.9% 5.5% BOC 
Share of VAT-exempt non-oil imports 33% Same DOF 
Deferred payments (P million) 8382  3301  BOC 
Tax credits (P million) 3212  12287  BOC 
Excise taxes on non-oil imports (P million) 4880  5002  BOC 
Excise taxes on petroleum, alcohol, tobacco (P 
million) 

17185  10259  BOC 

Excise taxes on petroleum products (P million)  5755 BOC 
 
Realized values about imports come from the National Statistics Office 
(NSO), which consolidates these from import entries4 as they are filed 
at the BOC. At this time of year NSO import data are available only for 
the period January to November 2006, necessitating the extrapolation 
of the December figure from the average share of December imports 
in total annual imports for the years 2002 to 2005. To get the CIF 
equivalent, the average proportion of insurance and freight was 
added to the FOB value. This method was used to arrive at 2006 
estimates of total CIF imports, non-oil imports, and mineral fuel imports, 
which was in turn the basis for crude oil imports. 
 
The other realized values come from actual collection data of BOC for 
2006, except for the share of VAT-exempt non-oil imports, which was 
estimated by the Department of Finance in 1998. 
 

 
                                                 
4 The import entries are consolidated at the time they are lodged rather than liquidated, hence 
reflecting declared values rather than assessed values.  
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Using the programmed parameters, target revenue is estimated 
separately under new and existing measures by the DOF. New 
measures are either legislative or executive.  Under the former are the 
VAT-related reforms of RA 9337 which consisted of (a) an increase in 
the VAT rate from 10% to 12%,  (b) lifting of exemptions on coal, crude 
oil, and petroleum products, (c) reduction of excise tax on kerosene, 
diesel and fuel oil as a mitigating measure, (d) rationalization of excise 
taxes on motor vehicles and indexation of taxes on sin products 
cigarettes and fermented liquor.  Executive measures consist of 
administrative initiatives to: (a) improve assessment, (b) increase law 
enforcement, (c) strengthen internal audit, (d) check transshipment, 
(e) expand Super Green Lane, (f) collect from demandable assets, (g) 
expand computerization, and others. 
 
Using the realized values of the parameters, target duties, VAT, and 
excise taxes under both existing and new measures are reestimated 
together following the worksheet used by the DOF below.  The last 
column gives the details of the computation. 
 
TABLE 19. REESTIMATED DUTIES, VAT, AND EXCISE TAXES 

 Program (Jan 
2006) 

REESTIMATED TARGETS 

MACROECONOMIC ASSUMPTIONS    
GDP, Real 1270346   
GDP growth, Real 6.30% 5.5%  
Exchange Rate 56 51.3143  
Price of Oil (US$/barrel) 29.17 61.567  
Imports, FOB (US$m) 52677   
Import growth, US$ terms 11%   
Import growth, Peso terms 11%   
Tariff rate, Non-Oil Imports, Existing  4.92% 5.5%  
Tariff rate, Non-Oil Imports, New  4.92%   
    
A. IMPORT DUTIES    
Total Imports (FOB, $m) 52677 51470 add average 

Dec 2002-05 
share to actual 
Jan-Nov 2006 
imports 

Total Imports (CIF, $m) 57945 53631.74 add 4.2% to get 
CIF equivalent 

    
Collections from Non-Oil Imports     
Non-Oil Imports (FOB, $m) 47485 43281 add average 

Dec 2002-05 
share to actual 
Jan-Nov 2006 
imports 

Non-Oil Imports (CIF, $m) 52234 45185.364 add 4.4% to get 
CIF equivalent 

less: non-dutiable non-oil imports  31348 27517.8867 actual 60.9%  
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Assumed nondutiable/nonoil ratio 60% 60.90%  
Dutiable non-oil imports (CIF $m) 20886 17667.4773  
Assumed exchange rate 56 51.3143  
Dutiable non-oil imports (CIF Pm) 1169594 906594.232  
Assumed average tariff 4.90% 5.50% actual  
Import duties before TC/DF 57544 49862.6827  
less: assumed deferred payments (DF) 8382 3301 actual 
less: assumed tax credits (TC) 3212 12287 actual 
Estimated duties collectible from Non-Oil Imports 
(Pm) 

45950 34274.6827  

     
Collections from Crude Oil Imports     
Crude Oil Imports (FOB $m) 5192 5143 add average 

Dec 2002-05 
share (from 
Mineral Fuels) to 
actual Jan-Nov 
2006 imports 

Crude Oil Imports (CIF $m) 5711 5323.005 add 3.5% (from 
Mineral Fuels) to 
get CIF 
equivalent 

Assume 100% dutiable    
Assumed exchange rate 56 51.3143  
Dutiable crude oil imports (CIF Pm) 319827 273146.275  
Assumed tariff rate  3% 3%  
Estimated duties collectible from Crude Oil 
Imports (Pm) 

9595 8194.38826  

    
Collections from Petroleum Product Imports    
Petroleum Product Imports (FOB $m)  2781 added average 

Dec 2002-05 
share (from 
Mineral Fuels) to 
actual Jan-Nov 
2006 imports 

Petroleum Product Imports (CIF $m)  2878.335 add 3.5% (from 
Mineral Fuels) to 
get CIF 
equivalent 

Assume 100% dutiable    
Assumed exchange rate  51.3143  
Dutiable petroleum product imports (CIF Pm)  147699.746  
Assumed tariff rate   3%  
Estimated duties collectible from Petroleum 
Product Imports (Pm) 

 4430.99237  

    
B. VAT    
Non-Oil Imports (CIF, $m) 52234 43281 add average 

Dec 2002-05 
share to actual 
Jan-Nov 2006 
imports 

less: VAT-exempt Non-Oil Imports 17237 14282.73 Use programmed 
33% 
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Assumed VAT exempt ratio  0.3300   
Non-Oil imports subject to VAT 34996 28998.27  
Assumed ratio of dutiable/taxable Non-Oil 
Imports 

40% 40% Use programmed 
40% 

Estimated dutiable/taxable Non-Oil ($m) 13993 11599.308  
Assumed exchange rate 56 51.3143  
Estimated dutiable/taxable Non-Oil (Pm) 783628 595210.371  
plus: import duty (average tariff) 38554 32736.5704 actual 5.5% 
        excise taxes on Non-Oil 4880 5002 actual 
Tax base subject to VAT (Pm) 827063 632948.941  
VAT rate 10% 12%  
Estimated VAT collectible on Non-Oil Imports 
(Pm) 

82706 75953.8729  

     
VAT from Crude Oil     
Dutiable Crude Oil Imports (CIF Pm)  273146.275  
plus: import duties  8194.38826  
Tax base subject to VAT  281340.664  
VAT rate  12%  
Estimated VAT collectible from Crude Oil (Pm)  33760.8796  
    
VAT from Petroleum Products    
Dutiable Petroleum Product Imports (CIF Pm)  147699.746   
plus: import duty  4430.99237  
plus: excise tax  5755 actual 
Tax base subject to VAT  157885.738  
VAT rate  12%  
Estimated VAT collectible from Petroleum 
Product Imports (Pm) 

 18946.2886  

   
C. OTHER COLLECTIONS    
Excise taxes (petroleum, alcohol, tobacco) 17185 10259 actual; assumed 

to include motor 
vehicle, 
cigarettes, 
fermented liquor 

 
These reestimated revenue targets by type of tax are then compared 
with the programmed targets of DOF/DBCC for 2006, and actual BOC 
collections.  
 
TABLE 20. REESTIMATED REVENUE TARGET (P million) 

 Duties VAT Excise TOTAL 
Non-oil 34275 75954   
Crude oil 8194 33761   
Petroleum products 4431 18946   
TOTAL 46900 128661 10259 185820 
TEF (programmed)     5524 
TOTAL Cash    180296 
New measures: administrative    900 
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TABLE 21. PROGRAMMED REVENUE TARGET (P million) 
 Duties VAT Excise TOTAL 

Existing 55545 82706 17185 155436 
New 2720 36746 1077 40540 
TOTAL 58265 119452 18262 195976 
TEF    5524 
TOTAL Cash    190452 
 
 
TABLE 22. ACTUAL BOC COLLECTIONS (P million) 

 Duties VAT Excise TOTAL 
Non oil 57440    
Crude oil 7873    
Petroleum products 3078    
TOTAL 68391 118955 10760 198175*  
Bureau of Treasury (Cash)    187874 
    TEF (implied)    10301 
*adjusted 
 
The above figures imply that the excess of actual total collections 
(P198175 million) over originally programmed target collections 
(P195976 million) is equal to P2199 million. The excess of actual cash 
collections (P187874 million) over the reestimated target revenue less 
programmed TEF (P180296 million) is equal to P7578 million. Including 
collections from administrative measures in this yields P6678 million. 
 
Other possible adjustments to the targets that have been suggested 
by the District Collectors are as follows: 
 
a. When necessary, distribute the collection that is credited to the 

Office of the Commissioner to those Districts that processed the 
imports that yielded this collection, e.g. NFA imports  

b. Adjust targets on a monthly or quarterly basis to take parameter 
changes into account. Changes in both directions would have to 
be accepted.  

 

Organization for Target Allocation and 
Adjustments 
 
1. The Financial Service under the Revenue Collection Monitoring 

Group will assume the following responsibilities in connection with 
the allocation of targets and adjustments in the assumptions: 
a. Goal Allocation  

i. Organize Desk Staff to specialize in each major District who 
will (1) collect data from the District to be used in target 
allocation, (2) collect data including but not limited to 
economic or industrial activity at the local level and prices, 
from independent sources such as the NSO, DOF, Bangko 
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Sentral ng Pilipiinas, Department of Trade and Industry, 
Department of Agriculture, Department of Energy, other 
government agencies, private sector associations and 
academic libraries, (3) analyze the determinants of port 
collections, (4) conduct random checks to verify the 
accuracy of data particularly assessed values. 

ii. Assign staff to hold office in each major District in order to 
ensure completeness and accuracy of record-keeping and 
integrity and quality of data. 

iii. Undertake the statistical procedure(s) needed to implement 
goal allocation. 

iv. Prepare and submit to the Commissioner the annual target 
goal allocation of Districts and their respective Divisions, 
providing a copy to the PMS Owner. 

 
b. Ex Post Target Allocation 

i. Gather the relevant data on the realized values of the 
exogenous variables explaining actual collection. 

ii. Estimate the target collection of the Bureau based on the 
realized parameters following a replicable and transparent 
procedure. 

iii. Submit an analysis of the estimate’s implications on the 
Bureau’s collection performance in the preceding year. 

 
2. Each District shall exercise due diligence in record-keeping and 

provide complete monthly data on the variables enumerated 
below to the Financial Service not later than 1 October of the year. 
This shall consist of data at the Division level and include all Divisions 
under the District, providing a copy to the PMS Owner.  
• import values (declared and assessed) 
• commodity composition of imports  
• number of entries 
• exchange rate 
• imports selected Green, Yellow, Red 
• duty-exempt or nondutiable imports (under warehousing, 

AFMA, AFTA, etc) 
• tax credits and deferred payments 
• proportion containerized 
• number of personnel 
• budget 
• port infrastructure 

 
3. Each District Head shall allocate the District target to the attritable 

individuals under his/her jurisdiction following the guiding principles 
and methodology. The individual goal allocation shall be submitted 
to the Commissioner by 1 December of the year through the 
Financial Service. 
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4. The Financial Service shall be guided by the following indicative 
deadlines:  
a. Obtain the data from each District not later than 1 October and 

organize the information from all sources. 
b. Calculate the target allocation of each District and Division by 

31 October.  
c. Submit the resulting allocated targets to the Commissioner on 1 

November of the year.   
d. Disseminate the approved goal allocation to the District Heads 

on 7 November of the year. 
e. Collect from the District Heads the allocated targets of 

attritable individuals by 30 November. 
f. Consolidate the goal allocation lists and submit to the Office of 

the Commissioner by 1 December, providing a copy to the PMS 
Owner. 

5. The Commissioner shall issue a Customs Memorandum Order 
containing the District, Division and individual targets and forward it 
to the DBCC in the first week of December. 
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The allocation of targets among 
the Districts or their component 
units will make use of statistical 
procedures such as forecasting 
and regression to explain the 
systematic dependence of one 
variable upon others. This Annex 
describes the steps in preparing 
the data and performing these 
procedures. 
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Objectives 
This Manual describes the steps to be followed in processing the data 
needed for determining the collection targets of Districts and the 
component units under them.  It then explains the regression 
procedure using the Statistical Packages for the Social Sciences (SPSS), 
and enumerates the tools used to interpret the results of the regression.  

Output 
 Data processing procedures 

 

Acronyms 
ACOS Automated Customs Operations System 
AVT Ad Valorem Tax 
BOC Bureau of Customs 
BSP Bangko Sentral ng Pilipinas 
CUD Customs Duties 
EXC Excise Tax 
Forex Foreign Exchange 
HS Code Harmonized System Code 
MISTG Management Information Systems and Technology Group 
RCMG Revenue Collection and Monitoring Group  
SAS Statistical Analysis System 
SGD Safeguard Duties 
SPSS Statistical Packages for the Social Science 
TCC Tax Credit Certificate 
VAT Value Added Tax  
 

Summary 
 
The data processing method described in this Manual mainly utilizes 
Microsoft Excel.  Step by step procedures are discussed and sample 
screen shots are provided to enable the user to visualize the datasets 
that will be generated.  It is assumed here that the user is familiar with 
Windows-based software and has working knowledge of the features 
of Microsoft Excel. 
 
The Statistical Package for Social Science (SPSS) is also utilized for 
regression analysis.  The versions now available in the market are 
Windows-based and can be used with relative ease.  Like any 
Windows application, one only needs to click on the topic/command 
(usually located at the top of the screen) and the sub-topics become 
available in a drop-down menu.  Other statistical software (e.g. SAS, 
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Stata, Eviews) can be utilized as long as the needed regression outputs 
can be generated. 
 

Data Preparation  
 
To determine the allocation of the BOC target, several sources of data 
have been identified.  Monthly data from both the MISTG and the 
Districts are usually needed to complement one another. 

Sources of Data 
 

Management Information Systems and Technology Group 
(MISTG) is the principal unit responsible for maintaining the 
Automated Customs Operations System (ACOS) which captures 
the information on import entry declarations.  However it is the 
declared rather than actual assessed values of imports that are 
obtained. For this target allocation exercise, the MISTG furnished 
a semi-processed dataset composed of monthly imports 
aggregated at the 4-digit HS code at the port level for the years 
2002-2006.  The dataset was saved in Excel, with the following 
variables and data type/format: 

 
Variable Data type/format 

1. Port String  
2. Year Numeric 
3. Month Date 
4. HS Code String 
5. No. of entries Numeric 
6. Description String 
7. Volume Numeric 
8. Value Numeric 
9. Ad valorem tax (AVT) Numeric 
10. CSD Numeric 
11. Customs Duties (CuD) Numeric 
12. DOE Numeric 
13. DPD Numeric 
14. Excise Tax (EXC) Numeric 
15. Fines (Fin) Numeric 
16. Value added Tax (VAT) Numeric 
17. SGD (Safeguard duties) Numeric 
 

 
Statistics Division, which is under the Revenue Collection and 
Monitoring Group (RCMG), processes the daily collection 
reports submitted by each District.  These reports consist of cash 
and non-cash collections broken down into Tax Credit 
Certificate (TCC) and deferred payments, oil and non-oil, etc.  
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The following monthly data processed by the Statistics Division 
were used in this exercise. 
 

Variable Data type/format 
1. Cash Collection Numeric 
2. Tax Credit Certificates 

Collection 
Numeric 

3. Deferred Payment Collection Numeric 
4. Percent Share of Non-

Dutiable Value 
Numeric 

 
 
Districts. Aside from the data processed by the Statistics Division, 
other significant data that are available at the District level 
should be provided for use in the regression.  
 
BSP. While the MISTG maintains a database of foreign 
exchange rates that were applied on filed import entries, this 
was not included in the dataset provided.  Monthly average 
foreign exchange rates published by the Bangko Sentral ng 
Pilipinas (BSP) were used instead.   

 

Consolidation and processing of data 
 
The data processing stage is summarized in the succeeding 
process flowchart. It shows the steps to follow in processing the 
data provided by MISTG and the Districts. 
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The format of data furnished by the MISTG necessitates 
segregation and consolidation by port.   Hence, various files 
should be created in which to transfer the segregated port 
data.  The variable names in each of the files must, however, 
remain intact and in order on the first row of the worksheets 
(also called the header row).  
 
Segregation can be done easily using Excel.  The first step is to 
open the original MISTG data in Excel and perform the sort 
function.  Before doing this, the whole active sheet (columns 
and rows that contain the needed information) must be 
highlighted. After highlighting, click the Data tab and select 
Sort. The user will be prompted by the following screen: 
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Select 
Header Row 
since the 
variable 
names are 
incorporated 
in the file at 
the first row 

Select first the 
Port then 
Month (in 
ascending 
order) 

 
 
 
The user selects the sorting variable(s) to be used, the order of 
sorting (ascending or descending) and the option indicating 
whether a header row is present or not.  For this exercise, the 
primary sorting variable is Port and the secondary sorting 
variable is Month since the MISTG files were grouped annually. 
Click the OK button when the sorting variables have been 
selected.  The rows that contain similar port codes (e.g. PO1, 
PO2A, PO2B, etc.) have to be segregated and transferred 
manually to a separate file or worksheet by highlighting them 
and clicking Edit > Cut and Edit > Paste and saving them 
appropriately under unique filenames.  
 
After segregating the data into their respective Port file, the 
next step is to consolidate them into monthly totals.  For each 
port, the subtotals for the number of entries, volume, value, and 
the rest of the variables are computed. This can be done by 
clicking on Data > Subtotal and selecting Month as the subtotal 
changing variable.  The variables by which the subtotals will be 
applied should also be selected.  In the subtotal mini screen 
(shown below), the user has to select Sum (the function to be 
employed) and tick the variable names needed.   
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Select Month 
(variable that 
will prompt 
the totaling) 

Select Sum 
and check all 
the variables 
that will have 
sub-total. 

 
 
The user should note that the subtotals are in formulas and 
inserted exactly at the point when the month changed.  To 
expedite the capture of these monthly subtotals, the worksheet 
where the summarized subtotals is located should be selected.  
This can be done by clicking the 2nd summary worksheet that is 
located on the left side of the screen (as shown in the next 
figure). 
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As the subtotals are still physically attached to the active 
worksheet, they must be copied into a new worksheet (e.g. Port 
Main Matrix) where data will be consolidated.  To do this, the 
user must click on the Edit > Go to tabs. Successive small 
command screens will pop up and the user needs to click the 
Special button on the first then select the Visible cells option on 
the next small command screen.  The user will notice that the 
cells of the subtotals will automatically be highlighted when the 
OK button is clicked. 
 
To copy the subtotals, the user must click the Edit > Copy tabs 
then proceed to a new worksheet. Once in the new worksheet, 
the user has to paste the copied cells into it.  However, instead 
of the usual Paste command, the Paste Special should be used 
now.  The user must remember that the subtotals are in formulas 
and they have to be converted into numeric values.  To 
facilitate this, the user must choose  the Values option and tick 
the Skip blanks from the Paste Special screen.  The succeeding 
figure illustrates this process. 
 
 

 

Select Values to 
convert formula 
to numeric 
format 

 
 

 The resulting worksheet (shown below) will now be used 
District/Port’s template for the Port Main Matrix where
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variables will be incorporated.  The user has to manually input 
the year and months since Excel reformatted them when the 
subtotal process was done.  It is suggested that months be 
inputted in numeric format for easy manipulation later. 
 

 
 
 
 

Preparation of the Port Main Matrix  
 
The Port Main Matrix is the worksheet (in Excel format) th
contains all the given port’s consolidated data needed for t
regression.  This worksheet contains the monthly data that w
processed above and the data that the Statistics Division (TC
deferred payment, etc.) processed. 
 
Using the Excel file of monthly processed port data, Reven
can be computed.  A separate column has to be inserted in t
worksheet and labeled accordingly in the header row for t
purpose.  For this exercise, the revenue was calculated as: 
 
Revenue = ∑ (ad valorem tax, customs duties, excise tax, VAT
 
 
The formula has to be copied in all cells that are parallel to t
months.  After calculating Revenue, it is important to conv
the formula cells to values to make it compatible with the da
format of SPSS. 
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Only the essential variables from the processed port data that 
are needed for the exercise have to be retained in the 
worksheet.  These variables are revenue, number of entries, 
import volume and import value.  The rest of the variables are 
deleted. 

 
In addition to the above variables, the monthly foreign 
exchange data of BSP and the data processed by the Statistics 
Division (TCC, deferred payment and percent share of non-
dutiable) are included in the Port Main Matrix.  These variables 
are saved in separate files and must be configured so that the 
format (years and months) match with the processed port data 
above. Incorporating the additional variables can be 
accomplished with relative ease by just copying (from the 
source file) and pasting them to the Port Main Matrix worksheet.   

 

Similarly, the data required from the Districts, once provided, 
must be incorporated in the Port Main Matrix.   

 
The succeeding screen shows all the variables for the Port of 
Manila after they were incorporated in the Port Main Matrix. 
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Performing Regression  
 
 
Any statistical software capable of running a regression can be used in 
this exercise.   The values generated for R- squared, coefficients, T and 
F statistics are the outputs necessary for evaluation.  The following 
process flowchart illustrates the steps for performing the regression. 
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Retrieving the file containing the data to be processed 
 
SPSS is opened by clicking on the SPSS icon located at the SPSS for 
Windows program folder. Once the SPSS is in operation, the next 
step is to open or load the data (Port Main Matrix) to be processed.  
In this exercise, the data file was created with Excel.  To load this to 
SPSS, just click on theh File > Open > Data tabs.  The user will be 
prompted by the following screen: 
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Locate the 
Drive/Folder 
where the 
data file (Port 
Main Matrix) 
is located 

Select *.xls 

 
 
 

Remember to click on the File of type button and choose *.xls 
(since this is the file extension name of Excel files), then locate the 
folder or drive that contains the file to be processed (e.g. Port Main 
Matrix).  Click the Open button when the drive/folder has been 
located. 
 
The SPSS data editor screen is similar to an Excel screen where cells 
are arranged in columns and rows.  At the bottom left side, the 
Data View and Variable View folder tabs can be seen.  The Data 
View folder shows all the variables at the header row and the data 
across all rows.  On the other hand, the Variable View contains all 
the variables and their respective type or attributes.  Changes in 
the attributes of the variables (e.g. numeric to date, numeric to 
string, etc.) can be made in the Variable View mode. 
 
The user must note that one can perform the regression analysis 
even in the Data View or Variable View mode. 

 

Running the Regression  
 
After the attributes of the variables have been fixed, the user is now 
ready to perform the regression analysis.  To do this, the user must 
click on the Analyze tab and then select Regression > Linear.  The 
user will be prompted by the following screen: 
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Click the 
Independent 
variables here 

Click the 
Dependent 
variable here 

Select the 
Dependent 
and 
Independent 
variables here 

Select 
Backward 
Method 

 
 

The important thing remember in this process is to identify the 
dependent and independent variables properly.  For this exercise, 
the model specified Revenue as the dependent variable and 
exchange rate, TCC, deferred payment, number of entries, import 
volume, import values and non-dutiable values as independent 
variables.  As soon as the dependent and independent variables 
are listed, the user must click the OK button to run the regression 
analysis. 
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Note: 

Method selection allows you to specify how independent variables are 
entered into the analysis. Using different methods, you can construct a variety 
of regression models from the same set of variables.  

• Enter (Regression). A procedure for variable selection in which all 
variables in a block are entered in a single step.  

• Stepwise. At each step, the independent variable not in the equation 
which has the smallest probability of F is entered, if that probability is 
sufficiently small. Variables already in the regression equation are 
removed if their probability of F becomes sufficiently large. The method 
terminates when no more variables are eligible for inclusion or removal.  

• Remove. A procedure for variable selection in which all variables in a 
block are removed in a single step.  

• Backward Elimination. A variable selection procedure in which all 
variables are entered into the equation and then sequentially 
removed. The variable with the smallest partial correlation with the 
dependent variable is considered first for removal. If it meets the 
criterion for elimination, it is removed. After the first variable is removed, 
the variable remaining in the equation with the smallest partial 
correlation is considered next. The procedure stops when there are no 
variables in the equation that satisfy the removal criteria.  

• Forward Selection. A stepwise variable selection procedure in which 
variables are sequentially entered into the model. The first variable 
considered for entry into the equation is the one with the largest 
positive or negative correlation with the dependent variable. This 
variable is entered into the equation only if it satisfies the criterion for 
entry. If the first variable is entered, the independent variable not in the 
equation that has the largest partial correlation is considered next. The 
procedure stops when there are no variables that meet the entry 
criterion. 

Interpreting the Regression Results 
 
SPSS produces several outputs in every regression run.  The first output 
enumerates the variables entered/removed in the model.  In the case 
of the regression run for POM, three (3) models were tested when the 
Revenue was regressed against the independent variables.  As shown 
in the figure below, Model 1 is where all the listed independent 
variables were used to explain the behavior of POM Revenue.  For 
Models 2 and 3, the proportion of non-dutiable imports and the TCC 
were removed respectively. 
 
 

  

Bureau of Customs - EMERGE 2-47 
 



Goal Allocation Methodology 

 

The 
Backward 
option 
produced 3 
models for 
POM 

 
 

 

Notes for Output 1:   

Model - SPSS allows you to specify multiple models in a single regression 
command.  This tells you the number of the model being reported. 

Variables Entered - SPSS allows you to enter variables into a regression in 
blocks, and it allows stepwise regression.  Hence, you need to know which 
variables were entered into the current regression.  If you did not block your 
independent variables or use stepwise regression, this column should list all of 
the independent variables that you specified. 

Variables Removed - This column listed the variables that were removed from 
the current regression.  Usually, this column will be empty unless you did a 
stepwise regression. 

Method - This column tells you the method that SPSS used to run the 
regression.  "Enter" means that each independent variable was entered in 
usual fashion.  If you did a stepwise regression, the entry in this column would 
tell you that. 
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The next output produced by SPSS is the Model Summary where the R 
statistics including the standard error of the estimates are listed.  In the 
case of POM, the R-square of the 3 models ranges from 0.723 to 0.733.  
This means that about 72% to 73% of the deviation of the POM revenue 
can be explained by the independent variables.  As a general rule, 
the closer the value of R-square to 1, the better the model is. 
 
 
 

 

R squared 
values of the 
models are 
listed 

Anova Table 

 
 
 
The 3rd output produced by SPSS is the Analysis of Variance (ANOVA) 
table where the sum of squares, degrees of freedom and F values are 
listed. The p-value or Sig. is usually compared to the alpha level 
(typically 0.05) and, if lower than the latter, one can conclude that the 
independent variables reliably predict the dependent variable.  One 
can say that the group of variables number of  entries, volume, value, 
TCC, deferred payments, Forex, etc., can be used to predict Revenue. 
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Notes for Output2:   

Model - SPSS allows you to specify multiple models in a single regression 
command.  This tells you the number of the model being reported. 

R - R is the square root of R-Squared and is the correlation between the observed 
and predicted values of dependent variable.  

R-Square - R-Square is the proportion of variance in the dependent variable 
(science) which can be predicted from the independent variables.  Note that this 
is an overall measure of the strength of association, and does not reflect the 
extent to which any particular independent variable is associated with the 
dependent variable.  R-Square is also called the coefficient of determination. 

Adjusted R-square - As predictors are added to the model, each predictor will 
explain some of the variance in the dependent variable simply due to chance.  
One could continue to add predictors to the model which would continue to 
improve the ability of the predictors to explain the dependent variable, although 
some of this increase in R-square would be simply due to chance variation in that 
particular sample.  The adjusted R-square attempts to yield a more honest value 
to estimate the R-squared for the population.   Adjusted R-squared is computed 
using the formula 1 - ((1 - Rsq)(N - 1 )/ (N - k - 1)).  From this formula, you can see 
that when the number of observations is small and the number of predictors is 
large, there will be a much greater difference between R-square and adjusted R-
square (because the ratio of (N - 1) / (N - k - 1) will be much less than 1).  By 
contrast, when the number of observations is very large compared to the number 
of predictors, the value of R-square and adjusted R-square will be much closer 
because the ratio of (N - 1)/(N - k - 1) will approach 1.  

Std. Error of the Estimate - The standard error of the estimate, also called the root 
mean square error, is the standard deviation of the error term, and is the square 
root of the Mean Square Residual (or Error). 
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Notes for Output3 (Anova Table): 

 Model - SPSS allows you to specify multiple models in a single regression command.  
This tells you the number of the model being reported. 

Sum of Squares - These are the Sum of Squares associated with the three sources of 
variance, Total, Model and Residual. These can be computed in many ways.  
Conceptually, these formulas can be expressed as: 
    SSTotal     The total variability around the mean.  S(Y - Ybar)2.    
    SSResidual  The sum of squared errors in prediction.  S(Y - Ypredicted)2.  
    SSRegression     The improvement in prediction by using the predicted value of Y over 
just using the mean of Y. Hence, this would be the squared differences between the 
predicted value of Y and the mean of Y, S(Ypredicted - Ybar)2.  

df - These are the degrees of freedom associated with the sources of variance.  The 
total variance has N-1 degrees of freedom.   The model degrees of freedom 
corresponds to the number of predictors minus 1 (K-1).   

Mean Square - These are the Mean Squares, the Sum of Squares divided by their 
respective DF.  These are computed so you can compute the F ratio, dividing the Mean 
Square Regression by the Mean Square Residual to test the significance of the 
predictors in the model.  

F and Sig. - The F-value is the Mean Square Regression divided by the Mean Square 
Residual.  These values are used to answer the question "Do the independent variables 
reliably predict the dependent variable?".  The p-value is compared to alpha level 
(typically 0.05) and, if smaller, you can concludethat the independent variables reliably 
predict the dependent variable.   If the p-value were greater than 0.05, you would say 
that the group of independent variables does not show a statistically significant 
relationship with the dependent variable, or that the group of independent variables 
does not reliably predict the dependent variable.  Note that this is an overall 
significance test assessing whether the group of independent variables when used 
together reliably predict the dependent variable, and does not address the ability of 
any of the particular independent variables to predict the dependent variable.  The 
ability of each individual independent variable to predict the dependent variable is 
addressed in the table below where each of the individual variables are listed. 

 
 
The 4th and significant output produced by SPSS is the Matrix of 
Coefficients.  These are the estimates that tell you about the 
relationship between the independent variables and the dependent 
variable.  They indicate the amount of increase or decrease in 
Revenue that would be predicted by a 1-unit increase in the predictor. 
In the following example for Model 1, for a unit increase in the value of 
imports, one can expect the Revenue of POM to increase by 0.107 
units.  
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Challenges  

 
An effective goal allocation model can be implemented only if data is 
of good quality and complete.  The preceding exercise was done with 
a very limited set of data. Further improvements can be made once 
the Districts collect and provide the required data.    
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Rewarding performance 

 
 

This chapter describes a rewards 
framework that is based on 
performance and recognizes the 
variations in accountabilities of 
the offices and employees in the 
BOC. 
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The Rewards Framework 

Objectives 
 
This chapter outlines a framework for the distribution of rewards across 
employees and offices of the Bureau of Customs, assuming some 
reward amount has been allocated to the Bureau or its performing 
districts, according to the provisions of the Attrition Act of 2005 (AA).  
An information system implementing the framework is also described. 

Outputs 
 
 Rewards Framework 
 Sample Simulations 
 Rewards System (PMIS: Rewards) 

 

Acronyms 
BOC Bureau of Customs 
PMIS Performance Management Information System 

(Note: only rewards management is implemented for this project) 
AA Attrition Act of 2005 
OPMS Office Performance Management System 
PES Performance Evaluation System 
 

Definitions 
Office Pertains to a section, district, division, service, or group in the 

BOC that is subject to office evaluations. 
Employee A salaried individual assigned to an office in the BOC. 
Employee Rating A number between 2 and 10 assigned to an employee in the 

BOC for a given year.  Ratings are based on the performance 
of that office or employee; the system currently in use is the 
standard Performance Evaluation System (PES). 

Office Rating A number between 1 and 5 assigned to an office in the BOC 
for a given year.  Ratings are based on the performance of 
that office or employee and are obtained through an Office 
Performance Management System (OPMS), initially based on 
collection performance only. 

Employee Reward The reward amount assigned to an employee for a given year  
Office Reward The reward amount assigned to an office for a given year 
ixed Reward Share The component of employee rewards that is not dependent on 

performance 
Merit Reward Share The component of employee rewards that is dependent on the 

employee’s performance 
Weight In the case of rewards distribution for employees, this is a 

number associated to an employee that indicates that 
employee’s relative share of the total reward.  This applies to 
the merit reward share only.  Weights also indicate the relative 
share of an office in the case of distribution of rewards to 
offices. 

Factor A number used in the computation of weights.  Several factors 
are multiplied to determine weight.  There are factors for 
different categories such as function, position, attritability, 
employee rating, office rating, office size and goal size. 
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Guiding principles and methodology 
 
The following were the guiding principles used in the formulation of this 
rewards framework: 

 
1. Performance-based rewards.  Employee rewards should be 

dependent on performance at the individual level and at the 
office level to encourage both individual excellence and 
teamwork.  Office rewards should be primarily based on the 
performance of an office. 

2. Levels of accountability. Employees in the BOC have varying 
levels of accountability with respect to the collection 
performance of the offices they report to.  Accountability 
indicators include the employee’s function, position, and 
whether or not that employee is attritable. These indicators, 
together with performance indicators, shall be used as bases for 
differentiation of employee rewards.  

3. Variations in Office Size and Goal Size.  Offices in the BOC have 
significant variations in terms of number of employees in an 
office as well as the collection goal size (or difficulty) assigned 
to that office.  These variations should also be incorporated in 
the rewards framework. 

4. Internal equity. Employees with the same circumstances 
(position, function, attritability, individual performance, and 
office-level indicators) should have the same rewards across 
offices. 

 

The rewards framework presented in this chapter was a result of an 
iterative process.  Simulations were carried out for each version of the 
framework, and then presented to BOC officials for their feedback, 
from which a revision of the framework and/or necessary parameters 
was made.  The latest version of the framework and its parameters are 
presented in this document. 
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Rewards framework 
 
The rewards framework details a system of distribution using the 
following inputs: 

 
 Collection targets and performance data at the BOC and 

district level 

 Percentage allocations for the different components of the 
reward (i.e., employee rewards versus office rewards, fixed 
rewards versus merit rewards) 

 Office data describing relative differences (i.e., number of 
employees and collection goal) between the offices 

 Employee data describing each employee’s accountabilities 
(salary grade/position/designation, function, attritability) 

 Performance ratings for offices and employees 

 
The outputs of the system are: 

 
 Reward for each office 

 Reward for each employee 

 
Section 4 of the AA provides for rewards at both the employee and 
office levels, assuming the BOC exceeds its collection target.  Section 
5 of the AA provides for rewards assuming a particular collection 
district exceeds its target (in the event that the BOC does not exceed 
its target); in this case, only office rewards apply (District Incentives).  
The framework described here can be used to distribute employee 
rewards and office rewards under either Section. 

 

In case Section 4 of the AA applies, a fraction of the BOC excess, 
known as the Rewards and Incentive Fund, will be set aside for 
rewards.  A portion of this Fund (at least 25%) will be for employee 
rewards and the remaining portion will be for office rewards.  
Furthermore, a small portion of employee rewards may be distributed 
evenly across all employees in the Bureau and the rest of the amount 
is distributed based on performance and accountability.   Several 
parameters are therefore required as a prerequisite to this framework: 
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EMPPCT: Percentage for employee rewards 

OFCPCT: Percentage for office rewards 

(Should equal 100% - EMPPCT) 

FIXEDPCT: Percentage of employee rewards set aside 
  for fixed rewards 

MERITPCT: Percentage of employee rewards set aside 

  For merit rewards (should equal 100% - FIXEDPCT) 

 

Suppose REWFUND is the resulting rewards fund for a given year when 
Section 4 of the AA applies.  The following amounts are derived 
accordingly: 

 

EMPFUND = REWFUND * EMPPCT 

  (Amount allocated for employee rewards) 

 
OFCFUND = REWFUND * OFCPCT 

  (Amount allocated for office rewards) 

 
FIXEDEMP = EMPFUND * FIXEDPCT 

  (Amount allocated for fixed employee rewards) 

 

MERITEMP = EMPFUND * MERITPCT 

(Amount allocated for merit-based employee rewards) 
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Employee rewards 
 
The reward amount for a given employee will have two components, 
a fixed reward and a merit reward: 

 

Reward for an Employee = Fixed Reward (FR) + Merit Reward (MR) 

 
Fixed reward 
 

The fixed reward is determined by dividing the total fixed reward 
amount evenly among all employees in the Bureau.  Suppose N is the 
number of employees in the Bureau; the fixed reward per employee is 
computed as follows: 
 
FR (Fixed Reward) = FIXEDEMP / N 
 
It is also possible to restrict fixed rewards to particular employees in the 
Bureau, if top management deems it appropriate to do so.  For 
instance, a cutoff for employee performance and/or the performance 
of the office that the employee belongs to may be imposed, so that 
only those employees meeting the cutoff are eligible for fixed rewards.  
In this case, the value N will be less than the total number of 
employees in the BOC. 

 

Merit reward 

Employee merit rewards are computed using the following method. 
Weights are first assigned to each employee in the Bureau.  The 
weights represent the relative merit rewards share of the given 
employee. These weights are obtained by multiplying several factors 
associated to an employee.  Factors may vary from year to year.  
Based on a workshop conducted with the BOC in September 2006, 
and after succeeding consultations with BOC officials, the following 
factors have emerged: 

- position factor (PF) 

- function factor (FF) 

- attritability factor (AF) 

- employee rating factor (RF) 

- office rating factor (OF) 
 - goal size factor (GF) 
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Each employee will have a position factor (PF), a function factor (FF), 
an attritability factor (AF), and an employee rating factor (RF).  The 
office that an employee is under will also have an office rating factor 
(OF) and a goal size factor (GF).  The values for these factors will 
depend on employee circumstances and will come from 
predetermined tables presented in a separate section.  It is possible 
that one of these factors is 0, implying no merit reward for the given 
employee. 

 

Suppose: 

Wi = weight assigned to employee i, computed as  

PF * FF * AF * RF * OF * GF 

S = sum of all Wi’s 

Then: 

MRi (Merit Reward for employee i ) = MERITEMP * Wi / S. 

 

The total reward for an employee is simply the sum of the computed 
fixed and merit reward amounts. 

 

TRi (Total Reward for employee i ) = FR + MRi
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Office rewards 
 
A similar process applies to rewards distribution at the office level, 
although rewards in this case will not have a fixed component.  Three 
factors apply at the office level:  office rating factor (OF), goal size 
factor (GF) representing the difficulty level of the collection goal of an 
office, and a size factor (SF) representing the number of employees in 
that office.   

- office rating factor (OF) 

- goal size factor (GF) 

- office size factor (SF) 

The proposed factor values are presented in a separate section. 

 

Suppose: 

Wi = weight assigned to office i, computed as OF * GF * SF 

S = sum of all Wi’s 

Then: 

ORi (Reward for office i) = OFCFUND * Wi / S. 

 

District rewards 
 
In case Section 5 of the AA applies (the BOC does not meet its target), 
then only districts that exceed their collection targets will be entitled to 
rewards and only office rewards will apply.  Rewards will be 
determined using a method similar to the one described in the 
previous section.  The same formulas apply, although computations will 
be made per district.  The term OFCFUND will be replaced by 
DISTFUND, representing the District Incentive allocated for offices in a 
performing district: 

 

Suppose: 

Wi = weight assigned to office i, computed as OF * SF * GF 

S = sum of all Wi’s for an office given (performing) district 

Then: 
 

DRi (Reward for office i) = DISTFUND * Wi / S. 
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Factor tables 
 
In this section, factor tables are presented for the different factor 
categories.  The factor values found in these tables will be used in the 
computation of weights as discussed in the previous section.  The 
factor tables are a result of several consultations with BOC officials.  
Note, however, that these tables are provided for demonstration only 
and are still subject to formal approval from top management.  

Employee Factors 
 
Employees will be categorized according to their position, function, 
and atritability.  This means that each employee will fall under a 
particular position category, function category, and attritability 
category, based on policies approved by top management.  These 
categories, in turn, determine the factors to be used during rewards 
distribution. 

 

Function categories capture the actual function carried out by an 
employee.  Initially, categories such as “Assessment”, “Audit”, 
“Enforcement”, “Legal” and “Operations” were included to distinguish 
between these different roles.  These were later simplified to three 
categories: 

Function 
Category 

Factor 
(FF) 

Top Management     10 

Line 9 

Support 8 

 

 

 

 

 

 

Note that the factor values indicated in the above table implies that 
Support personnel get 20% less than Top Management personnel, all 
other things being equal.  “Line” personnel are non-support personnel 
in collection districts, and personnel under this category get 10% less 
than Top Management personnel. 

 

Position categories capture the rank and designation of a given 
employee.  Although plantilla item data serve as a reasonable starting 
point when determining position categories, it should be emphasized 
that the categories should capture actual assignments of personnel.  
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Categorizations will be based on the “effective” salary grade of the 
employee, according top the assignment he/she currently occupies. 

 

Position Category Factor 
( PF) 

SG 30 15 
SG 29 14 
SG 28 13 
SG 27 12 
SG 26 11 
SG 25 10 
SG 24 9 

SG 21-23 8 
SG 19-20 7 
SG 16-18 6 
SG 11-15 5 
SG 7-10 4 
SG 4-6 3 
SG 1-3 2 

 

It is reasonable to assume that attritable personnel should get more 
rewards than those who are not attritable, all other employee 
characteristics being equal.  The following table captures this 
distinction. 

 
Attritability 
Category 

Factor 
  (AF) 

Attritable     12 

Not Attritable 5 

 

 

 

 

 

Performance rating factors enable a rewards system that is 
performance based.  The current employee performance rating 
system is the Performance Evaluation System or PES. The table below 
illustrates PES ratings and factors that corresponding to each 
employee rating. 
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Employee 
Rating 

Factor 
( PF) 

2 0.5 

3 0.5 

4 0.5 

5 5 

6 5 

7 6 

8 6 

9 8 

10 8 

Office factors 
 
Employee weights also include indicators at the office level, 
particularly office performance and goal size.  Performance ratings at 
the office level and their corresponding factors are given in the 
following table. 

 

Office 
Rating 

Factor 
( PF) 

1 0 

2 1 

3 6 

4 9 

5 10 

 

Office ratings should be generated from an Office Performance 
Management System (OPMS).  In the absence of a full-blown OPMS, 
ratings can be dependent on collection performance alone, for 
instance: 
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Collection Performance 
(actual over target) 

Office 
Rating 

Below 92.5% 1 

92.5% to 99% 2 

99% to 100% 3 

100% to 107.5% 4 

Above 107.5% 5 

 

Goal size categories and factors represent the level of difficulty 
associated with an office in terms of meeting their collection goal.  This 
may be based purely on the collection target amount although other 
indicators may be used.  The following table shows categories and 
their corresponding factors. 

 

Goal Size 
Category 

Factor 
( GF) 

1 6 

2 8 

3 10 

4 11 

5 13 

6 15 

 

Determination of goal categories can be based on the following: 

 

Collection Target Goal Category 

Below 0.8B 1 

0.8B to 3B 2 

3B to 10B 3 

10B to 30B 4 

30B to 50B 5 

Over 50B 6  

 

Bureau of Customs - EMERGE 3-12 
 



The Rewards Framework 

 

The Office Rating and Goal Size factor tables are used in the 
determination of employee rewards.  The same tables are used for 
office rewards.  In addition, for office rewards, Office Size Factor is 
included.  Here, the actual number of employees in the office will be 
used as the corresponding factor. 
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Challenges 
 
Several challenges were encountered in the formulation of this 
framework, among them: 
 
1. Reliability of the PES.   The PES has been perceived to be an 

unreliable measure for individual performance, particularly since 
most if not all of the employees get ratings of 8 or higher.  As such, 
the PES ratings do not really discriminate high performers from low 
performers. 
 

2. Plantilla positions versus actual assignments.  Many employees in 
the Bureau have actual assignments different from their plantilla 
positions.  This means that they occupy positions and functions that 
may be inconsistent with their formal positions and functions. 
 

3. Effect of employee transfers and promotions.  There are cases 
where employees transfer mid-year, which brings into question the 
office they belong to when it comes to computing their rewards.  
Promotions also occur mid-year; what is the salary grade/position 
of the employee (for rewards purposes) in this case? 
 

4. Rewards for employees of non-performing offices.  Should 
employees under a non-performing office receive rewards? 
 

5. Readiness and availability of the required data.  Are the employee 
and office data needed to determine factors (and consequently, 
rewards) readily available? 

 
6. Process of finalizing factor tables.  How are the factor values and 

tables finalized?  Which office proposes these values?  Which office 
approves them? 
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Recommendations 
 
1. Regarding the reliability of the PES, it is recommended that the PES 

be used nonetheless, although factor differences need not be 
significant.  In the future, an alternate system for individual 
performance ratings can be formulated to arrive at a more reliable 
indicator that discriminates performance; factor values may then 
be revised accordingly. 
 

2. Actual positions and functions, not plantilla assignments, should be 
used for rewards purposes.  An “effective salary grade” could be 
established for each employee, reflecting their actual position.  The 
corresponding function category of an employee should also be 
based on the employee’s actual assignment. 

 
3. In the case of a mid-year promotion, the latest position will apply 

when determining rewards; however, the actual position held takes 
precedence whenever there is a discrepancy.  In the case of 
transfers, office factors can be prorated according to the length of 
stay in a particular office. 

 
4. If it is the policy that every employee in a non-performing district 

should have zero reward, even if the Bureau exceeds its target, 
then the office factor associated to a low rating should be set to 
zero.  Fixed rewards may or may not be given to such employees 
by establishing an appropriate cutoff. 

 
5. The Human Resource Management Division (HRMD) shall be 

responsible for ensuring that the data needed for rewards 
distribution are available.  This includes establishing categories for 
each of the factors for each employee in the BOC, consistent with 
approved policies. 

 
6. It is recommended that the HRMD propose the factor categories 

and values as well as other parameters, to be approved by the 
Commissioner and the Revenue Performance Evaluation Board 
(RPEB).  
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Simulations 
 
The following is a simulation of employee and office rewards assuming 
the Bureau exceeds by PhP 2B, and Section 4 of the AA applies. 
 
The following parameters will be used in this simulation: 
 
EMPPCT: 25% 
OFCPCT: 75% 
FIXEDPCT: 10% 
MERITPCT: 90% 

The above parameters yield the following amounts: 

 

BOC EXCESS   2,200,000,000
BOC REWARD   330,000,000.00
OFFICES   82,500,000.00
EMPLOYEES   247,500,000.00
 - fixed  10% 24,750,000.00
 - merit  90% 222,750,000.00

 
The following are sample port collection target and performance 
data, with their associated performance ratings and goal size 
categories: 
 

PORT TARGET ACTUAL PERCENT RATING
GOAL SIZE 
CATEGORY 

BOC 195,976.11 198,175.00 101.12% 4 3 
SAN FERNANDO 957.51 893.13 93.28% 2 2 
POM 67,140.34 65,998.18 98.30% 2 6 
MICP 59,124.25 46,603.38 78.82% 1 6 
NAIA 17,476.17 15,208.71 87.03% 1 4 
BATANGAS 30,847.49 40,865.76 132.48% 5 5 
LEGASPI 17.18 17.10 99.53% 3 1 
ILOILO 146.69 306.05 208.64% 5 1 
CEBU 5,202.47 4,012.03 77.12% 1 3 
TACLOBAN 350.51 454.80 129.75% 5 1 
SURIGAO 80.04 43.93 54.89% 1 1 
CAGAYAN DE 
ORO 3,111.02 1,865.67 59.97% 1 3 
ZAMBOANGA 51.81 55.87 107.84% 5 1 
DAVAO 1,560.49 1,355.85 86.89% 1 2 
SUBIC 3,802.39 3,350.54 88.12% 1 3 
CLARK 583.75 585.11 100.23% 4 1 
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From the preceding inputs, the following reward amounts result.  
Employee and Office rewards are shown.  Note that there are over 
4000 employees in the Bureau, but only a selected set of employees 
are presented in the simulation for demonstration purposes. 
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Appendix 1: 

Performance Management Information System 
(PMIS) Rewards User’s Manual 
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Appendix 1:  PMIS-Rewards User’s Manual 
 
 
DESCRIPTION 
 
The PMIS Rewards System is a stand-alone database system designed to support 
and enable the rewards distribution. This section presents the different 
components of the Rewards System. 
 
 
REWARDS SYSTEM FUNCTIONS AND FEATURES 
 
The Rewards System supports computation of rewards distribution to offices and 
individuals. Obtaining the office and individual rewards involves 3 key activities: 
(1) setting up factors, (2) uploading office and employee performance data, 
and (3) computing rewards.  
 
 
Logging In 
 
To log in to the BOC Rewards System, open Internet Explorer and type the 
following on the address bar: 
 

 
 
When the Rewards System startup page appears, enter User ID and Password to 
log in. 
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Upon entering a valid User ID – Password combination, the following screen is 
presented showing the Rewards System start page. 
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SYSTEM ADMINISTRATION 
 
 
Installation 
 
Installation of the Rewards System involves setting up the web server. This requires 
installation of the following system software components: 
 
• Web Server (Apache) 
• Database Server (MySQL) 
• Scripting Language (PHP) 
 
Once these components have been installed, the files containing the Rewards 
System can be copied onto the PC. 
 
Please see Installation of Rewards System in installation CD for more details. 
 
 
User Management 
 
To maintain security and integrity of data, users will be authenticated and 
authorized before they are allowed to use the system. Each user will be provided 
a login name and password. The system has been developed to grant or limit 
access to users based on the roles assigned to the users. 
 
User management involves adding and removing users from the system. 

 
1. To add a new user, click User Management > Add New User. 
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2. To edit or disable a user, click User Management > Modify User 
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System Maintenance: Managing Evaluation Periods 
 
The period management facility enables storage, management and 
maintenance of multiple evaluation periods simultaneously. It allows creation, 
activation and closing of evaluation periods. 
 
1. To navigate through the available evaluation periods, click System 

Management > Period Management. 
 

a. Choose the evaluation period from the dropdown list. 
b. Once a period has been selected, click the Activate button to view the 

period. 
 

 
 
 

2. To create a new period, click System Management > Period Management. 
 

a. Activate latest period available in the database. 
b. Click Create New Period. 

 
Notes: 
• A new period can only be created if the current period is the latest 

period available in the database. 
• The system limits the total number of open periods to a maximum of 

2periods. 
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3. To close a period, click System Management > Period Management. 
 

a. Click Close Current Period. 
 
 
System Maintenance: Backing Up and Restoring Data 
 
The system’s backup and restore feature allows users to backup evaluation 
periods along with the data therein whenever needed. It also provides a restore 
facility from which users may select backups that have been made on specific 
dates as restore points. 
 
1. To backup system data, click System Management > Backup 
 

The backup database section allows users to backup open databases either 
individually or by batch  

 
a. To backup a specific evaluation period, select the period database 

instance, and click the corresponding button. 
b. To backup all open databases, click Backup all open databases. 

 

 
 
 

2. To restore data that has been backed up, click System Management > 
Backup. 

 
The restore database section lists down all the evaluation periods that have 
been backed up along with the specific backups/restore points for each 

Bureau of Customs - EMERGE 3-25 
 



Performance Management Information System-Rewards  
 

evaluation periods. The restore points for each period are identified by the 
date the backup was made. 

 
a. Select the restore point desired.  
b. Click the Restore button corresponding to the desired restore point. 
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Setup Factors 
 
The Setup Factors page of the Rewards System allows users to encode, view, 
modify and remove employee and office factors. 
  
1. To create a new factor, click Setup > Factors. 
 

 
 

In the Add New Factor Section: 
 

a. Encode the new Factor Name 
b. Indicate if the rating values of the factor are fixed or ranged 
c. Indicate if the factor is persistent for all evaluation periods 
d. Specify if the factor is an Employee Factor or an Office Factor 
e. Click Add Factor 
 

2. To edit a factor’s name, click Setup > Factors. 
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In the Setup Factor Section: 
 

a. Display Employee / Office Factors by selecting the corresponding label 
b. Once the set of Employee / Office Factors appear in the list box, click 

the Edit button corresponding to the factor name to be modified 
 
3. To delete a factor, click Setup > Factors. 
 

In the Setup Factor Section: 
 

a. Display Employee / Office Factors by selecting the corresponding label 
b. Once the set of Employee / Office Factors appear in the list box, click 

the Delete button corresponding to the factor to be erased 
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Setup Factor Categories and Factor Values 
 
The Setup Factor Categories and Factor Values page allows users to specify the 
categories and values for existing office and employee factors. 
 
 
Setting Office Factor Categories and Factor Values 
 
1. To add office factor categories and values, click Setup > Categories and 

Factor Values > Office Factors. 
 

 
 

a. Select the Office Factor from the dropdown list in the Setup Office 
Factor Values section 

b. Once the set of Office Factor Categories appear in the list box, enter 
the Name and Value of the new category to be added in the Add 
New Category section 

c. Click on Add Category button  
 
2. To edit office factor categories and values, click Setup > Categories and 

Factor Values > Office Factors. 
 

In the Setup Factor Values Section: 
 

a. Select the Office Factor from the dropdown list 
b. Once the set of Office Factor Categories appear in the list box, click 

the Edit button corresponding to the factor category to be modified 
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c. In the Edit Office Category popup box, modify the Category Name 
and/or Category Value. 

d. Click Save 
 
3. To delete office factor categories and values, click Setup > Categories and 

Factor Values > Office Factors. 
 

In the Setup Office Factor Values Section: 
 

a. Select the Office Factor from the dropdown list 
b. Once the set of Office Factor Categories appear in the list box, click 

the Delete button corresponding to the desired factor 
 
 
Setting Employee Factor Categories and Factor Values 
 
1. To add employee factor categories and values, click Setup > Categories and 

Factor Values > Employee Factors. 
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a. Select the Employee Factor from the dropdown list in the Setup 
Employee Factor Values section 

b. Once the set of Employee Factor Categories appear in the list box, 
enter the Name and Value of the new category to be added in the 
Add New Category section 

c. Click on Add Category button  
 
2. To edit employee factor categories and values, click Setup > Categories and 

Factor Values > Employee Factors. 
 

In the Setup Factor Values Section 
 

a. Select the Employee Factor from the dropdown list in the Setup 
Employee Factor Values section 

b. Once the set of Employee Factor Categories appear in the list box, 
enter the Name and Value of the new category to be added in the 
Add New Category section 

c. Click on Add Category button 
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d. In the Edit Office Category popup box, modify the Category Name 

and/or Category Value. 
e. Click Save 

 
3. To delete employee factor categories and values, click Setup > Categories 

and Factor Values > Employee Factors. 
 

In the Setup Office Factor Values Section: 
 

a. Display Employee Factors by selecting the corresponding label 
b. Once the set of Employee Factor Categories appear in the list box, 

click the Delete button corresponding to the desired factor 
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Uploading Office and Employee Performance Data 
 
The Prepare Data section enables users to upload district, office and employee 
performance data onto the PMIS Rewards System. 
 
 
Uploading District Targets 
  
1. To upload district targets, click Prepare Data > Upload Target 
 

 
 
2. Click the Browse… button and select the file to upload 
 
3. Click Upload 
 
 
INPUT FORM: District Targets Data Worksheet  
 
The District Targets Data Worksheet is a tab delimited text file used for encoding 
collection performance data for all districts to be evaluated. The worksheet also 
indicates the targets allocated for each of the districts enumerated. 
 
The file should have the following information, using the given order of the 
columns: 
 

District 
ID 

District 
Name TARGET ACTUAL 

EMP 
% 

OFC 
% 

FIXED 
% 

PERFORMANCE 
% 

OFC 
CUTOFF 

EMP 
CUTOFF 
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ROW 1: This ROW will ALWAYS contain data for the entire BUREAU as is denoted 
by BOC as its DISTRICT ID. ROWS 2 onwards will contain data for the 
DISTRICTS (in no particular order). 

 
COLUMN 1: contains the District ID  
Note: The District IDs entered in this worksheet must correspond with the District 
IDs in the subsequent worksheets when referring to the same district. Otherwise, 
the system will not be able to compute rewards properly. 
 
COLUMN 2: contains the District Name 
COLUMN 3: target for the given district 
COLUMN 4: actual collection for the given district 
COLUMN 5: the % of the total budget allocated for rewards that will be 

distributed to employees 
COLUMN 6: the % of the total the % of the total budget allocated for rewards 

that will be distributed to offices 
Note: The amounts entered for COLUMNS 5 & 6 must total 100 
 
COLUMN 7: the % of total rewards that will be allotted as fixed rewards 
COLUMN 8: the % of total rewards that will be allotted as merit rewards 
COLUMN 9: office rating required for employees of a given office to receive fixed 
rewards 
COLUMN 10: individual rating required for employees to receive fixed rewards 
Note: for COLUMNS 5 to 10, only ROW 1 will be filled out. The contents for these 
columns refer to the general parameters to be followed when computing for 
office and individual rewards. As such, these values will only apply to the Bureau. 
 
 
Following is sample of this worksheet. 

 
 
 
Uploading Office Evaluations 
 
1. To upload Office Evaluations, click Prepare Data > Upload Office Evaluations 
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2. Click the Browse… button and select the file to upload 
 
3. Click Upload 
 
 
INPUT FORM: Office Evaluation Data Worksheet 
 
The Office Evaluation Data Worksheet is a tab delimited text file where basic 
office information to be used by the Rewards System will be entered. The 
worksheet also entails classifying offices onto the categories which they belong 
based on the predetermined office factors. 
 
The file should have the following information, using the given order of the 
columns: 
 

Office 
ID 

Office 
Name 

District 
ID 

Office 
Size 

Office 
Factor #1 

Office 
Factor #2 

Office 
Factor #3 

………. Office 
Factor N 

 
COLUMN 1: (Office ID) 

Contains the ID for a given office. It is recommended to use the 
OFFICE IDs used by the BOC. 

Note: The Office IDs entered in this worksheet must correspond with the Office IDs 
in the subsequent worksheets when referring to the same office. Otherwise, the 
system will not be able to compute rewards properly. 
 
COLUMN 2: (Office Name) 

Contains the complete Office Name for the specified office. 

Bureau of Customs - EMERGE 3-35 
 



Performance Management Information System-Rewards  
 

 
COLUMN 3: (District ID) 

The DISTRICT ID of the respective office. 
 
COLUMN 4: (Office Size) 

Official headcount of the number of employees in the given office. 
 
COLUMN 5 onwards: (Office Factors) 

From COLUMN 5 ONWARDS, each column’s heading will be the 
name of office factors, listing all of the office factors. 
 
If for example: there are 4 office factors, then  
Office factor #1 will be at column 5, 
Office factor #2 at column 6, 
Office factor #3 at column 7, 
and Office factor #4 at column 8 
 

 
Following is a sample of this worksheet, where there is only 1 office factor, namely 
Office Rating. 

 
 
 
Upload Employee Evaluations 
 
1. To upload Employee Evaluations, click Prepare Data > Upload Employee 

Evaluations 
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2. Click the Browse… button and select the file to upload 
 
3. Click Upload 
 
Note: In simulation runs done using approximately 6,000 employees of the 
Bureau, total uploading and processing time for employee data was 15 minutes. 
 
 
INPUT FORM: Employee Evaluation Data Worksheet 
 
The Employee Evaluation Data Worksheet is a tab delimited text file that will 
contain basic employee information along with their respective individual 
performance ratings. 
 
The final component of the worksheet involves classifying each employee onto 
the categories which they fall under based on the employee factors that have 
been determined. 
 
The file should have the following information, using the given order of the 
columns: 
 

ID 
Number 

Last 
Name 

First 
Name MI 

Employee 
Factor #1 

Employee 
Factor #2 

Employee 
Factor #3 

……….. Employee 
Factor N 

 
COLUMN 1: (ID Number) 

Contains employee’s ID number.  
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Note: The TIN Numbers entered in this worksheet must correspond with the TIN 
Numbers in the subsequent worksheets when referring to the same employee. 
Otherwise, the system will not be able to compute rewards properly. 
 
COLUMN 2: (Last Name) 

Contains the employee’s Last Name. 
 
COLUMN 3: (First Name) 

Contains the employee’s First Name. 
 
COLUMN 4: (MI) 

Contains the employee’s Middle Initial. 
 
COLUMN 5 onwards: (Employee Factors) 

From COLUMN 5 ONWARDS, each column’s heading will be the 
name of employee factors, listing all of the employee factors. 
 
If for example: there are 5 employee factors, then  
Employee factor #1 will be at column 5, 
Employee factor #2 at column 6, 
Employee factor #3 at column 7, 
Employee factor #4 at column 8, 
and Employee factor #5 at column 9 

 
 
Following is a sample of this worksheet, where there have been 4 employee 
factors created in the setup factors page, specifically:  

(1) Individual Rating,  
(2) Position,  
(3) Function,  
(4) Accountability. 
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Upload Employee Offices 
 
In order to accommodate the reality of employees being reassigned to different offices 
during the span of an evaluation period, the system requires employee monthly office 
data to be submitted. The employee monthly office worksheet will specify the offices an 
employee was assigned to for every month in the period. The system then prorates the 
office rating factors based on the employee’s tenure in a given office.  
 
1. To upload Employee Monthly Office Assignments, click Prepare Data > Upload 

Employee Offices 
 

 
 
2. Click the Browse… button and select the file to upload 
 
3. Click Upload 
 
Note: In simulation runs done using approximately 6,000 employees of the 
Bureau, total uploading and processing time for employee data was 15 minutes. 
 
 
INPUT FORM: Employee Monthly Office Data Worksheet 
 
The Employee Monthly Office Data Worksheet is a tab delimited text file used for 
inputting the office where employees were associated with for each month of 
the evaluation period. 
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The file should have the following information, using the given order of the 
columns 
 

 

ID 
Number 

Last 
Name 

First 
Name 

Middle 
Initial 1 2 3 4 5 6 7 8 9 10 11 12 

COLUMN 1: (ID Number) 
Contains employee’s TIN number.  

 
COLUMN 2: (Last Name) 

Contains the employee’s Last Name. 
 
COLUMN 3: (First Name) 

Contains the employee’s First Name. 
 
COLUMN 4: (Middle Initial) 

Contains the employee’s Middle Initial. 
 
COLUMN 5 to 16: (Calendar Months) 

COLUMNS 5 to 16 are labeled from 1 to 12 in order. Each number 
corresponds to the month number of the Bureau’s calendar year.  
For example, if the calendar year begins at January and ends at 
December, then COLUMN 5, which has a heading of 1, will refer to 
January, with COLUMN 6 referring to February, and so on, until 
reaching COLUMN 16, which will represent December. 
The entries for each cell will be the Office ID where the employee 
was assigned to for the particular calendar month. 

 
 
Following is a sample of this worksheet.  
(Note that the months begin at column E, and end at column P, which will 
represent month #12) 
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Rewards Computation 
 
 
Computing Office Rewards 
 
This process generates the office rewards based on the district and office data 
that were uploaded to the system. 
 
1. To compute for office rewards, click Compute Office Rewards 
 

 
 
Following the computation of the office rewards, the screen outputs the result of 
the computations. 
 
 
Computing Employee Rewards 
 
This process generates individual rewards based on the district, office and 
employee data that were uploaded to the system. 
 
1. To compute for individual rewards, click Compute Employee Rewards 
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This screen presents the outcome of the system’s computation of employee 
rewards.  
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Printing Reports 
 
 
1. To print the District Targets report, click Print District Targets 
 

 
 
 
2. To print the Office Rewards report, click Print Office Rewards 
 

 
 
 
3. To print the Individual Rewards Report, click Print Individual Rewards 
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Customs Memorandum Order 

on Attrition Act Implementation 
 
This chapter presents the 
proposed Guidelines and 
Customs Memorandum Order for 
the full scale implementation of 
Attrition Act of 2005 in the Bureau 
of Customs.  
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Scope of the Guidelines and the CMO 
 
 
This chapter presents the proposed Guidelines and Customs 
Memorandum Order for the full scale implementation of Attrition Act 
of 2005 in the Bureau of Customs. 
 

Highlights of the CMO  
 
Title 1: General Provisions 
Title 2: Allocation of Goal 
Title 3: Attrition of Personnel 
Title 4: Reassignment of Personnel  
Title 5: Distribution of Rewards and Incentives  
Title 6: Establishment of the Performance Management System 
Title 7: Reportorial Requirements 
Title 8: Transitory Provisions 

 

Guidelines  
 
1. Guidelines on the Allocation of Goal 
2. Guidelines on Implementation of Performance Management System 
3. Policies and Guidelines in the Distribution of Rewards and Incentives 
under Attrition Act 
4.  Policies and Guidelines on Attrition of Officials and Employees  

 

Recommendations 
 
1. The BOC management must move towards the immediate 

approval of the proposed Guidelines by the Revenue Performance 
and Evaluation Board (RPEB).   Thereafter, the CMO drafting team 
must be re-convened in order to ensure that the CMO is in 
harmony with RPEB approved guidelines. 

 
2. There is a need to create more venues for discussion and 

consultation with various stakeholders about the implementing 
guidelines of the Attrition Act and the proposed CMO.    This is to 
provide a forum for clarification of issues and also to allay fears of 
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officials and employees about the perceived adverse impacts of 
the implementation of  Attrition Act to them. 

 
3. The BOC management must exert political will to implement the 

policies embodied in the proposed guidelines and the CMO.  It 
must also provide support, both in terms of human and financial 
resources, especially to  the PMS sponsors, process owners, and 
monitoring and evaluations teams.   
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Customs Memorandum Order  
 
The draft Customs Memorandum Order is found in Appendix 1.  The 
CMO also contains several annexes as follows: 
 

a. List of Attritable Positions in BOC 

b. Indicative Time Line for Implementation of  Attrition Act 

c. List of Material Documents Required for Implementation of this 
Order  

d. Framework for Computing Rewards and Incentives Under 
Attrition Law 

e. Sample Expenditure Plan 

f. PMS Implementation Guidelines  

 

Guidelines 
The draft guidelines are found in Appendix 2, 3, 4, and 4.  These are as 
follows: 
 

a. Guidelines on Allocation of Goal 
b. Guidelines on Implementation of Performance Management 

System 
c. Policies and Guidelines in the Distribution of Rewards and 

Incentives under the Attrition Act 
d. Policies and Guidelines on Attrition of Officials and Employees  
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Republic of the Philippines 
DEPARTMENT OF FINANCE 

BUREAU OF CUSTOMS 
MANILA 

 
 
CUSTOMS MEMORANDUM ORDER No. __________ 
 
TO:  All Customs Officials and Employees 
 
SUBJECT: Implementation Guidelines for Attrition Act of 2005 
(Republic Act No. 9335). 
 

Pursuant to Republic Act No. 9335, and its implementing rules 
and regulations (“IRR”), this Order is issued to optimize the revenue 
generating capability and collections of the BOC of Customs. 
 

CHAPTER I: GENERAL PROVISIONS 
 

SECTION 1.  OBJECTIVES – This Order is issued to achieve the following 
objectives: 
 

a) To provide a framework for rationally allocating revenue 
targets both at the District and individual level; 

 
b) To prescribe policies, procedures, and guidelines in the 

implementation of the Performance Management System 
(PMS) in the BOC; 

 
c) To provide policies, framework and procedures, in the 

distribution of rewards and incentives in the BOC pursuant to 
Sec. 4 and 5 of the Attrition Act; 

 
d) To provide criteria and procedures for removing from service 

Officials and employees whose revenue collection falls short 
of the target in accordance with Sec. 7, Rule V of the 
Attrition Act;   

 
e) Lastly, to prescribe the duties and responsibilities of units, 

officials, and employees pertaining to allocation of revenue 
targets, establishment of  performance management 
system,  attrition,  and distribution of rewards and incentives 
to Employees and Officials. 

 
SECTION 2.   SCOPE - All Officials and Employees in the BOC of 
Customs (BOC) regardless of employment status, with at least six (6) 
months of service shall be covered by this order. 
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Pursuant to Section 4(h) and (f) of the IRR, an “Official” is a person who 
is appointed to and occupies a third level position while an 
“Employee”  is a person who is appointed to and occupies either a first 
or a second level position.   
 

CHAPTER II:   ALLOCATION OF GOALS 
 
SECTION 3.  GUIDING PRINCIPLES 

 
a) The Attrition Act provides that the collection surplus or 

shortfall relative to the target as adjusted for realized values 
of exogenous variables, respectively, shall be the basis for 
attrition of BOC’s personnel.  (by analogy to Sec. 19, Rule V,  
IRR,) 

 
b) The allocation of the collection target of the BOC shall be 

based on a system that is rational, replicable, transparent 
and fair. It must mitigate any potential perverse incentives 
against good performance and integrity among Officials 
and Employees. A rational target allocation recognizes the 
following principles: 

 
1. BOC revenue is determined by exogenous factors 

as well as effort.   
2. Exogenous factors may not remain constant 

during the year. 
3. Rational targets require quality verifiable 

information.  
 
SECTION 4.  OPERATIONAL POLICIES 
 

The allocation of the BOC target collection shall be done at 
three levels namely (a) across Districts including the Office of 
the Commissioner, (b) across Divisions, Sub-ports, Sections or 
other component units under each District (hereafter referred to 
as Sub-Districts), and (c) across individual attritable personnel.  
 
 
a) Across Districts and Office of the Commissioner 

 
1.  Verifiable Data:  The statistical procedure to be used in 

determining the BOC collection target per District shall 
involve the use of verifiable data to determine the relative 
contribution of the following exogenous variables to the 
percentage change in collection per District and the Office 
of the Commissioner.   Collection shall include duties, value-
added taxes, excise taxes, and other revenue. These 
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exogenous variables, shall include, but not be limited to the 
following: 

  
i. import values (declared and assessed) 
ii. import volumes 
iii. commodity composition of imports  
iv. number of entries 
v. exchange rate 
vi. number of personnel 
vii. value of imports selected Green, Yellow, and Red 
viii. value of duty-exempt imports (granted under special 

laws such as the Export Incentives Act, AFMA, or trade 
agreements such as the AFTA, etc) 

ix. tax credits and deferred payments 
x. value of containerized imports 
xi. non-tax revenue 
xii. budget 
xiii. port infrastructure 
 

Data for any of these variables to be used in the above-
stated replicable statistical procedure must be verifiable 
and statistically significant in explaining collection 
performance.   

 
2. Statistical Procedure:  The application of the statistical 

procedure shall produce the respective estimated 
percentage contributions of the exogenous variables to the 
District’s historical collection performance and collection 
efficiency growth.   
 

i. The weighted sum of the respective estimated 
percentage contributions of the exogenous variables 
and the collection efficiency growth is the estimated 
percentage that shall be used in computing the 
shares of each District in the target collection of the 
BOC.   

 
ii. The Commissioner may increase the target collection 

efficiency growth of a district if in his or her judgment, 
the District collection performance needs to be 
improved.  In adjusting the target collection 
efficiency growth, the Commissioner may be guided 
by factors such as 1) support infrastructure available 
and 2) quality of the personnel at the District. 

 
iii. The District estimated percentage changes in 

collection as may be adjusted by the Commissioner 
are applied to BOC’s actual collection in the current 
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year or up to the last month of the current year where 
information on actual collection is available, to 
obtain the absolute amounts per District, which are 
then converted to District shares. 

 
iv. The District shares are applied to the BOC target for 

the following year to obtain the absolute amounts of 
the target per District.  

  
b) Across the Sub-Districts 

 
1. Subject to the availability of each of the verifiable data at 

the level of the Sub-Districts,, the same statistical procedure 
as described above may be repeated to estimate   the 
targets for said offices.   

 
2. If data is not available to allow a decomposition of the 

factors explaining the Sub-District’s collection performance, 
some other replicable allocation of the target collection of 
the District to which these units belong to may be used, such 
as but not limited to historical shares of the Sub-District’s 
collections. 

 
c) Division Across Its Attritable Individuals 
 
1. The collection target of the lowest grouping or unit that an 

attritable individual directly belongs to shall serve as that 
individual’s target.  All individuals in the said group shall 
share a collective or pooled target.  (Example: if the group 
that an attritable individual immediately reports to is a 
Section, Division, Sub-Port, or Unit, then the target of that 
Section, Division, Sub-Port, or Unit, shall serve as his or her 
target.)  

2. The Head of the unit or group shall also assume its target.  
3. Individual performance shall be evaluated in order to ensure 

similar effort among the individuals in a unit or group. 
4. In a unit or group that consists of individuals of different 

ranks, although the collective target will apply to all, those 
that have a higher rank will have greater responsibility and 
therefore a corresponding greater weight in terms of 
rewards as well as attritability. This will be reflected in their 
performance evaluation, which will consider mitigating 
factors and individual effort separately.  

5. The collection target of an attritable individual who belongs 
to a unit or group that does not have a collection target 
shall be determined on the basis of the source of revenue 
comprising that individual’s work responsibilty. 
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6. Transferees or those in acting capacities shall be considered 
regular members of the unit or group, they are assigned to 
and shall assume the collective target. 

 
SECTION 5.   ROLES AND RESPONSIBILITIES  
 
The following roles and responsibilities shall be performed by various 
agencies in BOC. 
 

a)  The Financial Service under the Revenue Collection 
Monitoring Group shall assume the following responsibilities  
in connection with: 

 
1. Goal Allocation 

 
i. Organize Desk Staff to specialize in each major District 

who will (1) collect data from the District to be used in 
target allocation, (2) collect data including but not 
limited to economic or industrial activity at the local 
level and prices, from independent sources such as 
the National Statistics Office, Department of Finance, 
Bangko Sentral ng Pilipinas, Department of Trade and 
Industry, Department of Agriculture, Department of 
Energy, other government agencies, private sector 
associations and academic libraries, (3) analyze the 
determinants of port collections, (4) conduct random 
checks to verify the accuracy of data particularly 
assessed values. 

ii. Assign staff to hold office in each major District in 
order to ensure completeness and accuracy of 
record-keeping and integrity and quality of data. 

iii. Undertake the statistical procedure(s) needed to 
implement goal allocation. 

iv. Prepare and submit to the Commissioner the annual 
target goal allocation of Districts and their respective 
Divisions, providing a copy to the PMS Owner. 

 
2. Ex Post Target Goal Allocation 

i. Gather the relevant data on the realized values of 
the exogenous variables explaining actual collection. 

ii. Estimate the target collection of the BOC based on 
the above realized data following a replicable and 
transparent procedure. 

iii. Submit the estimate and analysis of the estimate’s 
implications on the BOC’s collection performance in 
the preceding year. 
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b)  Each District shall provide complete monthly data on the 
variables enumerated in Section 4(a)1 above, at the Division 
level including all Divisions under the District, to the Financial 
Service and to the Planning and Systems Control Office 
(PSCO)/ Interim Internal Control Office (IICO)  not later than 
1 October of each year.  

 
c) Each District Head shall allocate the District target to the 

attritable individuals under his or her jurisdiction following the 
guiding principles and methodology for allocating the 
Division target across attritable individuals. The individual 
goal allocation shall be submitted to the Commissioner by 1 
December of each year through the Financial Service. 

 
i. The Financial Service shall be guided by the following 

indicative deadlines:  
ii. Obtain the data from each District not later than 1 

October and/or from other sources such as the 
National Statistics Office. 

iii. Calculate the target allocation of each District and 
Division by 31 October.  

iv. Submit the resulting allocated targets to the 
Commissioner on 1 November of each year.   

v. Disseminate the approved goal allocation to the 
District Heads on 7 November of each year. 

vi. Collect from the District Heads the allocated targets of 
attritable individuals by 30 November. 

vii. Consolidate the goal allocation lists and submit to the 
Office of the Commissioner and the PSCO/IICO by 1 
December. 

viii. The Commissioner shall issue a Customs Memorandum 
Order (CMO) containing the District, Division and 
individual targets and forward it to the DBCC in the first 
week of December. 

 
 

CHAPTER III.  ATTRITION OF PERSONNEL 
 

SECTION 6.  GENERAL POLICY 
 
All personnel of the BOC of Customs who have revenue collection 
target shall be subject to attrition.  They shall include the District 
Collectors, and their deputies, as well as other personnel of the BOC 
performing assessment, audit and collection functions as provided in 
Sec. 17, Rule V of the IRR of the Attrition Act. 
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SECTION 7.   CRITERIA IN DETERMINING PERSONNEL SUBJECT TO 
ATTRITION 

 
a) All Officials and Employees including District Heads and 

assistant district head who have revenue collection targets; 
 
b) District/Port Collectors and their deputies as well as customs 

officers assigned in services, divisions, or units with collection 
targets; and 

 
c) All other Personnel performing assessment, audit and 

collection functions. 
 
For this purpose, the positions listed in the BOC Commissioner’s 
Memorandum to the Secretary of Finance dated 24 November 2006, 
hereto attached as “Annex A” shall be subject to attrition. 
 
SECTION  8.   ACTUAL DUTIES OF PERSONNEL SHALL BE CONTROLLING 
 
In determining whether or not an Official or Employee is subject to 
attrition under Section 7 of the Act and Rule V of the IRR, it is not the 
official designation or title of the position that controls but the actual 
duties performed and the existence of a financial target as reflected 
in such Official’s or Employee’s performance contract.  Personnel 
designated to perform non-assessment and non-collection functions 
even if holding positions normally having financial targets and/or 
performing assessment, audit, or collection functions shall not be 
subject to attrition.  Provided, that the designation to such non-
assessment and non-collection functions has been effective for at 
least one semester. 
 
SECTION 9.   REQUIRED PERIOD IN THE POSITION 
  
The Official or Employee must have been working or holding the 
attritable position for at least six (6) months of service before he or she 
can be subject to attrition. 
 
SECTION 10.    GROUND FOR TERMINATION 

 
Personnel holding any of the positions aforementioned shall be 
separated or removed from the service when the collection 
performance of such Employee or Official falls short of his or her  
individual  collection target by 7.5 %.  (Sec. 18 Rule V of the IRR) 
 
However, a decision to terminate shall be made only after due 
consideration of (a) all relevant  factors affecting collection as 
provided in the IRR and this order and (b) mitigating circumstances 
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such as the personnel’s performance ratings under the performance 
management system and upon compliance with substantial and 
procedural due process.  The performance ratings under PMS shall be 
measured using factors such as office and individual performance, 
position, function and others. 
 
SECTION 11.   WHEN TERMINATION SHALL NOT APPLY 

 
a) Where the District or area of responsibility is newly created, 

not exceeding two years in operation, and has no 
historical record of collection performance that can be 
used as basis for evaluation {Sec. 18 (a) Rule V of the IRR} 

 
b) Where the Official or Employee is a recent transferee in the 

middle of the period under consideration unless the 
transfer was due to nonperformance of revenue targets or 
potential nonperformance of revenue targets {Sec. 18 (b) 
Rule V of the IRR} 

 
SECTION 12.  RELEVANT FACTORS AFFECTING COLLECTION 
PERFORMANCE 

 
 
a. Economic difficulties brought about by natural calamities or 

force majeure suffered by any District or area of 
responsibility covered by Officials or Employees as may be 
determined by the Board (Sec. 18 (b),  Rule V of the IRR). 

 
b. The following factors shall be taken into account only if 

these  have not been considered in setting BESF targets:   
 

i. Enactment of a law that repeals revenue measures, 
reduces tax and tariff rates, grants tax exemptions, or 
otherwise results in the diminution of the tax base or of 
taxable transactions and activities, including the entry 
into force of a treaty or an international agreement 
that the Philippines entered into resulting in 
preferential treatment for certain taxpayers or 
transactions:  Provided that the Board shall have the 
final authority to determine the affected District or 
Districts as well as the amount of revenues deemed 
foregone due to such enactment or entry into force 
{Sec. 19 (a) Rule V of the IRR}. 

 
ii. Reduction by the President of tariff rates under 

Section 401 of the Tariff and Customs Code of the 
Philippines {Sec. 19 (b) Rule V of the IRR}. 
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iii. Exercise by the President of the power to open or 
close any port of entry under Section 702 of the Tariff 
and Customs Code of the Philippines {Section 19 (c) 
Rule V of the IRR}. 

 
SECTION 13.   NON-DISCIPLINARY NATURE OF SEPARATION 

 
Employees and Officials who are separated from the service by virtue 
of Section 7 (a) of the Attrition Act shall be deemed dropped from the 
rolls in accordance with Civil Service Laws, Rules and Regulations, 
without prejudice to the receipt of whatever benefits are due to the 
Official or Employee concerned, including reemployment to other 
government agencies, at the discretion of the appointing authority 
concerned. 

 
SECTION 14.  OPERATIONAL POLICIES  
 
The following operational policies shall be adopted in accordance 
with the Time Table as provided in “Annex B”. 
   

a) Execution of Performance Contracts 
 
1. After the issuance of a CMO containing District, Division and 

individual targets, a Performance Contract shall be 
executed by all attritable individuals. The Performance 
Contract shall be prepared by the following: 

 
i. The Performance Contract between the District 

Collector and the Commissioner shall be prepared by 
the PSCO/IICO.   

 
ii. The Performance Contract between the District 

Collector and all Officials and Employees under his or 
her jurisdiction shall be prepared by the Collector.   

 
2. Employees and Officials concerned must execute the 

aforementioned Performance Contract and forward these 
signed documents to the PSCO/IICO on or before the start 
of the year. 

 
b) Monitoring and Evaluation: 
 

1. The PSCO/IICO and the Human Resource Service (HRS) 
shall collate and monitor the duly executed performance 
contracts.   The evaluation of individual performance shall 
be conducted annually.  However, semestral reports on 
office performance shall be generated for purposes of 
monitoring individual performance evaluation as required 
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by the Attrition Act, and other purposes.  The semestral 
report shall be submitted to the Board.  

 
2. At the end of the year, the PSCO/IICO shall evaluate and 

determine who among the Employees or Officials holding 
attritable positions failed to reach the assigned collection 
target.  The PSCO/IICO shall base their findings on the 
summary of individual weekly performance collection 
report as consolidated by the HRS.   The PSCO/IICO will 
present a list of personnel who failed to reach the assigned 
collection target to the Commissioner. 

 
c)    Review by the Commissioner : 

 
1. The Commissioner shall review the recommendation 

made by PSCO/IICO and after which, he or she shall 
issue an order to those who failed to reach the assigned 
collection target to show cause why he or she should not 
be attrited.   The personnel concerned must submit his or 
her explanation to the Commissioner not later than 15 
days after receipt of the aforementioned order from the 
Commissioner.  

 
2. After due consideration of the explanation made by the 

personnel concerned and all relevant factors/mitigating 
circumstances allowed under this order, the 
Commissioner shall decide whether there is basis to 
recommend a certain individual for termination/attrition 
or reassignment.   Thereafter, the Commissioner shall 
present the list of attritable personnel to the Revenue 
Performance Evaluation Board for approval. 

 
d)   Decision by the Board: 

 
1. The Board shall issue a final decision as to who should be 

removed or separated from the service.  Such decision 
shall be immediately executory. 
 

2. A copy of the final decision of the Board shall be 
transmitted by the Office of the Commissioner to the 
concerned Official or Employee.   

 
e)   Motion for Reconsideration and Appeal: 

 
1. An Official or Employee whose employment is 

terminated by virtue of the final decision of the Board 
may initially file a motion for reconsideration with the 
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Board, through the Commissioner, within fifteen days 
from receipt of such decision.   

 
2. Thereafter, Officials appointed by the President may file 

and appeal at the Office of the President, while all the 
rest of the Officials and Employees may appeal to the 
Civil Service Commission or the Office of the President, as 
the case may be, within 15 days from receipt of the copy 
of the decision of the Board pursuant to Sec. 20 of the 
IRR. 

 
3. The Decision of the Board shall be final and executory 

after the lapse of the reglementary period for filing of 
motion for reconsideration or an appeal or where no 
motion or appeal has been filed. 

 
 

CHAPTER IV:  REASSIGNMENT OF PERSONNEL 
 
SECTION 15.   GENERAL POLICY 
 
The Commissioner of Customs pursuant to  Section  703 of the Tariff 
and Customs Code of the Philippines shall have the power to assign 
Employees in the best interest of service and as often as exigency of 
the service may require. (Sec. 18, last paragraph, Rule V of the IRR).  
The Commissioner shall exercise this power to improve human resource 
competence and optimize the revenue generating capability of the 
BOC. 
 
The concept of reassignment provided in Rule VII, Section 11 of the 
Omnibus Rules Implementing Book V of EO 292, defined as “the 
movement of an  Employee or Official from one organizational unit to 
another in the same agency not involving a reduction in rank, status or 
salary” shall be considered and strictly adhered to when moving 
personnel. 
 
SECTION 16.  GROUNDS FOR REASSIGNMENT OF PERSONNEL –The 
following shall be considered as grounds for reassignment of personnel 
in connection with the implementation of the Attrition Act. 
 

a) Refusal to sign the Performance Contract 
b) Unsatisfactory performance within the contract period as 

may be shown by a personnel’s monthly or quarterly 
performance report. 

c) Failure to reach the assigned annual financial target. 
d) Non-submission of material documents required for the 

implementation of this Order as specified in “Annex C”.  
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e) Good performance, as a basis for reassignment to more 
challenging positions/functions. 

f) Other similar circumstances as the best interest of service 
may require. 

 
SECTION 17.  OPERATIONAL POLICIES -   The following operational 
policies shall be adopted in regard to reassignment of personnel. 
 

a) Any request for reassignment may be initiated by the Head 
of any Unit/Division, District Collector or  by the  PSCO/IICO. 

 
b) All requests for reassignment of personnel shall be 

transmitted to the Office of the Commissioner.  Upon receipt 
of the request for reassignment, the Commissioner shall 
transmit the request to the Lateral Attrition Implementation 
Committee (LAIC) for evaluation. 

 
c) The LAIC will require the PSCO/IICO to submit a report 

containing an evaluation of the past revenue collection 
performance of the personnel.   Thereafter, LAIC will 
evaluate the case of Employee or Official proposed to be 
reassigned by considering his or her performance based on 
the PSCO/IICO report, among others. LAIC shall also request 
the Human Resource Service to recommend new posting for 
the concerned personnel, in case of reassignment. 

 
d) Thereafter, the Commissioner shall exercise his or her 

authority to reassign personnel taking into consideration the 
recommendations of LAIC.     

 
 

 
CHAPTER V:  DISTRIBUTION OF REWARDS AND INCENTIVES 

 
  
 SECTION 18.  GENERAL POLICY 

 
Rewards and Incentives shall be apportioned among the various Units 
and personnel of the BOC, pursuant to Section 4 and Section 5 of the 
Attrition Act and Rule III of its Implementing Rules and Regulations.  
 
A “Unit” shall refer to a Service, Collection District, Ports, Sub-Ports, 
Division, Section or Office in the BOC.  
 
 

 
 
 

                                                
12 of 38 pages  



For Review Purposes Only 
April 24, 2007 

SECTION 19.  COVERAGE 
 

The system of rewards and incentives shall cover all Officials and 
Employees, regardless of employment status, with at least six months 
of service. 

 
  SECTION 20.     TYPES OF REWARDS AND INCENTIVES 
 

a) Individual Rewards  
 
Individual Rewards pertain to monetary benefits or cash 
given to the Officials or Employees in case BOC as a whole 
exceeds its revenue collection target. It is distributed 
according to individual’s performance evaluation rating.   

 
b) Unit Rewards  

 
Unit Rewards pertain to non-monetary benefits given to a 
Unit which has exceeded its revenue collection target in 
case the BOC as a whole exceeds its own revenue 
collection target.  It shall be sourced from twenty five (25%) 
of the Rewards and Incentives Fund.   
 
It shall take the form of non-monetary benefits designed to 
enhance personnel development within the Unit, implement 
measure to improve collection, efficiency, promote training 
and personnel development and improve work environment 
within the Unit. 
 
It shall not be distributed as additional salaries, allowances or 
any other additional emoluments or remuneration to a Unit’s 
Officials and Employees. 

 
c) District Incentives  

 
District Incentives shall refer to incentives given to a 
Collection District that exceeds its target even if the BOC, as 
a whole fails to meet its revenue target by less than ten 
(10%) percent.   
 
District Incentives shall also be distributed in the form of non-
monetary benefits. 

 
SECTION 21.  REWARDS AND INCENTIVES FUND 
 

a) The Rewards and Incentives Fund, created pursuant to 
Section 4 of the Act, shall be sourced from the collection of 
the BOC in excess of its revenue collection target of the 
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year, as determined by the Development Budget and 
Coordinating Committee (DBCC) in the following 
percentages: 

 
Excess of Collection 
over the        Revenue 
Targets 

Percent (%) of the Excess   
Collection to Accrue to 
the Fund 

 
30% or below 

 
15% 

More that 30% 15% of the first 30% plus 
20% of the remaining 
excess. 

 
b) The Fund shall be allocated, distributed and released by the 

Revenue Performance Evaluation Board of the BOC, in 
accordance with the rules and regulations issued by the 
same. 

 
c) A minimum of twenty five (25) % of the Fund shall be 

allocated as Unit Reward and Incentive. 
 
SECTION 22.   BASIS FOR REWARDS AND INCENTIVES 
 

a) Performance ratings of individuals and offices shall be the 
basis for determining rewards under Sections 4 and 5 of the 
Attrition Act.  

 
b) Office and individual performances shall be measured using 

the BOC’s performance management system.  
 

SECTION 23.  REWARDS FRAMEWORK 
 
This framework shall be followed in the distribution of Rewards and 
Incentives in accordance with the Attrition Act.  

  
a)  Individual Rewards 

 
1. The grant of reward to individuals shall be based on a 

combination of the performance of Employee/Officials 
and the performance of the office to which he or she is 
assigned to as translated into individual and office 
ratings, respectively.   
 

2. The office ratings shall be based on the Office 
performance management system   while the individual 
rating shall be based on Individual performance 
management system.  

                                                
14 of 38 pages  



For Review Purposes Only 
April 24, 2007 

 
3. The process of determining the amount of reward for 

each Employee or Official shall involve the assignment of 
weights for selected factors based on personnel’s 
performance and position.  The weights shall represent 
the relative share of each personnel against the total 
reward.  The weight for a given personnel shall be 
obtained by multiplying several factors that represent 
personnel’s performance or accountability.  The factors 
will come from predetermined tables as approved by the 
Commissioner of Customs as further described in “Annex 
D”.  These factors will show the Official’s or Employee’s 
relative contribution to the aggregate amount of the 
excess collection over the targeted amount of tax 
revenue to be collected by the BOC. 
 

4. In determining these factors, the higher rewards and 
incentives shall accrue to Officials and Employees who 
exercise greater responsibilities.  Hence, those who 
occupy higher positions shall correspondingly be entitled 
to greater rewards and incentives.  
 

5. Individuals holding positions subject to attrition, as 
provided for in Section 17, Rule V of the IRR, shall be 
entitled to an additional premium in view of the risk of 
attrition inherent in such position. 

 
6. The rewards of Officials and Employees who provide 

support services to revenue collection both in the 
National Office and in Collection Districts, but do not 
have direct revenue collection functions, shall also be 
determined using the BOC’s performance management 
system.  

 
7. An individual who is transferred in the middle of the 

period shall be entitled to a pro-rata share in the 
rewards. 

 
b) Unit Rewards 

 
1. The Unit rewards shall be distributed based on selected 

factors as may be approved by the Commissioner of 
Customs. 

 
2. The Unit Rewards shall be determined based on a 

particular Unit’s contribution to the aggregate amount of 
excess revenue collection of the BOC. 
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c) District Rewards   
 

1. In case of application of Section 5 of the Attrition Act, the 
distribution of District Incentives to the various offices 
under a District shall be based on selected factors as 
may be approved by the Commissioner of Customs.     

 
2. District Incentives will not be applicable in the following 

cases:  
 

i. Any District which deliberately foregoes any 
revenue collection in any given year as part of 
the scheme to avoid a higher allocated target 
for the subsequent year shall not be entitled to a 
District Incentive in such subsequent year 
notwithstanding its having exceeded its 
allocated target. 

 
ii. A District shall be deemed to have deliberately 

foregone revenue collection when, after it has 
reached or exceeded its annual target before 
the end of the year, its collection for the 
remaining period decreased significantly 
compared to its collection for the remaining 
period in the previous years.  Provided , that the 
remaining period shall be at least one (1) month. 

 
iii. A decrease in collection of at least 20% shall be 

deemed significant unless extenuating 
circumstances similar to those enumerated in 
Section 18, Rule V of the IRR are determined to 
be present by the Board. 

  
SECTION 24.   OPERATIONAL POLICIES 
 
The following operational policies shall be adopted in accordance 
with the Time Table as provided in “Annex B”. 

 
a) The PSCO/IICO shall manage the Rewards System which 

shall electronically compute the scores for each factor as 
provided in the Rewards Framework.  At the end of each 
year, the HRS and the PSCO/IICO shall generate a list of 
individuals and Units/Districts entitled to rewards and 
incentives.  This list shall be referred to as the “Rewards 
Distribution List.” 

 
b) Based on the report of PSCO/IICO and the HRS, the Deputy 

Commissioner for Internal Administration Group shall present 
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the Individual and Unit/District Rewards’ Distribution List for 
consideration of the Commissioner. 

 
c) The Commissioner shall present the Rewards Distribution List 

to the Revenue Performance Evaluation Board for approval. 
 
 
SECTION 25.   PREPARATION OF EXPENDITURE PLAN 

 
An Expenditure Plan refers to a program of expenses consisting of list 
and cost of supplies equipment and services needed in (1) enhancing 
personnel development, (2) implementing measures to improve 
collection efficiency, (3) promoting training and personnel 
development, and (4) improving the work environment within the Unit.   
The preparation of Expenditure Plan shall be consistent with the 
Guidelines on Utilization of Unit/District Rewards that will be issued by 
the BOC.  A sample template of Expenditure Plan is provided in 
“Annex E”. 

   
a) Each Unit of District in the BOC shall submit to the Financial 

Management Office (FMO), not later than November 30 of 
each year, its contingent Expenditure Plan for the 
succeeding year for the utilization of its share in the Rewards 
Fund, in the event the BOC exceeds its target or in case a 
District becomes entitled to District Incentive according to 
the Attrition Act. 

 
b) The final Expenditure Plan of each Unit/District shall be 

submitted to the FMO on or before March 1 of each year. 
 
c) The Expenditure Plans of various Units/Districts shall be 

consolidated by Budget Division of the FMO to come up 
with the BOC’s proposed Consolidated Expenditure Plan.  

 
d) Based on the Consolidated Expenditure Plan, the FMO shall 

present to the Commissioner the proposed distribution of the 
Rewards Fund to deserving individuals, Units/Districts for his or 
her approval.   

 
e) Once approved by the Commissioner, the proposed 

distribution of the Fund shall be submitted to the Board on or 
before the deadline it shall prescribe pursuant to Sections 12 
and 30 (b)(iv) of the IRR. 

 
f) In the event of accrual of rewards based on Sec. 4 or 5 of 

the Attrition Act and subject to release of the funds by the 
Department of Budget and Management (DBM), the 
Accounting Division of the FMO shall be tasked to 

                                                
17 of 38 pages  



For Review Purposes Only 
April 24, 2007 

implement the proposed distribution of rewards and 
incentives among the various Officials, Employees and Units 
or Districts, as the case maybe, based on the Consolidated 
Expenditure Plan approved by the Revenue Performance 
Evaluation Board. 

 
 

CHAPTER VI:  ESTABLISHMENT OF PERFORMANCE MANAGEMENT 
SYSTEM 

 
SECTION 26.  GENERAL POLICY 
 

a) The performance of the various offices and personnel of the 
BOC shall be evaluated annually using a Performance 
Management System (PMS) that is fair, objective and 
accurate, and whose results are not only verifiable but also 
replicable.  

b) The PMS shall follow a four-stage process composed of 
performance planning, monitoring, evaluating, and 
rewarding.   In performance planning, objectives, 
performance measures and targets are established and 
cascaded from the office to the individual levels.     

c) The BOC shall adopt a phased in implementation approach 
in installing its full scale PMS following the PMS 
Implementation Guidelines in “Annex G”. 

d) Pending the installation of a full scale PMS, the BOC shall 
utilize the financial metric (revenue collection performance) 
in evaluating the performance of personnel. 

 

SECTION 27.  ROLE OF THE PLANNING AND SYSTEMS CONTROL OFFICE 
(PSCO)/ INTERIM INTERNAL CONTROL OFFICE (IICO) 
 
The PSCO/ IICO shall ensure that the PMS is installed in accordance 
with the PMS Implementation Guidelines.   Further, it shall coordinate 
with the Financial Service in implementing the rewarding/attriting 
phase of the PMS. 
 

CHAPTER VII.  REPORTORIAL REQUIREMENTS  
 
 SECTION 28.  BOC Representation in the Revenue Performance 
Evaluation Board. 
 

a) The members of Employees’ or Officials’ organizations as 
may be duly recognized by the BOC shall elect the following 
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representatives to the Board:  one (1) Official and two (2) 
Employees.   

 
b) Only Officials may elect the representative of the “Official’s 

Group” to the Board.  In the same manner, only Employees 
may elect the representatives of the “Employee’s Group” to 
the Board. 

 
SECTION 29.  PREPARATION OF BOC PERFORMANCE REPORTS 

 
a) Within one month from the end of each semester, the 

Financial Service shall prepare the BOC performance reports 
required under Section 28 of the IRR and present the same 
to the Commissioner for approval.  The reports shall be 
submitted semi-annually, and the last report shall be 
annualized. 

 
b) Once approved by the Commissioner, the reports shall be 

submitted to the Board as well as to Congress, within two 
months after each period covered by the report in 
accordance with Section 30(b)(vi) and (d)(i) of the IRR. 

 
CHAPTER VIII.  OTHER  SANCTIONS 

 
SECTION 30.   No Employee or Official is allowed to process import 
entries covering commodities not belonging to his or her section.  Any 
BOC personnel found to be violating this provision shall be subject to 
disciplinary measures under Rule IX of the Omnibus Rules Implementing 
Book V of the Executive Order No. 292 (series of 1987) as amended 
and other Civil Service laws, rules and regulations. 
 

CHAPTER IX.  TRANSITORY PROVISIONS 
 
SECTION 31.  TRANSITORY PROVISIONS – Inasmuch as the Implementing 
Rules and Regulations of the Attrition Act was issued on 22 May 2006, 
the documents required to be submitted to the Board for fiscal year 
2006 shall be prepared in accordance with the following schedule: 

 
a) Not later than thirty (30) days from the issuance of this Order, 

the Collection District that exceeds its target for CY 2006 
shall submit to the FMO its proposed Expenditure Plan for the 
utilization of its rewards.  

 
b) Not later than thirty (30) days from the issuance of this Order, 

each Unit shall submit to the FMO  its proposed expenditure 
plan for the utilization of the Fund in the event the BOC 
exceeds its target for CY 2006. 
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SECTION 32. REPEALING CLAUSE – All existing customs memorandum  
orders, and other issuances inconsistent herewith are hereby repealed, 
modified or amended accordingly. 
 
SECTION 33.  EFFECTIVITY – This Order shall take effect immediately. 
 
 

  
 
 NAPOLEON MORALES 
 Commissioner  
 BOC of Customs 
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                              LIST OF ANNEXES 
 
a) List of Attritable Positions in BOC 

b) Indicative Time Line for Implementation of  Attrition Act 

c) List of Material Documents Required for Implementation of this 
Order  

d) Framework for Computing Rewards and Incentives Under Attrition 
Act 

e) Sample Expenditure Plan 

f) PMS Implementation Guidelines  
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ANNEX  A   -- LIST OF ATTRITABLE POSITIONS 

 
(See Excel Files) 

 
(See page 3-18 for a sample of the over 4,000 positions.) 
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ANNEX  B -- INDICATIVE TIME TABLE 

 
Activity Date 
1. GOAL ALLOCATION  

DBCC formally communicates to the Board the over all 
collection goal of BOC. 

September 

DCR-RCMG shall prepare a List of Collection Targets per 
District. 

October 

District Collector shall assign targets for all individuals under 
his or her jurisdiction. 

November 

Commissioner will issue a CMO containing individual and 
district targets and forward it to the DBCC. 

First week of December 

2. EXECUTION OF PERFORMANCE CONTRACTS  
      Office Performance Contracts Second Week of 

December 
Contract between the Office of the Commissioner and the 
District Collector. 

Second Week of 
December 

Contract between the District Collector and individual 
under his or her jurisdiction. 

Third Week of December 

Submission of Signed Performance Contracts to PSCO/ IICO.  Fourth Week of 
December 

3.  MONITORING OF PERFORMANCE  
District Collector shall submit the revenue collection 
performance report of each attritable  individual under his 
or her jurisdiction to PSCO/ IICO. 

Weekly 

PSCO/ IICO will manage the PMS system. Year round 
4.  EVALUATION OF PERFORMANCE  
     a)  Attrition  

PSCO/IICO shall present to the Commissioner a List of 
Attritable Employees or Officers 

Second Week of January 

Commissioner will order personnel in danger of being 
attrited to explain why they should not be terminated. 

Third Week of January 

Commissioner will submit names of personnel proposed to 
be attrited to the Revenue Performance Board for approval. 

February 

RPEB releases the names of personnel to be attrited. March 
   b)  Rewards  
       PSCO/IICO will prepare the Rewards Distribution List. First Week of January 

Depcom for IAG will present to the Commissioner the 
Rewards Distribution List. 

February 

Commissioner will present the Rewards Distribution List to the 
Revenue Performance Evaluation Board for approval 

March 

5.   FINAL  STEPS:  
a)  ATTRITION   
A copy of the final decision of the Board shall be 
transmitted by the Office of the Commissioner to the 
concerned Official or Employee.   

March 
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b)   DISTRIBUTION OF  REWARDS   
Preparation Of Expenditure Plan  
Each Unit/District will prepare an Expenditure Plan for its 
share in the utilization of Fund in case BOC exceeds its 
target (or District exceeds its target) and submit it to the 
FMO.  

 

o Contingent Expenditure Plan End of November 
o Final Expenditure Plan Second Week of 

February 
Budget Division of FMO will consolidate the EPs and present 
the Consolidated Expenditure Plan to the Commissioner. 

Last Week of February 

Commissioner will present Consolidated EP for approval by 
the Board. 

March 
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ANNEX C -- LIST OF MATERIAL DOCUMENTS 
 
 

Documents Person In Charge 
1. Performance Contract Employee/Official 
2. Monthly Performance Report District Collector 
3. Semestral Performance Report PSCO/IICO 
4. Annual Performance Report Financial Service 
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ANNEX D -- FRAMEWORK FOR COMPUTING REWARDS AND INCENTIVES 

UNDER ATTRITION LAW 

 
Part I:  KINDS OF REWARDS AND INCENTIVES 

A.  PERSONNEL REWARDS 
 
The reward amount for a given personnel will have two components, a 
fixed reward and a merit reward: 
 
Reward for a Personnel = Fixed Reward (FR) + Merit Reward (MR) 
 
Fixed Reward 
 
The fixed reward is divided evenly among all personnel in the BOC.   
 
Suppose N = the number of personnel in the BOC; the fixed reward per 
personnel is computed as follows: 
 

FR (Fixed Reward) = FIXEDEMP / N 
 
It is also possible to restrict fixed rewards to particular personnel in the 
BOC, if top management deems it appropriate to do so.  For instance, 
a cutoff for personnel performance and/or the performance of the 
office that the personnel belongs to may be imposed, so that only 
those personnel meeting the cutoff are eligible for fixed rewards.  In 
this case, the value N will be less than the total number of personnel in 
the BOC. 
 
Merit Reward 
 
Personnel merit rewards are computed using the following method: 
 
a)  Weights are first assigned to each personnel in the BOC.  The 
weights represent the relative merit rewards share of the given 
personnel.  These weights are obtained by multiplying several factors 
associated to a personnel.  Factors may vary from year to year.  Based 
on a workshop conducted with the BOC in September 2006, and in 
succeeding consultations with BOC Officials, the following factors 
have emerged: 
 

1. position factor (PF) 

2. function factor (FF) 

3. accountability factor (AF) 
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4. personnel rating factor (RF) 

5. office rating factor (OF) 

6. goal size factor (GF) 

 
Each personnel will have a position factor (PF), a function factor (FF), 
an accountability factor (AF), and an employee rating factor (RF).  The 
office covering a certain personnel will also have an office rating 
factor (OF) and a goal factor (GF).  The values for these factors will 
depend on personnel circumstances and will come from 
predetermined tables presented in a separate section.  It is possible 
that one of these factors is 0, implying no merit reward for the given 
personnel. 
 
Suppose: 
 
Wi = weight assigned to personnel i, computed as  
 

PF * FF * AF * RF * OF * GF 
 
S = sum of all Wi’s 
 
Then: 

MRi (Merit Reward for personnel i ) = MERITEMP * Wi / S. 
 
Total reward for a personnel is simply the sum of the computed fixed 
and merit reward amounts. 
 

TRi (Total Reward for personnel i ) = FR + MRi

 

B. UNIT REWARDS 
 
A similar process applies to rewards distribution at the office level, 
although rewards in this case will not have a fixed component.  Three 
factors apply at the office level:  office rating factor (OF), goal size 
factor (GF) representing the difficulty level of the collection goal of an 
office, and a size factor (SF) representing the number of personnel in 
that office.  The proposed factor values are presented in a separate 
section. 
 

1. office rating factor (OF) 

2. goal size factor (GF) 

3. office size factor (SF) 
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Suppose: 
 
Wi = weight assigned to office i, computed as OF * GF * SF 
S = sum of all Wi’s 
 
Then: 
 

ORi (Reward for office i) = OFCFUND * Wi / S. 

 

C. DISTRICT REWARDS 
 
In case Section 5 of the Attrition Act applies (the BOC does not meet 
its target), then only districts that exceed their collection targets will be 
entitled to rewards and only office rewards will apply.  Rewards will be 
determined using a method similar to the one described in the 
previous section.  The same formulas apply, although computations will 
be made per district.  The term OFCFUND will be replaced by 
DISTFUND, representing the District Incentive allocated for offices in a 
performing district: 
 
Suppose: 
 
Wi = weight assigned to office i, computed as OF * SF * GF 
 
S = sum of all Wi’s for an office given (performing) district 
 
Then: 
 

DRi (Reward for office i) = DISTFUND * Wi / S. 
 
 
 

Title II: FACTOR TABLES 
 
In this section, factor tables are presented for the different factor 
categories.  The factor values found in these tables will be used in the 
computation of weights as discussed in the previous section.   

A. Employee Factors 
 
All personnel will be categorized according to their position, function, 
and atritability.  This means that each personnel will fall under a 
particular position category, function category, and attritability 
category, as defined by top management.  These categories, in turn, 
determine the factors to be used during rewards distribution. 
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Function categories capture the actual function carried out by an 
personnel.  Initially, categories such as “Assessment”, “Audit”, 
“Enforcement”, “Legal” and “Operations” were included to distinguish 
between these different roles.  These were later simplified to three 
categories: 
 
 

Function 
Category 

Factor 
(FF) 

Top Management     10 
Line 9 
Support 8 

 
 
 
 
 
 
 
Note that the factor values indicated in the above table implies that 
Support personnel get 20% less than Top Management personnel, all 
other things being equal.  “Line” personnel are non-support personnel 
in collection districts, and personnel under this category get 10% less 
than Top Management personnel. 
 
Position categories capture the rank and designation of a given 
employee.  Although plantilla item data serves as a reasonable 
starting point when determining position categories, it should be 
emphasized that the categories should capture actual assignments of 
personnel.  Categorizations will be based on the “effective” salary 
grade of the personnel. 
 

Position Category Factor 
( PF) 

SG 30 15 
SG 29 14 
SG 28 13 
SG 27 12 
SG 26 11 
SG 25 10 
SG 24 9 

SG 21-23 8 
SG 19-20 7 
SG 16-18 6 
SG 11-15 5 
SG 7-10 4 
SG 4-6 3 
SG 1-3 2 

 
It is reasonable to assume that attritable personnel should get more 
rewards than those who are not attritable, all other personnel 
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characteristics being equal.  The following table captures this 
distinction. 
 
 Attritability 

Category 
Factor 
  (AF) 

Attritable     12 
Not Attritable 5 

 
 
 
 
 
Performance rating factors enable a rewards system that is 
performance based.  The current personnel performance rating 
system is the Performance Evaluation System (PES). The table below 
illustrates PES ratings and factors that corresponding to each personnel 
rating. 
 

Employee 
Rating 

Factor 
( PF) 

2 0.5 
3 0.5 
4 0.5 
5 5 
6 5 
7 6 
8 6 
9 8 

10 8 

B. Office Factors 
 
Employee weights also include indicators at the office level, 
particularly office performance and goal size.  Performance ratings at 
the office level and their corresponding factors are given in the 
following table. 
 

Office 
Rating 

Factor 
( PF) 

1 0 
2 1 
3 6 
4 9 
5 10 

 
Office ratings should be generated from an Office Performance 
Management System (OPMS).  In the absence of a full-blown OPMS, 
ratings can be dependent on collection performance alone, for 
instance:  
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Collection Performance 
(actual over target) 

Office 
Rating 

Below 92.5% 1 
92.5% to 99% 2 
99% to 100% 3 

100% to 107.5% 4 
Above 107.5% 5 

 
Goal size categories and factors represent the level of difficulty 
associated with an office in terms of meeting their collection goal.  This 
may be based purely on the collection target amount although other 
indicators may be used. 

Goal Size 
Category 

Factor 
( GF) 

1 6 
2 8 
3 10 
4 11 
5 13 
6 15 

 
Determination of goal categories can be based on the following: 
 

Collection Target Goal Category 
Below 0.8B 1 
0.8B to 3B 2 
3B to 10B 3 

10B to 30B 4 
30B to 50B 5 
Over 50B 6 

 
 
The Office Rating and Goal Size factor tables are used in the 
determination of personnel rewards.  The same tables are used for 
office rewards.  In addition, for office rewards, Office Size Factor is 
included.  Here, the actual size of the office will be used as the 
corresponding factor. 
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ANNEX E - SAMPLE EXPENDITURE PLAN 

 
                                                        

BOC OF CUSTOMS 
    

EXPENDITURE PLAN 
UNIT or DISTRICT INCENTIVE (per R.A. 9335) 

CY ____________ 
(In Thousand Pesos) 

    
REVENUE REGION: ________________________________   

 
 
   

TYPE OF EXPENSES QUANTITY COST PER UNIT 
TOTAL 

AMOUNT 
        
        
        
        
    
Prepared by:  Approved by:  
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ANNEX F -- PMS IMPLEMENTATION GUIDELINES 

 
SECTION 1.  POLICY GUIDELINES: 
 

a) The Implementing Rules and Regulations of the 2005 
Performance Attrition Act require the use of a Performance 
Management System (PMS) in distribution the rewards and 
incentives for Officials and Employees of the BOC of Customs 
(BOC).   

 
b) The Commissioner of Customs shall evaluate annually the 

performance of the various offices and personnel of the BOC 
using a PMS that is fair, objective and accurate, and whose 
results are not only verifiable but also replicable.    

 
c) The PMS follows a four-stage process composed of 

performance planning, monitoring, evaluating, and rewarding.   
In performance planning, objectives, performance measures 
and targets are established and cascaded from the office to 
the individual levels.  Monitoring involves periodically checking 
and systematically documenting performance at the office and 
individual levels so that necessary adjustments in priorities and 
strategies can be made.  Evaluation involves the process of 
assessing whether the performance targets are attained and 
determining ratings for actual performance.  The results of 
performance evaluation are used as basis for rewards and 
continuous improvements.   

 
d) The BOC’s PMS follows the Balanced Scorecard approach in 

the design and installation of the PMS.  It is a strategy 
management and implementation tool that looks at 
performance of an organization from a balanced set of 
perspectives such as: 
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i. Financial - It includes efforts of the BOC that 

directly contribute to increased collection.   
 
ii. Customer - It pertains to all strategic objectives 

leading to increasing compliance and satisfaction 
levels of BOC customers.  

 
iii. Process improvement - It captures all strategic 

objectives of the Agency to improve its core 
operations processes.  These core processes may 
be in the areas of assessment/valuation, trade 
facilitation, and enforcement, warehousing and 
case resolution. 

 
iv. Organizational learning and growth - It subsumes 

all strategic objectives contributing to 
improvement in BOC human resource 
competence, integrity and professionalism. It also 
includes efforts of the BOC to improve the quality 
of its work life.  

 
e) The performance management system uses several tools to 

ensure effective alignment of performance measures/data 
across offices and individuals.  These are the strategy map, 
scorecard, measures dictionary, PMS process map and the 
performance management information system.  

 
i. The Strategy Map is used to translate the vision 

and mission of the BOC of Customs into inter-
related strategic objectives.  It serves as the 
guiding framework in the formulation of office and 
individual performance scorecards.   All the 
performance measures or key performance 
indicators in performance scorecards are linked to 
these objectives. 

 
ii. The Performance Scorecard serves as the 

contract that binds offices and individuals to pre-
identified financial and non-financial targets.  
Performance Scorecards are mutually agreed –
upon and signed by raters and ratees after the 
target setting and evaluation processes. 

 
iii. The Measures Dictionary is a reference document 

containing detailed information about each 
measure in the scorecard.  
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iv. The PMS process map details the activities of the 
PMS Teams in ensuring alignment of targets across 
offices during the target setting, integrity of data 
during the monitoring process and consolidation 
and analyses of data during the evaluation stage.  
The PMS Teams are composed of the PMS 
Sponsors, Owners and Monitoring and Evaluation 
(M&E) Teams.  The PMS Sponsors are composed of 
the BOC Commissioner, EXECOM and District 
Collectors. The PMS Owners are the Financial 
Service, Interim Internal Quality Control Service 
and Human Resource Service.  The Financial 
Service focuses on financial collection data at the 
Office level while the Interim Internal Quality 
Control Service on non-financial performance 
data at the Office level and the Human Resource 
Service on performance data at the individual 
level. 

 
f) The last tool is the Performance Management Information 

System (PMIS) which is a web-based application that supports 
the OPMS process.  Its installation and implementation is a major 
component of the OPMS since it is the system that facilitates the 
encoding and processing of measurement data to arrive at 
performance ratings for offices. It has the following modules: 

 
i. Planning/ Target-setting - includes the setting up 

and generation of Office Contracts. 
 

ii. Evaluation – includes the generation of worksheets 
for consolidating and uploading actual 
performance data, and rating of office 
performance. 

 
iii. Management Reports – includes standard reports 

that provide management with data for analysis 
and decision-making. 

 

g) With all tools installed, the PMS is a potent tool that can provide 
quantitative and qualitative explanations on the organizational 
determinants of good and poor performance.  With good 
performance measures properly documented and evaluated, 
one is able to systematically define the areas of strength and 
improvement of an office which becomes a basis for office 
target setting, continuous improvement and organizational 
rewards. 
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SECTION 2.  INSTALLATION TIMELINE : 
 
The installation of a full-scale PMS will take some time.   The following is 
the installation timeline of PMS for BOC. 
 
 

a) YEAR 1    
 

Activity Indicators 
Main 
Deliverable    

Office performance contracts that capture a balanced 
set of performance measures.  The BOC Scorecard shall 
be firmed up and cascaded up to the District level 
based on pre-identified clustering.   

Monitoring Agency and District Scorecard ratings are monitored 
periodically. 

Evaluation Agency and Districts are evaluated based on a 
balanced set of performance measures. Individual are 
evaluated using the PES.   

Rewarding Offices are rewarded based on Scorecard ratings.  
Individuals are rated using the rewards framework. 

Change 
Management 

Visible, sustained top management sponsorship of the 
project is required.  A communication plan focusing on 
the rationale and gains of the PMS should be instilled in 
top and middle BOC managers across ports. 
 
District collectors are trained and coached on the skills 
involved in PMS: strategic and aligned target setting, 
monitoring and documentation of performance data, 
evaluation and continuous improvement of offices and 
cascade of performance data to the individual level.  
They are also trained how to be effective change 
managers. 

OPMIS PMIS used as a stand alone system to assess office and 
individual performance ratings. 

 
 

b) YEAR 2 
 
 

Activity Indicators 
Deliverable 
 

Office performance contracts contain balanced set of 
performance measures.  BOC and District Scorecard 
enhanced and cascaded to the Group, Division and 
Section levels. 
 

Monitoring All Offices are monitored periodically. 
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Evaluation 
 

All Offices are evaluated based on a balanced set of 
performance measures.  Individuals are evaluated using 
the PES. 

Rewarding Offices are rewarded based on Scorecard ratings.  
Individuals are rated using the rewards framework. 

Change 
Management 

District collectors are trained to   be effective 
“coaches” to their personnel in the sustained 
implementation of the PMS.  They are also trained on 
anticipating and managing possible resistance to the 
PMS. 

OPMIS PMIS used as a stand alone system to assess office and 
individual performance ratings. 
 

 
 

c) YEAR 3 
 

Activity Indicators 
Deliverable Individual performance contracts are aligned with 

office performance contracts. 
Monitoring Individual performance contracts monitored on a 

semestral basis. 
Evaluation Individuals are evaluated using the PES that is aligned 

with the Office Scorecards. 
Rewarding Individuals are rewarded based on financial and non-

financial measures 
Change 
Management 

Individuals are trained to align their targets to the office, 
monitor their performance using pre-structured 
monitoring tools and accept feedback during the 
evaluation stage. 

OPMIS PMIS used as a stand alone system to assess office and 
individual performance ratings. 
 

 
 
SECTION 3.   STAKEHOLDERS AND IMPLEMENTORS 
 
The PMS installation process will have to be steered and managed by 
critical stakeholders internal to BOC for more ownership and buy-in of 
the system.  The PMS teams will be formed with distinct and 
complementing roles.  It shall be composed of three levels of 
stakeholders.  The relationship among the PMS critical stakeholders is in  
Annex A. 
 

a) The PMS sponsors shall champion the PMS and provide strategic 
directions.  They shall be composed of the Customs 
Commissioner (Cuscom), EXECOM and the 15 District Collectors. 
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b) The PMS process owners shall provide technical support to the 

PMS sponsors.  They will consolidate and analyze performance 
data of the Agency.  They will also communicate the 
performance results of the BOC. They shall be composed of the 
Finance Service, Human Resource Service and Interim Internal 
Control Office. 
 

c) The PMS Monitoring &Evaluation Teams shall ensure the integrity 
of the performance data in the Districts. They shall be 
composed of the Deputy Collectors across Districts.  Studies 
show that middle managers have the most access and 
influence on the Employees.  It is critical that the Deputy 
Collectors are allies in the installation of the PMS. 
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Republic of the Philippines 
REVENUE PERFORMANCE EVALUATION BOARD 

Bureau of Customs 
Manila 

 
 

GUIDELINES ON THE ALLOCATION OF REVENUE TARGETS FOR DISTRICTS, OFFICIALS 
and EMPLOYEES  

 
Pursuant to the provisions of Sec. 6, Rule II of the Implementing Rules and 
Regulations of the Attrition Act of 2005, the Revenue Performance Evaluation 
Board (RPEB) hereby prescribes the system of rationally allocating revenue 
targets for Districts, Officials and Employees. 
 
SECTION 1. POLICY GUIDELINES 

 
a) The Attrition Act provides that the collection shortfall relative to the 

target as adjusted for realized values of exogenous variables, 
respectively, shall be the basis for attrition of the Bureau’s personnel.  
(Sec. 19, Rule V,  IRR) 

 
b) The allocation of the collection target of the Bureau shall be based on 

a system that is rational, replicable, transparent and fair. It must 
mitigate any potential perverse incentives against good performance 
and integrity among Officials and Employees. A rational target allocation 
recognizes the following principles: 

 
1. BOC revenue is determined by exogenous factors as well as 

effort.   
2. Exogenous factors may not remain constant during the year. 
3. Rational targets require quality verifiable information.  

 
SECTION 2.  OPERATIONAL POLICIES 
 

The allocation of the BOC target collection shall be done at three levels 
namely (a) across Districts including the Office of the Commissioner, (b) 
across Divisions, Sub-ports, Sections or other component units under each 
District (hereafter referred to as Sub-Districts), and (c) across individual 
attritable personnel.  
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a) Across Districts and Office of the Commissioner 
 

1.  Verifiable Data:  The statistical procedure to be used in determining 
the BOC collection target per District shall involve the use of verifiable 
data to determine the relative contribution of the following exogenous 
variables to the percentage change in collection per District and the 
Office of the Commissioner.   Collection shall include duties, value-
added taxes, excise taxes, and other revenue. These exogenous 
variables, shall include, but not be limited to the following: 

  
i. import values (declared and assessed) 
ii. import volumes 
iii. commodity composition of imports  
iv. number of entries 
v. exchange rate 
vi. number of personnel 
vii. value of imports selected Green, Yellow, and Red 
viii. value of duty-exempt imports (granted under special laws such 

as the Export Incentives Act, AFMA, or trade agreements such 
as the AFTA, etc) 

ix. tax credits and deferred payments 
x. value of containerized imports 
xi. non-tax revenue 
xii. budget 
xiii. port infrastructure 

 
Data for any of these variables to be used in the above-stated 
replicable statistical procedure must be verifiable and statistically 
significant in explaining collection performance.   
 

2. Statistical Procedure:  The application of the statistical procedure shall 
produce the respective estimated percentage contributions of the 
exogenous variables to the District’s historical collection performance 
and collection efficiency growth.   
 

i. The weighted sum of the respective estimated percentage 
contributions of the exogenous variables and the collection 
efficiency growth is the estimated percentage that shall be 
used in computing the shares of each District in the target 
collection of the Bureau.   

 
ii. The collection efficiency growth is a residual between the 

actual collection performance of the District and that portion of 
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the collection which is explained by the exogenous variables.  
The residual is attributable to the intensity and quality of the 
Bureau’s collection performance effort.  

 
iii. The Commissioner may increase the target collection efficiency 

growth of a District if in his or her judgment the District collection 
performance needs to be improved.  In adjusting the target 
collection efficiency growth, the Commissioner may be guided 
by factors such as 1) support infrastructure available and 2) 
quality of the personnel at the District. 

 
iv. The District estimated percentage changes in collection as may 

be adjusted by the Commissioner are applied to BOC’s actual 
collection in the current year or up to the last month of the 
current year where information on actual collection is available, 
to obtain the absolute amounts per District, which are then 
converted to District shares. 

 
v. The District shares are applied to the BOC target for the 

following year to obtain the absolute amounts of the target per 
District.  

  
b) Across the Sub-Districts 

 
1. Subject to the availability of each of the verifiable data at the level of 

the Sub-Districts, the same statistical procedure as described above 
may be repeated to estimate   the targets for said offices.   

 
2. If data is not available to allow a decomposition of the factors 

explaining the Sub-District’s collection performance, some other 
replicable allocation of the target collection of the District to which 
these units belong to may be used, such as but not limited to historical 
shares of the Sub-District’s collections. 

 
c) Across Its Attritable Individuals 
 
1. The collection target of the lowest grouping or unit that an attritable 

individual directly belongs to shall serve as that individual’s target.  All 
individuals in the said group shall share a collective or pooled target.  
(For instance, if the group that an attritable individual immediately 
reports to is a Section, Division, Sub-Port, or Unit, then the target of that 
Section, Division, Sub-Port, or Unit, shall serve as his/her target.)  
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SECTION 3:   ROLES AND RESPONSIBILITIES  
 
The following roles and responsibilities shall be performed by various agencies in 
BOC. 
 

a)  The Financial Service under the Revenue Collection Monitoring Group 
shall assume the following responsibilities  in connection with: 

 
1. Goal Allocation 

 
i. Organize Desk Staff to specialize in each major District who will 

(1) collect data from the District to be used in target allocation, 
(2) collect data including but not limited to economic or 
industrial activity at the local level and prices, from 
independent sources such as the National Statistics Office 
(NSO), Department of Finance (DOF), Bangko Sentral ng 
Pilipinas, Department of Trade and Industry, Department of 
Agriculture, Department of Energy, other government agencies, 
private sector associations and academic libraries, (3) analyze 
the determinants of port collections, (4) conduct random 
checks to verify the accuracy of data particularly assessed 
values. 

ii. Assign staff to hold office in each major District in order to 
ensure completeness and accuracy of record-keeping and 
integrity and quality of data. 

iii. Undertake the statistical procedure(s) needed to implement 
goal allocation. 

iv. Prepare and submit to the Commissioner the annual target goal 
allocation of Districts and their respective Divisions, providing a 
copy to the PMS Owner. 

 
2. Ex Post Target Goal Allocation 
 

i. Gather the relevant data on the realized values of the 
exogenous variables explaining actual collection. 

ii. Estimate the target collection of the BOC based on the above 
realized data following a replicable and transparent procedure. 

iii. Submit the estimate and analysis of the estimate’s implications 
on the BOC’s collection performance in the preceding year. 

 
b)  Each District shall provide complete monthly data on the variables 

enumerated in Section 4(a) 1 above, at the Division level including all 
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Divisions under the District, to the Financial Service and to the 
PSCO/IICO not later than 1 October of each year.  

 
c) Each District Head shall allocate the District target to the attritable 

individuals under his or her jurisdiction following the guiding principles 
and methodology for allocating the Division target across attritable 
individuals. The individual goal allocation shall be submitted to the 
Commissioner by 1 December of each year through the Financial 
Service. 

 
i. The Financial Service shall be guided by the following indicative 

deadlines:  
ii. Obtain the data from each District not later than 1 October 

and/or from other sources such as the National Statistics Office. 
iii. Calculate the target allocation of each District and Division by 31 

October.  
iv. Submit the resulting allocated targets to the Commissioner on 1 

November of each year.   
v. Disseminate the approved goal allocation to the District Heads 

on 7 November of each year. 
vi. Collect from the District Heads the allocated targets of attritable 

individuals by 30 November. 
vii. Consolidate the goal allocation lists and submit to the Office of 

the Commissioner and the PSCO/IICO by 1 December. 
viii. The Commissioner shall issue a Customs Memorandum Order 

containing the District, Division and individual targets and forward 
it to the DBCC in the first week of December. 

 
 

D.     EFFECTIVITY:    
 
These guidelines shall take effect immediately. 
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Approved by the Revenue Performance Evaluation Board (RPEB) 
this 19th day of April 2007, in Manila, Philippines 

 
 
 
 
 
 
MARGARITO TEVES 
Secretary 
Department of Finance 
 
 

 
ROLANDO ANDAYA, JR. 
Secretary 
Department of Budget and Management 

 
 
ROMULO NERI 
Secretary 
National Economic and Development Authority 
 
 
 
NAPOLEON MORALES 
Commissioner 
Bureau of Customs 
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GUIDELINES IN THE IMPLEMENTATION OF  

PERFORMANCE MANAGEMENT SYSTEM FOR BUREAU OF CUSTOMS 
 

Pursuant to the provisions of Sec. 25, Rule VI of the Implementing Rules and 
Regulations of the Attrition Act of 2005, the Revenue Performance Evaluation 
Board (RPEB) hereby prescribes the system of performance evaluation for Bureau 
of Customs.  
 
SECTION 1.  POLICY GUIDELINES: 
 

a) The Implementing Rules and Regulations of the 2005 Performance Attrition 
Act require the use of a Performance Management System (PMS) in 
distribution the rewards and incentives for officials and employees of the 
Bureau of Customs (BOC).   

 
b) The Commissioner of Customs shall evaluate annually the performance of 

the various offices and personnel of the Bureau using a Performance 
Management System (PMS) that is fair, objective and accurate, and 
whose results are not only verifiable but also replicable.    

 
c) The Performance Management System (PMS) follows a four-stage process 

composed of performance planning, monitoring, evaluating, and 
rewarding.   In performance planning, objectives, performance measures 
and targets are established and cascaded from the office to the 
individual levels.  Monitoring involves periodically checking and 
systematically documenting performance at the office and individual 
levels so that necessary adjustments in priorities and strategies can be 
made.  Evaluation involves the process of assessing whether the 
performance targets are attained and determining ratings for actual 
performance.  The results of performance evaluation are used as basis for 
rewards and continuous improvements.   

 
d) The Bureau’s PMS follows the Balanced Scorecard approach in the design 

and installation of the Performance Management System.  It is a strategy 
management and implementation tool that looks at performance of an 
organization from a balanced set of perspectives such as: 
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i. Financial - It includes efforts of the BOC that directly 

contribute to increased collection.   
 
ii. Customer - It pertains to all strategic objectives leading to 

increasing compliance and satisfaction levels of BOC 
customers.  

 
iii. Process improvement - It captures all strategic objectives of 

the Agency to improve its core operations processes.  These 
core processes may be in the areas of 
assessment/valuation, trade facilitation, and enforcement, 
warehousing and case resolution. 

 
iv. Organizational learning and growth - It subsumes all 

strategic objectives contributing to improvement in BOC 
human resource competence, integrity and professionalism. 
IT also includes efforts of the BOC to improve the quality of its 
work life.  

 
e) The Performance Management System uses several tools to ensure 

effective alignment of performance measures/data across offices and 
individuals.  These are the strategy map, scorecard, measures dictionary, 
PMS process map and the performance management information 
system.  

 
i. The Strategy Map is used to translate the vision and mission 

of the Bureau of Customs into inter-related strategic 
objectives.  It serves as the guiding framework in the 
formulation of office and individual performance 
scorecards.   All the performance measures or key 
performance indicators in performance scorecards are 
linked to these objectives. 

 
ii. The Performance Scorecard serves as the contract that 

binds offices and individuals to pre-identified financial and 
non-financial targets.  Performance Scorecards are mutually 
agreed –upon and signed by raters and ratees after the 
target setting and evaluation processes. 

 
iii. The Measures Dictionary is a reference document 

containing detailed information about each measure in the 
scorecard.  
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iv. The PMS process map details the activities of the PMS Teams 

in ensuring alignment of targets across offices during the 
target setting, integrity of data during the monitoring process 
and consolidation and analyses of data during the 
evaluation stage.  The PMS Teams are composed of the PMS 
Sponsors, Owners and Monitoring and Evaluation (M&E) 
Teams.  The PMS Sponsors are composed of the BOC 
Commissioner, EXECOM and District Collectors. The PMS 
Owners are the Financial Service, Interim Internal Quality 
Control Service and Human Resource Service.  The Financial 
Service focuses on financial collection data at the Office 
level while the Interim Internal Quality Control Service on 
non-financial performance data at the Office level and the 
Human Resource Service on performance data at the 
individual level. 

 
f) The last tool is the Performance Management Information System (PMIS) 

which is a web-based application that supports the OPMS process.  Its 
installation and implementation is a major component of the OPMS since 
it is the system that facilitates the encoding and processing of 
measurement data to arrive at performance ratings for offices. It has the 
following modules: 

 
i. Planning/ Target-setting - includes the setting up and 

generation of Office Contracts. 
 

ii. Evaluation – includes the generation of worksheets for 
consolidating and uploading actual performance data, and 
rating of office performance. 

 
iii. Management Reports – includes standard reports that 

provide management with data for analysis and decision-
making. 

 

g) With all tools installed, the PMS is a potent tool that can provide 
quantitative and qualitative explanations on the organizational 
determinants of good and poor performance.  With good performance 
measures properly documented and evaluated, one is able to 
systematically define the areas of strength and improvement of an office 
which becomes a basis for office target setting, continuous improvement 
and organizational rewards. 
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SECTION 2.  INSTALLATION TIMELINE: 
 
The installation of a full-scale PMS will take some time.   The following is the 
installation timeline of PMS for BOC. 
 
 

a) YEAR 1    
 

Activity Indicators 
Main 
Deliverable    

Office performance contracts that capture a balanced 
set of performance measures.  The BOC Scorecard shall 
be firmed up and cascaded up to the District level 
based on pre-identified clustering.   

Monitoring Agency and District Scorecard ratings are monitored 
periodically. 

Evaluation Agency and Districts are evaluated based on a 
balanced set of performance measures. Individual are 
evaluated using the PES.   

Rewarding Offices are rewarded based on Scorecard ratings.  
Individuals are rated using the rewards framework. 

Change 
Management 

Visible, sustained top management sponsorship of the 
project is required.  A communication plan focusing on 
the rationale and gains of the PMS should be instilled in 
top and middle BOC managers across ports. 
 
District collectors are trained and coached on the skills 
involved in PMS: strategic and aligned target setting, 
monitoring and documentation of performance data, 
evaluation and continuous improvement of offices and 
cascade of performance data to the individual level.   
They are also trained how to be effective change 
managers. 

OPMIS PMIS used as a stand alone system to assess office and 
individual performance ratings. 
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b) YEAR 2 
 
 

Activity Indicators 
Deliverable 
 

Office performance contracts contain balanced set of 
performance measures.  BOC and District Scorecard 
enhanced and cascaded to the Group, Division and 
Section levels. 
 

Monitoring 
 

All Offices are monitored periodically. 
 

Evaluation 
 

All Offices are evaluated based on a balanced set of 
performance measures.  Individuals are evaluated using 
the PES. 

Rewarding Offices are rewarded based on Scorecard ratings.  
Individuals are rated using the rewards framework. 

Change 
Management 

District collectors are trained to   be effective 
“coaches” to their personnel in the sustained 
implementation of the PMS.  They are also trained on 
anticipating and managing possible resistance to the 
PMS. 

OPMIS PMIS used as a stand alone system to assess office and 
individual performance ratings. 
 

 
 

c) YEAR 3 
 

Activity Indicators 
Deliverable Individual performance contracts are aligned with 

office performance contracts. 
Monitoring Individual performance contracts monitored on a 

semestral basis. 
Evaluation Individuals are evaluated using the PES that is aligned 

with the Office Scorecards. 
Rewarding Individuals are rewarded based on financial and non-

financial measures 
Change 
Management 

Individuals are trained to align their targets to the office, 
monitor their performance using pre-structured 
monitoring tools and accept feedback during the 
evaluation stage. 

OPMIS PMIS used as a stand alone system to assess office and 
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individual performance ratings. 
 

 
 
SECTION 3.   STAKEHOLDERS AND IMPLEMENTORS 
 
The PMS installation process will have to be steered and managed by critical 
stakeholders internal to BOC for more ownership and buy-in of the system.  The 
PMS teams will be formed with distinct and complementing roles.  It shall be 
composed of three levels of stakeholders.  The relationship among the PMS 
critical stakeholders is in  Annex A. 
 

a) The PMS sponsors shall champion the PMS and provide strategic 
directions.  They shall be composed of the Customs Commissioner 
(Cuscom), EXECOM and the 15 District Collectors. 
 

b) The PMS process owners shall provide technical support to the PMS 
sponsors.  They will consolidate and analyze performance data of the 
Agency.  They will also communicate the performance results of the BOC. 
They shall be composed of the Finance Service, Human Resource Service 
and Interim Internal Control Office. 
 

c) The PMS Monitoring &Evaluation Teams shall ensure the integrity of the 
performance data in the Districts. They shall be composed of the Deputy 
Collectors across Districts.  Studies show that middle managers have the 
most access and influence on the employees.  It is critical that the Deputy 
Collectors are allies in the installation of the PMS. 

 
 
D.     EFFECTIVITY:    
These guidelines shall take effect fifteen days after its publication in the National 
Administrative Register (NAR) of the University of the Philippines Law Center. 
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Approved by the Revenue Performance Evaluation Board (RPEB) 

this 19th day of April 2007, in Manila, Philippines 
 
 
 

 
MARGARITO TEVES 
Secretary 
Department of Finance 
 
 
 
 
ROLANDO ANDAYA, JR. 
Secretary 
Department of Budget and Management 
 
 
 
ROMULO NERI 
Secretary 
National Economic and Development Authority 
 
 
 
NAPOLEON MORALES 
Commissioner 
Bureau of Customs 
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                ANNEX A  
 
 

 
RELATIONSHIP OF PMS CRITICAL STAKEHOLDERS 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

M&E teams for every District 
composed of the Deputy 

Collectors assisted by Data 
Monitoring Unit 

 

Performance 
Quality Assurance 

PMS Process Owners composed 
of the Finance Service, Human 
Resource Service and Interim 

Internal Control Office, Incentives 
Review Committee 

Performance 
Integrators and 

Analysts 

PMS Sponsors composed of the CusCOM, 
ExeCOM and the District Collectors 

Strategic Direction 
Providers 
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Republic of the Philippines 
REVENUE PERFORMANCE EVALUATION BOARD 

Bureau of Customs 
Manila 

 
 

POLICIES AND GUIDELINES IN THE DISTRIBUTION OF REWARDS AND INCENTIVES 
UNDER THE ATTRITION LAW 

 
 
Pursuant to the provisions of Sec. 25 (a) of the Implementing Rules and 
Regulations of the Attrition Act of 2005, the Revenue Performance Evaluation 
Board (RPEB) hereby prescribes the rules and guidelines for the allocation, 
distribution and release of the Rewards Fund due to the Bureau as provided for in 
the Section 4 of the Act and for the allocation, distribution and release of District 
Incentive due to a District as provided for in Section 5 of the Act. 
 

1. GENERAL POLICY: 
 

Rewards and Incentives shall be apportioned among the various Units, 
Officials and Employees of the Bureau, pursuant to Section 4 and Section 
5 of the Attrition Act of 2005 and Rule III of its Implementing Rules and 
Regulations (IRR). 
 
1.1. Coverage: 
 
The system of rewards and incentives shall cover all officials and 
employees, regardless of employment status, with at least six months of 
service. 
 
An “Official” is a person who is appointed to and occupies a third 
level position while an “Employee” is a person who is appointed to 
and occupies either a first or a second level position.   
 
 
1.2.      Types of Rewards and Incentives: 
 

1.2.1. Individual Rewards  
 
Individual Rewards pertain to monetary benefits or cash given to 
the Officials or Employees in case BOC as a whole exceeds its 
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revenue collection target. It is distributed according to individual’s 
performance evaluation rating.   
 

 
 

 
 

1.2.2. Unit Rewards  
 
Unit Rewards pertain to non-monetary benefits given to a Unit 
which has exceeded its revenue collection target in case the BOC  
as a whole exceeds its own revenue collection target.  

 
A “Unit” shall refer to a Service, Collection District, Ports, Sub-Ports, 
Division, Section or Office in the BOC.  

 
Unit Rewards shall be sourced from twenty five (25%) of the 
Rewards and Incentives Fund.   
 
It shall take the form of non-cash benefits designed to enhance 
personnel development within the Unit, implement measure to 
improve collection, efficiency, promote training and personnel 
development and improve work environment within the Unit. 
 
It shall not be distributed as additional salaries, allowances or any 
other additional emoluments or remuneration to a Unit’s Officials 
and Employees. 

 
1.2.3. District Incentives: 
 
District Incentives shall refer to incentives given to a Collection 
District that exceeds its target even if the BOC, as a whole fails to 
meet its revenue target by less than ten (10%) percent.   
 
District Incentives shall also be distributed in the form of non-
monetary benefits. 
 

 
 1.3.     Rewards and Incentives Fund: 
 

1.3.1. The Rewards and Incentives Fund, created pursuant to 
Section 4 of the Act, shall be sourced from the collection of 
the Bureau in excess of its revenue collection target of the 
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year, as determined by the Development Budget and 
Coordinating Committee (DBCC) in the following 
percentages: 

 
Excess of Collection 
over the  
Revenue Targets 

Percent (%) of the Excess  
Collection to Accrue to the 
Fund 

 
30% or below 

15% 

More that 30% 15% of the first 30% plus 20% 
of the remaining excess. 

   
Collection target shall refer to the original estimated 
revenue collection expected of the BOC for a given year as 
stated in the in the Budget of Expenditures and Sources of 
Financing (BESF) submitted by the President to Congress.  
 

1.3.2. The Fund shall be allocated, distributed and released by the 
Revenue Performance Evaluation Board (Board) of the 
Bureau, in accordance with the rules and regulations issued 
by the same. 

 
1.3.3. A minimum of 25% of the Fund shall be allocated as Unit 

Reward and Incentive. 
 

1.4.     Basis for Rewards and Incentives: 
 
 
           1.4.1. Performance ratings of individuals and offices shall be the 

basis for determining rewards under Sections 4 and 5 of the 
Attrition Act of 2005.  

 
1.4.2 Office and individual performances shall be measured using 

the BOC’s performance management system.  
   
 
1.5. Rewards Framework: 
 

The following framework shall be followed in the distribution of 
Rewards and Incentives in accordance with the Attrition Act of 
2006.  
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1.5.2 Individual Rewards 
 

1.5.1.1.1. The grant of reward to individuals shall be 
based on a combination of the 
performance of Employee/Officials and the 
performance of the office to which he or 
she is assigned to as translated into 
individual and office ratings, respectively.   

 
1.5.1.1.2. The office ratings shall be based on the 

Office performance management system   
while the individual rating shall be based on 
Individual performance management 
system.  

 
1.5.1.1.3. The process of determining the amount of 

reward for each Employee or Official shall 
involve the assignment of weights for 
selected factors based on personnel’s 
performance and position.  The weights 
shall represent the relative share of each 
personnel against the total reward.  The 
weight for a given personnel shall be 
obtained by multiplying several factors that 
represent personnel’s performance or 
accountability.  The factors will come from 
predetermined tables as approved by the 
Commissioner of Customs as further 
described in “Annex A”.  These factors will 
show the Official’s or Employee’s relative 
contribution to the aggregate amount of 
the excess collection over the targeted 
amount of tax revenue to be collected by 
the BOC. 

 
1.5.1.1.4. In determining these factors, the higher 

rewards and incentives shall accrue to 
Officials and Employees who exercise 
greater responsibilities.  Hence, those who 
occupy higher positions shall 
correspondingly be entitled to greater 
rewards and incentives.  
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1.5.1.1.5. Individuals holding positions subject to 
attrition, as provided for in Section 17, Rule 
V of the IRR, shall be entitled to an 
additional premium in view of the risk of 
attrition inherent in such position. 

 
1.5.1.1.6. The rewards of Officials and Employees 

who provide support services to revenue 
collection both in the National Office and 
in Collection Districts, but do not have 
direct revenue collection functions, shall 
also be determined using the BOC’s 
performance management system.  

 
1.5.1.1.7. An individual who is transferred in the 

middle of the period shall be entitled to a 
pro-rata share in the rewards. 

 
 
1.5.2 Unit Rewards 
 

1.5.1.2.1. The Unit rewards shall be distributed based 
on selected factors as may be approved 
by the Commissioner of Customs. 

 
1.5.1.2.2. The Unit rewards shall be determined based 

on a particular Unit’s contribution to the 
aggregate amount of excess revenue 
collection of the BOC. 

 
1.5.2 District Rewards 
 

1.5.1.3.1. In case of application of Section 5 of the 
Attrition Act, the distribution of District 
Incentives to the various offices under a 
District shall be based on selected factors 
as may be approved by the Commissioner 
of Customs.     

 
1.5.1.3.2. District Incentives will not be applicable in 

the following cases: 
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Any District which deliberately foregoes any 
revenue collection in any given year as 
part of the scheme to avoid a higher 
allocated target for the subsequent year 
shall not be entitled to a District Incentive in 
such subsequent year notwithstanding its 
having exceeded its allocated target. 
 
A District shall be deemed to have 
deliberately foregone revenue collection 
when, after it has reached or exceeded its 
annual target before the end of the year, 
its collection for the remaining period 
decreased significantly compared to its 
collection for the remaining period in the 
previous years.  Provided that the 
remaining period shall be at least one (1) 
month. 
 
A decrease in collection of at least 20% 
shall be deemed significant unless 
extenuating circumstances similar to those 
enumerated in Section 18, Rule V of the IRR 
are determined to be present by the Board. 
  

2.          OPERATIONAL POLICIES 
 
 The following operational policies shall be adopted in accordance with 

the Time Table as provided in Annex B. 
 
 2.1    Execution of Performance Contracts 

 
After the issuance of a CMO containing District, Division and individual 
targets, Performance Contracts shall be executed by all attritable 
individuals. The Performance Contract shall be prepared by the following: 
 

i. The Performance Contract between the District Collector and 
the Commissioner shall be prepared by the PSCO/IICO.   

 
ii. The Performance Contract between the District Collector and 

all Officials and Employees under his or her jurisdiction shall be 
prepared by the Collector.   
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Employees and Officials concerned must execute the aforementioned 
Performance Contract and forward these signed documents to the 
PSCO/IICO on or before the start of the year. 
 
2.2 Monitoring and Evaluation 

 
The PSCO/IICO shall manage the Rewards System which shall 
electronically compute the scores for each factor as provided in the 
Rewards Framework.  At the end of each year, the HRS and the 
PSCO/IICO shall generate a list of individuals and Units/Districts entitled to 
rewards and incentives.  This list shall be referred to as the “Rewards 
Distribution List.” 
 
Based on the report of PSCO/IICO and the HRS, the Deputy Commissioner 
for Internal Administration Group shall present the Individual and 
Unit/District Rewards’ Distribution List for consideration of the 
Commissioner. 
 
The Commissioner shall present the Rewards Distribution List to the 
Revenue Performance Evaluation Board 

 
 

2.2. Preparation of Expenditure Plan:  
 
An Expenditure Plan refers to a program of expenses consisting of list and 
cost of supplies equipment and services needed in (1) enhancing 
personnel development, (2) implementing measures to improve collection 
efficiency, (3) promoting training and personnel development, and (4) 
improving the work environment within the unit.   The preparation of 
Expenditure Plan shall be consistent with the Guidelines on Utilization of 
Unit/District Rewards that will be issued by the BOC.  A sample Expenditure 
Plan is provided in Annex C. 
   

2.2.1. Each Unit of District in the Bureau shall submit to the Financial 
Management Office (FMO), not later than November 30 of 
each year, its contingent Expenditure Plan for the 
succeeding year for the utilization of its share in the Fund in 
the event the Bureau exceeds its target or in case a District 
becomes entitled to District Incentive according to the 
Attrition Act. 

  
2.2.2. The final Expenditure Plan of each Unit/District shall be 

submitted to the FMO on or before March 1 of each year. 
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2.2.3. The Expenditure Plans of various Units/Districts shall be 

consolidated by Budget Division of the FMO to come up 
with the Bureau’s proposed Consolidated Expenditure Plan 
for the utilization of the Fund as required by Section 11 of the 
IRR.     

 
2.2.4. Based on the consolidated Expenditure Plan, the FMO shall 

present to the Commissioner the proposed distribution of the 
Rewards Fund to deserving individuals, Units/Districts for 
his/her approval.   

 
2.2.5. Once approved by the Commissioner, the proposed 

distribution of the Fund shall be submitted to the Board on or 
before the deadline it shall prescribe pursuant to Sections 12 
and 30 (b)(iv) of the IRR. 

 
2.2.6. In the event of accrual of rewards based on Sec. 4 or 5 of 

the Attrition Law and subject to release of the funds by the 
DBM, the Accounting Division of the FMO shall be tasked to 
implement the proposed distribution of rewards and 
incentives among the various Officials, Employees and Units 
or Districts, as the case maybe, based on the Expenditure 
Plans approved by the Commissioner and the Board. 

 
 

3.       EFFECTIVITY:   These guidelines shall take effect immediately.   
 

Approved by the Revenue Performance Evaluation Board (RPEB) 
This 19th day of April 2007, in Manila, Philippines 

 
 

 
MARGARITO TEVES 
Secretary 
Department of Finance 

 
 

ROMULO NERI 
Secretary 
National Economic and Development 
Authority 

 
 
ROLANDO ANDAYA, JR. 
Secretary 
Department of Budget and 
Management 

 
 
NAPOLEON MORALES 
Commissioner 
Bureau of Customs 
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ANNEX A - FRAMEWORK FOR COMPUTING REWARDS AND INCENTIVES 
UNDER ATTRITION LAW 

 
Part I:  KINDS OF REWARDS AND INCENTIVES 

 

A.  PERSONNEL REWARDS 
 
The reward amount for a given personnel will have two components, a fixed 
reward and a merit reward: 
 
Reward for a Personnel = Fixed Reward (FR) + Merit Reward (MR) 
 
Fixed Reward 
 
The fixed reward is divided evenly among all personnel in the BOC.   
 
Suppose N = the number of personnel in the BOC; the fixed reward per personnel 
is computed as follows: 
 

FR (Fixed Reward) = FIXEDEMP / N 
 
It is also possible to restrict fixed rewards to particular personnel in the BOC, if top 
management deems it appropriate to do so.  For instance, a cutoff for personnel 
performance and/or the performance of the office that the personnel belongs 
to may be imposed, so that only those personnel meeting the cutoff are eligible 
for fixed rewards.  In this case, the value N will be less than the total number of 
personnel in the BOC. 
 
Merit Reward 
 
Personnel merit rewards are computed using the following method: 
 
a)  Weights are first assigned to each personnel in the BOC.  The weights 
represent the relative merit rewards share of the given personnel.  These weights 
are obtained by multiplying several factors associated to a personnel.  Factors 
may vary from year to year.  Based on a workshop conducted with the BOC in 
September 2006, and in succeeding consultations with BOC Officials, the 
following factors have emerged: 
 

1. position factor (PF) 
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2. function factor (FF) 

3. accountability factor (AF) 

4. personnel rating factor (RF) 

5. office rating factor (OF) 

6. goal size factor (GF) 

 
Each personnel will have a position factor (PF), a function factor (FF), an 
accountability factor (AF), and an employee rating factor (RF).  The office 
covering a certain personnel will also have an office rating factor (OF) and a 
goal factor (GF).  The values for these factors will depend on personnel 
circumstances and will come from predetermined tables presented in a 
separate section.  It is possible that one of these factors is 0, implying no merit 
reward for the given personnel. 
 
Suppose: 
 
Wi = weight assigned to personnel i, computed as  
 

PF * FF * AF * RF * OF * GF 
 
S = sum of all Wi’s 
 
Then: 

MRi (Merit Reward for personnel i ) = MERITEMP * Wi / S. 
 
Total reward for a personnel is simply the sum of the computed fixed and merit 
reward amounts. 
 

TRi (Total Reward for personnel i ) = FR + MRi

 

B. UNIT REWARDS 
 
A similar process applies to rewards distribution at the office level, although 
rewards in this case will not have a fixed component.  Three factors apply at the 
office level:  office rating factor (OF), goal size factor (GF) representing the 
difficulty level of the collection goal of an office, and a size factor (SF) 
representing the number of personnel in that office.  The proposed factor values 
are presented in a separate section. 
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1. office rating factor (OF) 

2. goal size factor (GF) 

3. office size factor (SF) 

 
Suppose: 
 
Wi = weight assigned to office i, computed as OF * GF * SF 
S = sum of all Wi’s 
 
Then: 
 

ORi (Reward for office i) = OFCFUND * Wi / S. 

 

C. DISTRICT REWARDS 
 
In case Section 5 of the Attrition Act applies (the BOC does not meet its target), 
then only districts that exceed their collection targets will be entitled to rewards 
and only office rewards will apply.  Rewards will be determined using a method 
similar to the one described in the previous section.  The same formulas apply, 
although computations will be made per district.  The term OFCFUND will be 
replaced by DISTFUND, representing the District Incentive allocated for offices in 
a performing district: 
 
Suppose: 
 
Wi = weight assigned to office i, computed as OF * SF * GF 
 
S = sum of all Wi’s for an office given (performing) district 
 
Then: 
 

DRi (Reward for office i) = DISTFUND * Wi / S. 
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Title II: FACTOR TABLES 
 
In this section, factor tables are presented for the different factor categories.  The 
factor values found in these tables will be used in the computation of weights as 
discussed in the previous section.   

A. Employee Factors 
 
All personnel will be categorized according to their position, function, and 
atritability.  This means that each personnel will fall under a particular position 
category, function category, and attritability category, as defined by top 
management.  These categories, in turn, determine the factors to be used during 
rewards distribution. 
 
Function categories capture the actual function carried out by an personnel.  
Initially, categories such as “Assessment”, “Audit”, “Enforcement”, “Legal” and 
“Operations” were included to distinguish between these different roles.  These 
were later simplified to three categories: 
 
 

Function 
Category 

Factor 
(FF) 

Top Management     10 
Line 9 
Support 8 

 
 
 
 
 
 
 
Note that the factor values indicated in the above table implies that Support 
personnel get 20% less than Top Management personnel, all other things being 
equal.  “Line” personnel are non-support personnel in collection districts, and 
personnel under this category get 10% less than Top Management personnel. 
 
Position categories capture the rank and designation of a given employee.  
Although plantilla item data serves as a reasonable starting point when 
determining position categories, it should be emphasized that the categories 
should capture actual assignments of personnel.  Categorizations will be based 
on the “effective” salary grade of the personnel. 
 

Position Category Factor 
( PF) 

SG 30 15 
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SG 29 14 
SG 28 13 
SG 27 12 
SG 26 11 
SG 25 10 
SG 24 9 

SG 21-23 8 
SG 19-20 7 
SG 16-18 6 
SG 11-15 5 
SG 7-10 4 
SG 4-6 3 
SG 1-3 2 

 
It is reasonable to assume that attritable personnel should get more rewards than 
those who are not attritable, all other personnel characteristics being equal.  The 
following table captures this distinction. 
 
 Attritability 

Category 
Factor 
  (AF) 

Attritable     12 
Not Attritable 5 

 
 
 
 
 
Performance rating factors enable a rewards system that is performance based.  
The current personnel performance rating system is the Performance Evaluation 
System (PES). The table below illustrates PES ratings and factors that 
corresponding to each personnel rating. 
 

Employee 
Rating 

Factor 
( PF) 

2 0.5 
3 0.5 
4 0.5 
5 5 
6 5 
7 6 
8 6 
9 8 

10 8 
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B. Office Factors 
 
Employee weights also include indicators at the office level, particularly office 
performance and goal size.  Performance ratings at the office level and their 
corresponding factors are given in the following table. 
 

Office 
Rating 

Factor 
( PF) 

1 0 
2 1 
3 6 
4 9 
5 10 

 
Office ratings should be generated from an Office Performance Management 
System (OPMS).  In the absence of a full-blown OPMS, ratings can be dependent 
on collection performance alone, for instance:  
 

Collection Performance 
(actual over target) 

Office 
Rating 

Below 92.5% 1 
92.5% to 99% 2 
99% to 100% 3 

100% to 107.5% 4 
Above 107.5% 5 

 
Goal size categories and factors represent the level of difficulty associated with 
an office in terms of meeting their collection goal.  This may be based purely on 
the collection target amount although other indicators may be used. 

Goal Size 
Category 

Factor 
( GF) 

1 6 
2 8 
3 10 
4 11 
5 13 
6 15 

 
Determination of goal categories can be based on the following: 
 

Collection Target Goal Category 
Below 0.8B 1 
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0.8B to 3B 2 
3B to 10B 3 

10B to 30B 4 
30B to 50B 5 
Over 50B 6 

 
 
The Office Rating and Goal Size factor tables are used in the determination of 
personnel rewards.  The same tables are used for office rewards.  In addition, for 
office rewards, Office Size Factor is included.  Here, the actual size of the office 
will be used as the corresponding factor. 

 
 
 
 
 
 
 
 

  15  of 18 pages 
 



For Review Purposes Only 
April 24, 2007 

 
 

ANNEX B – INDICATIVE TIMELINE 
 
 

Activity Date 
1. GOAL ALLOCATION  

DBCC formally communicates to the Board the 
over all collection goal of BOC. 

September 

DCR-RCMG shall prepare a List of Collection 
Targets per District. 

October 

District Collector shall assign targets for all 
individuals under his or her jurisdiction. 

November 

Commissioner will issue a CMO containing 
individual and district targets and forward it to the 
DBCC. 

First week of December 

2. EXECUTION OF PERFORMANCE CONTRACTS  
      Office Performance Contracts Second Week of 

December 
Contract between the Office of the Commissioner 
and the District Collector. 

Second Week of 
December 

Contract between the District Collector and 
individual under his or  her jurisdiction. 

Third Week of December 

Submission of Signed Performance Contracts to 
PSCO/ IICO.  

Fourth Week of December 

3.  MONITORING OF PERFORMANCE  
District Collector shall submit the revenue collection 
performance report of each attritable  individual 
under his or her jurisdiction to PSCO/ IICO. 

Weekly 

PSCO/ IICO will manage the PMS system. Year round 
4.  EVALUATION OF PERFORMANCE  
     a)  Attrition  

PSCO/IICO shall present to the Commissioner a List 
of Attritable Employees or Officers 

Second Week of January 

Commissioner will order personnel in danger of 
being attrited to explain why they should not be 
terminated. 

Third Week of January 

Commissioner will submit names of personnel 
proposed to be attrited to the Revenue 
Performance Board for approval. 

February 

RPEB releases the names of personnel to be 
attrited. 

March 

   b)  Rewards  
       PSCO/IICO will prepare the Rewards Distribution 
List. 

First Week of January 

Depcom for IAG will present to the Commissioner February 
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the Rewards Distribution List. 
Commissioner will present the Rewards Distribution 
List to the Revenue Performance Evaluation Board 
for approval 

March 

5.   FINAL  STEPS:  
a)  ATTRITION   
A copy of the final decision of the Board shall be 
transmitted by the Office of the Commissioner to 
the concerned Official or Employee.   

March 

b)   DISTRIBUTION OF  REWARDS   
Preparation Of Expenditure Plan  
Each Unit/District will prepare an Expenditure Plan 
for its share in the utilization of Fund in case BOC 
exceeds its target (or District exceeds its target) 
and submit it to the FMO.  

 

o Contingent Expenditure Plan End of November 
o Final Expenditure Plan Second Week of February 

Budget Division of FMO will consolidate the EPs and 
present the Consolidated Expenditure Plan to the 
Commissioner. 

Last Week of February 

Commissioner will present Consolidated EP for 
approval by the Board. 

March 
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ANNEX C - SAMPLE EXPENDITURE PLAN 
 

 
 
                                                        

BUREAU OF CUSTOMS 
    

EXPENDITURE PLAN 
UNIT or DISTRICT INCENTIVE (per R.A. 9335) 

CY ____________ 
(In Thousand Pesos) 

    
REVENUE REGION: 
________________________________   

 
 
   

TYPE OF EXPENSES QUANTITY COST PER UNIT TOTAL AMOUNT 
        
        
        
        
    
Prepared by:  Approved by:  
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Republic of the Philippines 

REVENUE PERFORMANCE EVALUATION BOARD 
Bureau of Customs 

Manila 
 

 
POLICIES AND GUIDELINES ON ATTRITION OF OFFICIALS AND EMPLOYEES  

 
 
 Pursuant to the provisions of Sec. 25 (b), Rule VI of the Implementing Rules 
and Regulations of the Attrition Act of 2005, the Revenue Performance 
Evaluation Board (RPEB) hereby prescribes the criteria and procedures for 
removing from the service Officials and Employees whose revenue collection 
falls short of the target in accordance with Sec. 7 of the Act. 
 
1. GENERAL POLICY: 
 

All personnel of the Bureau of Customs who have revenue collection 
targets shall be subject to attrition.  They shall include the District 
Collectors, and their deputies, as well as other personnel of the Bureau 
performing assessment, audit and collection functions as provided in Sec. 
17, Rule V of the IRR of the Attrition Act. 

 
Pursuant to Section 4(h) and (f) of the IRR, an “Official” is a person who is 
appointed to and occupies a third level position while an “Employee” is a 
person who is appointed to and occupies either a first or a second level 
position.   

 
For this purpose, the positions listed in the BOC Commissioner’s 
Memorandum to the Secretary of Finance dated 24 November 2006, 
hereto attached as Annex A, shall be subject to attrition. 
 

 
1.1. Criteria in Determining Personnel  Subject to Attrition: 
 

1.1.1. All Officials and Employees including District Heads and 
Assistant District Head who have revenue collection targets; 

 
1.1.2. District/Port Collectors and their deputies as well as customs 

officers assigned in services, divisions, or units with collection 
targets; and 
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1.1.3. All other personnel performing assessment, audit and 
collection functions. 

 
1.2.   Actual Duties of Personnel shall be Controlling: 

 
In determining whether or not an Official or Employee is subject to 
attrition under Section 7 of the Act and Rule V of the IRR, it is not 
the official designation or title of the position that controls but the 
actual duties performed and the existence of a financial target as 
reflected in such Official’s or Employee’s performance contract.  
Personnel designated to perform non-assessment and non-
collection functions even if holding positions normally having 
financial targets and/or performing assessment, audit, or collection 
functions shall not be subject to attrition.  Provided, that the 
designation to such non-assessment and non-collection functions 
has been effective for at least one semester. 

 
1.3. Required Period in the Position: 

  
The Official or Employee must have been working or holding the 
attritable position for at least six (6) months of service before he or 
she can be subject to attrition. 
 

1.4. Ground for Termination: 
 

1.4.1. Personnel holding any of the positions aforementioned shall 
be separated or removed from the service when the 
collection performance of such Employee or Official falls 
short of his or her individual target by 7.5 %.  (Sec. 18 Rule V 
of the IRR) 

 
1.4.2. However, a decision to terminate shall be made only after 

due consideration of (a) all relevant  factors affecting 
collection as provided in the IRR and this Order and (b) 
mitigating circumstances such as the personnel’s 
performance ratings under the performance management 
system and upon compliance with substantial and 
procedural due process.  The performance ratings under 
PMS shall be measured using factors such as office and 
individual performance ratings, position, function and others. 
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1.5. Grounds for Reassignment of Personnel 
 
The Commissioner may also exercise its power to reassign personnel to 
fully implement the Attrition Act based on the following:  

 
1.5.1. Refusal to sign the Performance Contract 
1.5.2. Unsatisfactory performance within the contract period as 

may be shown by a personnel’s monthly or quarterly 
performance report. 

1.5.3. Failure to reach the assigned annual financial target. 
1.5.4. Non-submission of material documents required for the 

implementation of the Attrition Act such as performance 
contract, performance report, etc. 

1.5.5. Good performance, as a basis for reassignment to more 
challenging positions/functions. 

1.5.6. Other similar circumstances as the best interest of service 
may require. 

 
 
1.6. When Termination shall not apply: 
 

1.6.1. Where the District or area of responsibility is newly created, 
not exceeding two years in operation, and has no historical 
record of collection performance that can be used as basis 
for evaluation {Sec. 18 (a) Rule V of the IRR} 

 
1.6.2. Where the Official or employee is a recent transferee in the 

middle of the period under consideration unless the transfer 
was due to nonperformance of revenue targets or potential 
nonperformance of revenue targets {Sec. 18 (b) Rule V of 
the IRR} 

 
1.7. Relevant Factors to be considered in evaluating performance of 

personnel: 
 
1.7.1. Economic difficulties brought about by natural calamities or 

force majeure or economic causes as may be determined 
by the Board (Sec. 18 (b),  Rule V of the IRR) 

 
1.7.2. The following factors shall be taken into account only these 

factors have not been considered in setting BESF targets:   
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1.7.2.1. Enactment of a law that repeals revenue 
measures, reduces tax and tariff rates, grants tax 
exemptions, or otherwise results in the diminution of the tax 
base or of taxable transactions and activities, including the 
entry into force of a treaty or an international agreement 
that the Philippines entered into resulting in preferential 
treatment for certain taxpayers or transactions:  Provided 
that the Board shall have the final authority to determine the 
affected District or Districts as well as the amount of 
revenues deemed foregone due to such enactment or entry 
into force {Sec. 19 (a) Rule V of the IRR}. 
 
1.7.2.2. Reduction by the President of tariff rates under 
Section 401 of the Tariff and Customs Code of the Philippines 
{Sec. 19 (b) Rule V of the IRR}. 

 
1.7.2.3. Exercise by the President of the power to open 
or close any port of entry under Section 702 of the Tariff and 
Customs Code of the Philippines {Section 19 (c) Rule V of the 
IRR}. 

 
1.8. Non-Disciplinary Nature of Separation: 
 
 Employees and Officials who are separated from the service by 

virtue of Section 7 (a) of the Attrition Act shall be deemed dropped 
from the rolls in accordance with Civil Service Laws, Rules and 
Regulations, without prejudice to the receipt of whatever benefits 
are due to the official or employee concerned, including 
reemployment to other government agencies, at the discretion of 
the appointing authority concerned. 

 
2. OPERATIONAL POLICIES  
 
 The following operational policies shall be adopted in accordance with 

the Time Table as provided in Annex B. 
 

2.1 Allocation of Collection Goal 
 

2.1.1 The Deputy Commissioner for Revenue Collection and 
Monitoring Group shall present the distribution of collection 
target by Collection District to the Commissioner for his or her 
approval. 
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2.1.2 Based on the collection goal of the District, the District 
Collector shall assign the collection target for Officers and 
Employees of the Bureau under his or her jurisdiction. 

 
2.1.3 A Customs Memorandum Order (CMO) showing the 

collection target per District and up to individual level shall 
be issued by the Commissioner. 

 
 

2.2 Execution of Performance Contracts 
 

2.2.1 After the issuance of a CMO containing District, Division and 
individual targets, separate performance contracts shall be 
executed by each attritable individual. The Performance 
Contract shall be prepared by the following:   

 
 

2.2.1.1 The Performance Contract between the District 
Collector and the Commissioner shall be prepared by 
the PSCO/IICO.   
 

2.2.1.2 The Performance Contract between the District 
Collector and Official or Employee under his or her 
jurisdiction shall be prepared by the Collector.   

 
2.2.2 Employees and Officials concerned must execute the 

aforementioned Performance Contract and forward the 
signed documents to the PSCO/IICO on or before the start 
of the year. 

 
 
2.3 Monitoring and Evaluation: 
 

2.3.1 The PSCO/IICO and the Human Resource Service (HRS) shall 
collate and monitor the duly executed performance 
contracts.   The evaluation of individual performance shall 
be conducted annually.  However, semestral reports on 
office performance shall be generated for purposes of 
monitoring individual performance evaluation as required by 
the Attrition Act, and other purposes.  The semestral report 
shall be submitted to the Board.  
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2.3.2 At the end of the year, the PSCO/IICO shall evaluate and 
determine who among the Employees or Officials holding 
attritable positions failed to reach the assigned collection 
target.  The PSCO/IICO shall base their findings on the 
summary of individual weekly performance collection report 
as consolidated by the HRS.   The PSCO/IICO will present a 
list of personnel who failed to reach the assigned collection 
target to the Commissioner. 

 
2.2. Review by the Commissioner : 
 

2.2.1. The Commissioner shall review the recommendation made 
by PSCO/IICO and after which, he or she shall issue an order 
to those who failed to reach the assigned collection target 
to show cause why he or she should not be attrited.   The 
personnel concerned must submit his or her explanation to 
the Commissioner not later than 15 days after receipt of the 
aforementioned order from the Commissioner.  

 
2.2.2. After due consideration of the explanation made by the 

personnel concerned and all relevant factors/mitigating 
circumstances allowed under this order, the Commissioner 
shall decide whether there is basis to recommend a certain 
individual for termination/attrition or reassignment.   
Thereafter, the Commissioner shall present the list of 
attritable personnel to the Revenue Performance Evaluation 
Board for approval. 

 
2.3. Attrition of Personnel: 
 

2.3.1. The Board shall issue a final decision as to who should be 
removed or separated from the service.  Such decision shall 
be immediately executory. 

 
2.3.2. A copy of the final decision of the Board shall be transmitted 

by the Office of the Commissioner to the concerned Official 
or Employee.   

 
2.4. Motion for Reconsideration and Appeal: 
 

2.4.1. An Official or Employee whose employment is terminated by 
virtue of the final decision of the Board may initially file a 
motion for reconsideration with the Board, through the 
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Commissioner, within fifteen days from receipt of such 
decision.   

 
2.4.2. Thereafter, Officials appointed by the President may file and 

appeal at the Office of the President, while all the rest of the 
Officials and Employees may appeal to the Civil Service 
Commission or the Office of the President, as the case may 
be, within 15 days from receipt of the copy of the decision 
of the Board pursuant to Sec. 20 of the IRR. 

 
2.4.3. The Decision of the Board shall be final and executory after 

the lapse of the reglementary period for filing of motion for 
reconsideration or an appeal or where no motion or appeal 
has been filed. 

 
2.5. Reassignment of Personnel: 
 

2.5.1. Any request for reassignment may be initiated by the Head 
of the Unit/Division, District Collector, or PSCO/IICO. 

 
2.5.2. All requests for reassignment of personnel shall be 

transmitted to the Office of the Commissioner.  Once the 
Commissioner receives the request for reassignment, he or 
she shall transmit the request to the Lateral Attrition 
Implementation Committee (LAIC) for evaluation. 

 
2.5.3. The LAIC will require the PSCO/IICO to submit a report 

containing an evaluation of the past revenue collection 
performance of the personnel.   Thereafter, LAIC will 
evaluate the case of the employee to be assigned by 
considering his or her revenue collection performance 
based on PSCO/IICO report and other relevant factors.  
LAIC will also request the Human Resource Service to 
recommend new posting for the personnel, in case s/he will 
be reassigned. 

 
 
2.5.4. After evaluation of the recommendations of the LAIC, the 

Commissioner shall exercise his/her authority to reassign 
personnel taking into consideration the recommendations of 
LAIC.     
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3. EFFECTIVITY:    
 
These guidelines shall take effect immediately.    
 
 
 

Approved by the Revenue Performance Evaluation Board (RPEB) 
this 19th day of April 2007, in Manila, Philippines 

 
 
 

 
MARGARITO TEVES 
Secretary 
Department of Finance 
 

 
 
ROLANDO ANDAYA, JR. 
Secretary 
Department of Budget and Management 
 
 
 
ROMULO NERI 
Secretary 
National Economic and Development Authority 
 
 
 
NAPOLEON MORALES 
Commissioner 
Bureau of Customs 
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ANNEX B - INDICATIVE TIME TABLE 
 

Activity Date 
1. GOAL ALLOCATION  

DBCC formally communicates to the Board the over all 
collection goal of BOC. 

September 

DCR-RCMG shall prepare a List of Collection Targets per 
District. 

October 

District Collector shall assign targets for all individuals under 
his or her jurisdiction. 

November 

Commissioner will issue a CMO containing individual and 
district targets and forward it to the DBCC. 

First week of December 

2. EXECUTION OF PERFORMANCE CONTRACTS  
      Office Performance Contracts Second Week of 

December 
Contract between the Office of the Commissioner and the 
District Collector. 

Second Week of 
December 

Contract between the District Collector and individual 
under his or or her jurisdiction. 

Third Week of December 

Submission of Signed Performance Contracts to PSCO/ IICO.  Fourth Week of 
December 

3.  MONITORING OF PERFORMANCE  
District Collector shall submit the revenue collection 
performance report of each attritable  individual under his 
or her jurisdiction to PSCO/ IICO. 

Weekly 

PSCO/ IICO will manage the PMS system. Year round 
4.  EVALUATION OF PERFORMANCE  
     a)  Attrition  

PSCO/IICO shall present to the Commissioner a List of 
Attritable Employees or Officers 

Second Week of January 

Commissioner will order personnel in danger of being 
attrited to explain why they should not be terminated. 

Third Week of January 

Commissioner will submit names of personnel proposed to 
be attrited to the Revenue Performance Board for approval. 

February 

RPEB releases the names of personnel to be attrited. March 
   b)  Rewards  
       PSCO/IICO will prepare the Rewards Distribution List. First Week of January 

Depcom for IAG will present to the Commissioner the 
Rewards Distribution List. 

February 

Commissioner will present the Rewards Distribution List to the March 
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Revenue Performance Evaluation Board for approval 
5.   FINAL  STEPS:  

a)  ATTRITION   
A copy of the final decision of the Board shall be 
transmitted by the Office of the Commissioner to the 
concerned Official or Employee.   

March 

b)   DISTRIBUTION OF  REWARDS   
Preparation Of Expenditure Plan  
Each Unit/District will prepare an Expenditure Plan for its 
share in the utilization of Fund in case BOC exceeds its 
target (or District exceeds its target) and submit it to the 
FMO.  

 

o Contingent Expenditure Plan End of November 
o Final Expenditure Plan Second Week of 

February 
Budget Division of FMO will consolidate the EPs and present 
the Consolidated Expenditure Plan to the Commissioner. 

Last Week of February 

Commissioner will present Consolidated EP for approval by 
the Board. 

March 
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